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A mountain in labor cried so lo ud 
that everyone, hearing the noise, 
ran up expecting that she would 

surely give birth to 
a city bigger than Paris; 

she brought forth a mouse. 

-Jean de Ia Fontaine, Fables\1.10 



"f11cre are rwo types of Macintosh keyboard: this book follows the style of the 
American version, which uses words w denote the keys. 

Readers who are using the 'International' style of Macintosh keyboard will 
already be aware that the symbols on their keyboard indicate the following: 

Tab - I 

Caps Lock D 
Shift D 
Option ~ 

Backspace 

Return 

Enter 

Command 

\ 'ii 
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Introduction 

On 24 Janu<uy l984, in a series of gala evenrs throughout the world, Apple 
Computer unveiled its latest machine: Macintosh. Viewed from the outside, this 
personal computer is a beige box that incorporates a small b lack-and-white screen 
and a built-in disk drive. There is a separate keyboard, but most commands are 
transmitted to the computer by means of the m ouse, which is a hand-held device 
about the size of a cigarette box. \'V11en the user glides the mouse over the table 
alongside the computer, a pointer on the screen of Macinrosh reproduces an 
analogous movement, making it possible for the user to acwally poinr at various 
objects (words o r images) displayed on the screen. TI1ere is also an elegant 
primer, called the lmagewriter, that can produce a hard copy of any text or graphic 
elements displayed on the screen. 

Priced in the vicinity of $2,500, rv1acintosh has been designed primarily for the 
small -business market, but the machine should become an ideal companion fo r 
knowledge workers in many different professional spheres: engineers, architects, 
lawyers, writers, research workers ... . University students, too, will appreciate the 
high-resolution graphic capabilities o f Macintosh, which make it an attractive 
educational tool. 

from the ve1y first instant that you come into contact w ith Macintosh, you 
realize that this machine is vety differenr from convenrional microcomputers, 
panicularly because there are so many operations that can be carried out 
ef'Tcmlessly by means o f the mouse. 

No doubt th e most effective manner of getting the feel o f Macintosh, at the 
beginning, is to play around with the entenaining demonstrations provided by 
Apple on their Guided Tour d isk. At one point, for example, an entire p iano 
keyboard appears on the screen, and you suddenly discover that you can play a 
melody in real time simply by pointing at the notes with the mouse and pressing 
the button on its back. Later on, you use the mouse to po int at top hats that are 
lined up in front of a magician, and the contents of the various hats appear on the 
screen each time you press the mouse button. 

\X1l1en it arrived on the market, Macintosh was armed above all w ith t\1-.'0 
sophist icated software products developed directly by Apple Computer: a word 
processing system called .llacWrite, and a remark'lble graph ics design tool called 
,1/cu.:Paillt. ·n,ese two products are fundamental in the Macintosh context, not only 
because they G ill be used conjo intlv to create top-quality documents contain ing both 



2 INTRODUcnON 

text and images, but because they provide an admirable and exhaustive c!emonst· 
ration of the performance and power of the ne"· machine. Two other application 
pro~rams ha,·e been developed directly by Apple Computer: a second graphics 
package named ,1/acDrau•. for structured drawi n~s. and a modeling too l named 
MacProject. In th is user's guide, a fu ll chapter is devoted to each of these four 
products. 

At least two years before the official :mnouncemenr o f Macintosh, Apple 
Computer staned to contact oYer a hundred soft\\•are and hardware fi rms, with a 
view to encouraging them to develop projects for the new machine. Relatively few 
of these products have yet appeared on the market, for the simple reason that the 
definitive speciflcat ions of i'vl<lci ntosh were final ized by Apple Computer only 
shonly before the public announcement of the machine, and so the developers 
have needed t ime to test the final versions o f their products before releasing them 
on the market. Several products have nevettheless already appeared, including 
Microsoft's Jlluiii/Jiau and Cbart. A chapter o f this guide is devotee! to each of these 
products. 

111ere is an interesting general question that must be brought up in the case 
of Macintosh, namely: I low wi ll the machine be programmed? Up unti l now, as 
most pro fessionals know, microcnmputing has been pervaded by a slight 
misunderstanding. Customers purchasing microcomputers were generally to ld that 
these machines could be programmed using an element:uy language, Basic, which 
is vety easy to learn . Consequently, many of these ne,vcomers to microcomputing 
were under the illusion that it would be c:tsy for them to develop their own 
software. 111is, o f course, was nm quite true; software development has always 
been - and st i l l is - an extremely difficult mixture of art. cra ftsmanship and 
industry ... not to spe:1k of imagination. tvloreover, few develorers would choose 
an ·'easy" language such as Basic for a major project. 

In the case o f Macintosh, this si tuation has been brought out into the open in 
a commendable fashion. Customers who are interested in becoming computer 
l iterate (and why not?) can choose between several interesting and easy-to-learn 
language systems: Jllacintosb Basic, ,\/icrosojt Basic, Macintosh Pascal, Logo, etc. An 
individual might even like to tackle the creation o f simple but worthwhile 
programs using one or other of these elementary languages. On the other hand, 
Apple Computer has made it cl ear that it is quire impossible to use Macintosh 
itself, combined w ith one of the above-mentioned language systems, to develop 
software products that would look and behave, for example, like Nk1c\flr ite or 
MacPain t. 1l1is question is deal t w ith in gremer detail in the two appendices 
:mached to this book, b ut it can be said for the moment that the creation o f top· 
notch software proclucrs for Macinrosh is an affair that is bcsr left to experienced 
professionals, for the ideal solution consists o f ca rrying o ut such development , not 
on Macintosh itself, but on a Lisa. 

ivlastering the Mac intosh is ch ilcl"s p lay in the sense that nc:1rly e,·erything takes 
place under the control of IJIC!IIIIs that present a l ist o f all the operat ions that you can 
carr:.· out at any part icular moment , making it practical ly impossible to mess ur things 
by requesting un feasib le actions. Most users of rhe older generation of micro-
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computers have had ample opportunities of experiencing the vague fear that might be 
termed the "crash syndrome". We were avvare at most ~imes that we only had to make 
one fa lse move- which meant hitting a wrong key- and the machine would stan 
beeping back at us in an unfriendly manner, w ith equally nascy hieroglyphics 
displayed on the screen to inform us (if we were capable of interpreting them) why 
th e computer refused tocany on w ith our job. With Macintosh, this anguish no longer 
exists, for you soon manage to establish an intlfilil'erelationship \Vith the computer, 
and one has the impression that nothing can real ly go wrong. 

l11e so-called icons that you encounter constantly on the Macintosh screen 
play an essential ro le in estab lishing this excellent man/ machine interface. ·what is 
an icon? ·n1is fine old word, borrowed from Ancient Greek, simply me-dns " image" . 
ln the case of Macintosh, an icon is a tiny illustration that represents a panicular 
tbing . .. such as a document, for example, or even a trash can. TI1 ere is no better 
way of describing the intuitive man/ Macintosh relationship than to look at the way 
in which you get rid o f a document that has become obsolete. You simply usc the 
mouse ta drag the document icon across the screen so that it coincides w ith the 
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trash can icon, then you release the button on top of the mouse in order to 
indicate that the document is to be deposited in the trash can. 

The documentation that accompanies Macintosh is remarkably well produced 
and printed by the machine itself. Some of the remarks seem strange for a 
computer manual. We are told, for example, that Macintosh - which consumes 
veiY little electricity (about the same as a 60-wart light bu lb) - can be left 
switched on overnight, and that " it makes a fine night light". We learn, roo, thm 
there is a clock inside the machine, pO\verecl by a battery that keeps it ticking even 
when Macintosh is not p lugged into a socket, and that this timekeeper was 
originally set to )anumy 1, 1904. Elsewhere, we are informed that a Macintosh can 
be stored under the seat of most commercia l airplanes, or in the overhead 
compattment. Other anecdotes concerning this revolution<Hy machine describe its 
habit of displaying an icon to either smile at you, or look sad, depending on 
whether or not evetything is going along fine. And there is a brief mention of a 
puzzle- fifteen interchangeable numbered "riles" in a square box - thar can be 
displayed on the screen ro entertain you whenever you get ti red of using the more 
serious attributes of the computer. 

It appears that the signatures of the forty seven team members ar Apple 
Computer who designed Macintosh have been molded imo the interior surface of 
the plastic that encases the machine. Funnily enough, there is no direct means of 
verifYing this fact, since the manual threatens you with high-vol tage death if ever 
you attempt to take the cover o ff the machine. (111is is likely to shock the older 
generation of Apple II users, many of whom gar used to working constantly with 
the lid off their machine, m facilitate the changing of electronic boards.) If the 
design of the machine is the outcome o f a lor o f crearive imagination and hard 
work, it also represents a large sum of money. Apple invested over $100 million on 
the project, then they spent another $20 million to set up a Japanese-style robot 
factory, in the heart of Silicon Valley, to manufacture the computer, at the rate of 
one Macintosh every 27 seconds. The truth of the matter is that this robor factory 
also employs some 300 human workers, but this means that less than 1 per cent of 
the cost price of Macintosh is clue to labor. 

One final anecdOte before we get on \Vith the book: there exists a disk for 
Macintosh that enables the machine to talk back at you, describing itsel f in a broad 
American accent. l11ere is no doubt whatsoever that li ttle Macintosh has a whole 
bag of tricks in store for anyone >vho would like ro see vvhat avanr-garcte 
computing is all abour. . .. 
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Image of a machine 

Since 1983, the notion of machine families can be applied to the various products 
manufactured by Apple Computer. In order tO show where Macintosh fits into the 
picture, let us take a glance at Apple's brief but spectacular hiStOI)'- It has often 
been pointed out that, back in 1976, the future company's first machine was built 
by Steven P. Jobs and Stephen G. Wozniak, nor in a $20-million robOt-controlled 
factory, but in a backyard garage. Apple Computer came into existence as a 
corpormion in 1977, assisted by a smarr businessman named Mike l'v1arkkula. Six 
years later, by the middle of 1983, they had sold a mil lion machines. 

The company's unique product, for several years, was the Apple II personal 
computer, based upon the 6502 processor. In 1981 a second product line was 
announced: the Apple Ill Although this new and far more powerful machine was 
based upon the same 8-bit chip as the Apple II (which had evolved by now into 
what was called the Apple II Plus). the two computers used completely different 
operating !>)'stems, and there was no compatibility whatsoever between them. 

Several important events occurred in 1983 which were to change considerably 
the Apple scene. On the one hand. a phenomenal but expensive new computer was 
created: Usa, bui lt around the 32-bit MC68000 processor designed and manul~tcturecl 
by Motorola Semiconductor in Texas. On the other hand, a sophisticated variant of the 
company's init ial machine came into existence: the Apple 1/e. Uttle by litt le, the 
compatibility barriers between the Apple II and the Apple III were broken clown, 
above all by the introduction of a new operating system called ProDOS, which meant 
that one could at last speak o f a 6502 family of Apple personal computers. And this is 
the context in which Macintosh \Vas announced at the beginning of 1984 .... 

·n1e processor inside Macintosh is an 8MHz version of the same MC68000 chip 
used for Lisa, which means that these two machines can henceforth be thought of 
as forming Apple's top-of-the-line 32 Supermicro family. 

TI1e black-ancl-\vhite Macintosh screen has a resolution of 512 X 342 pixels. 
Although it is only some 18cm \vide and I4cm high (9-inch diagonal), this screen 
is exceptionally pleasant to work with. TI1e text and images are clearcut, free from 
flicker. and highly readable. 1he user has no sensation of eye strain or fatigue, as 
with most monochrome monitors of earlier generation microcomputers. 

It is interesting to note that the 175,104 pixels on the Macintosh screen are 
bit-mapped, which simply means that there is a specific bit in the memoty o f 
Macintosh for evcty dot on the screen. It is because of this property that you can 
actually drag images across the screen, in real time, using the mouse. Furthermore, 
besides black and white. the high-resolution screen allows many shades of "color", 
from light to dark gray. 

'aturally, one might regret that an avant-garde computer such as Macintosh 
docs not offer us the familiar phenomenon of color graphics ... but it is a fact that 
this would have great ly increased the overall price of the machine. 

On the front face of Macintosh, just below the screen, there is the narrow 
opening of a built-in disk drive. 1l1e disks themselves are the standard 3.5-inch 
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model developed by Sony. Single-sided and protected by a hard plastic case, a disk 
can store up to 400K of data. 

Besides all the hardware features mentioned up until now, the main 
Macintosh unit contains a banety -powered clock/calendar that provides vital data 
both for application programs and for the system software. There is also a built-in 
polypbonic sotmd gen eratorrhm includes a digital/analog converter that samples at 
a rate of 22KHz, making it possible to produce music or even human speech, 
which can be heard over a built-in loudspeaker. A port ar the back of the machine 
allows such audio output to be sent, say, to an ex'ternal ampl ifier. 

In spite of all these attributes, the central Macintosh unit - whose upper face 
has been molded imo the shape of a handle, so you can cany it around - is no 
bigger than a cube with edges of about 30cm, and it weighs only 9Kg. (Somebody 
has said, quite rightly, that Macintosh, w hen looked at from the side, reminds you a 
little of the profile of the famous cinematographic visitor from outer space named 
E.T) 

One amusing feature of the main Macintosh unit is so rare in the 
microcomputer universe that it deserves ro be mentioned. l11ere is not a single 
word on the facade of the machine, not even "Macintosh" . . . only the 
multicolored Apple icon. (Let's get used to using the word " icon".) If you search 
carefully, you'll discover a knob that controls the screen brightness, and that's 
about all. 

Search even more carefully, just to the right of the horizontal disk-insettion 
slit, and you'll discover a t iny ho le. Apple employees at Macintosh instruction 
classes get all panicky i f ever a student asks them rn explain what is the purpose of 
this ho le. l11e truth of the matter is that, if ever a disk refuses to obey software 
attempts ro eject it from the machine, you can stick a pin in this hole in order to 
activare what might be termed "hardware disk-ejection mode". Two don 't,\~ ( I ) 
Don't stick a pin in this hole, ro eject a disk, unless you 're really forced to. (2) 
Please don't tell anybody from Apple who told you what this hole is all about. 

Peripheral devices 

The functions o f the Macintosh mouse will be dealt with exhaustively in the 
following chapter, and so the present discussion will be limited to a brief physical 
description of the beast itself. 

It is difficult to imagine why anyone \YOu lei have chosen_ to call this delightful 
instrument a ''mouse". One thinks of the mouse as a nasty little animal thar runs 
around erratically on its own. whereas the docile and wcl l-beha,·ecl :VIae mouse has to 
be moved around by the human hand. in orderly tra jectories, almost like a chesspiece. 
It might have been called a Queen, for example . ... 

Be that as it may, the mouse attached to Macintosh is an ingenious input 
device. It consists of a rubber ball that seems to float freely under a son of plastic 
ronoise shell. When you push the tottoise - sony ! the mouse - over a hard tlat 
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surface such as a table top, the ball revolves as a resulr of the friction between it 
and the table. l11is movemenr of the rubber sphere, once captured by other 
componenrs within the mouse, enables :VIacintosh to determine, in real time, both 
the direction in which the mouse is being moved, and the distance it is C(1\'ering. 
In other \VOrcls, the computer is capable of following the movements of the mouse. 

The general idea is that, if you roll the mouse over the table in a sweeping 
curve, for example, then the pointer on the Macintosh screen will also trace out a 
curve of much the same form. \'V'hy "much rhe same", instead of "exactly the 
same"? There are both sca ling and directional di fferences between mouse 
movements on the table top, and the corresponding poinrer movements on the 
Macintosh screen ... bur this is someth ing that you will soon get used to. A useful 
hint: ahvays manipulate the mouse with irs lengthwise a'<is perpendicular to the 
plane of the Macintosh screen. This is the only way of ensuring that up/ clmvn and 
left/ right movements of the mouse on the tabl e top w ill give rise - as might be 
expected - to analogous up/ clown and left/ right displacements of the pointer on 
the Macintosh screen. 

l11e Macintosh keyboarcl, anachecl to a flexib le spiral cord that plugs into the 
front of the main machine, resembles a normal typewriter keyboard , except that 
there arc f()ur additional keys: < Caps Lock>, < Option>, < Enter> and <x> 
(the latter being the ''Command" key). l11e \<lrious functions of these keys wi ll he 
described as they are encountered in the follmYing chapters. 

To sec how other peripheral equipment fits into th e scene, we have to move 
around to the back of Macintosh, where there is a series of four black sockets, all of 
which bear descriptive icons molded into the plastic. (\XIe also encounrcr the name 
of the machine, for th e First time, stamped on its rear end!) Various accessory 
devices can be connected to Macintosh by means of these huilt·in hardware 
interfaces. ·n,c leftmost socket is for the mouse. l11e next one makes it possible to 
plug in an extra disk drive. 'n1c other two sockets are high·speecl serial ports for 
peripheral equipment such as the lmagell'riter prinrer and modems. Mass storage 
devices similar to Apple's Profile are being dc,·cloped by several firms, and these 
hard disks wi ll be connected to Macintosh through these serial porrs. 

I laving seen what Macintosh looks like at a hardware lc,·el, let us no\\' carry 
out a detailed examination - in the following four chapters - of the major 
functional and logical concepts upon wh ich this ne,,· machine has been designed. 



chapter 1 

The Mouse Concept 

Apple's promOtional l iterature on Macintosh contains an intell igent rhetorical 
question on man/ machine relationships: "Since computen; are so smart, u·ouldn't 
it make more sense to teacb computers about people, instead of teacbing people 
about computers?' 

The Macintosh mouse provides an example of how the machine has been 
"taught" to handle the typically human habit of pointing at things, wh ich is 
probably an even more archaic and fundamental form of communication than 
language itself. Tourists in a Greek restaurant, for example, can order an entire 
meal by simply pointing at the dishes they want, without speaking a single word. 
So it's nor surprising that machine designers should have invented methods for 
accepting this kind of input. 

Various designers have actually taken the notion o f pointing quite literally, by 
developing touch-sensitive screens or light pens. Bur the problem in such cases is 
that the user is likely to become rather tired at the end of an entire day spent 
holding up his/ her arm to point at things on the screen. Other designers have 
thought that the ideal solution, instead of inventing techniques for pointing, would 
be to get the machines to understand spoken commands in a natural language 
such as English. But, even i f that were to become a perfect ly feasible method, it's 
strange to imagine the atmosphere in an office, say, with dozens of employees all 
conversing aloud with their machines! 

The mouse provides an elegant solution ro man/ machine communication in 
the sense that it enables you to designate objects on the screen with a great deal of 
precision and with little physical effort. In fact, so many laudatory remarks can be 
made concerning the merits of this ingenious device thm maybe, on the contrary, 
we should stan out by indicating what appears to be the unique drawback of the 
mouse: namely, the fact that it is nor easy to execute freehand sketching or wri ting 
with such a tool. We humans are accustomed to holding a pencil between our 
finge1tips, and the manner in wh ich you clasp the Macintosh mouse is hardly a 
natural position for wielding a writing or drawing instrument. To put it bluntly, 
using the mouse to execute a freehand drawing feels a l in le l ike ny ing to sign a 
check while wearing a boxing glove. But we shall see later on, when we get 
around to describing the MacPaint soft\>.rare product, that this deficiency of the 
mouse can be overcome in several ways. 
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In any case, the user is generally aston ished by the ease and rapidiry with which 
the mouse makes it possible to posit ion the pointer at a precise spot on the screen. In 
other words. one has the unexpected impression, \vhen using the mouse for the first 
time, that it 's easier to clot one's " i''s than to trace the main pan of the letter! 

The mouse button 
Since there is a single rectangular burton on top of the mouse, it comes as 
somewhat of a surprise to discover how it can be used to cany out several different 
operations. TI1erc arc no less than five different ways in which this button can be 
manipulated: 

First of all , there is the trivial case in which you don't touch the button at all, 
even though you may be moving the mouse on the table. Usually, in such 
cases, the only result is that the pointer moves around on the screen, following 
the movements of the mouse on the table. It is nevertheless perfectly feasib le 
that various events might take place on the screen, even though you never 
touch the mouse button. For example, the demonstration material for 
Macintosh includes a number of attractive maze games, and you only need to 
move the mouse, without ever touching the mouse butlon, in order to trace 
out your path through the maze. 

2 Often you move the mouse until the po inter is located at a specific spot on the 
screen, and th en you press the mouse button and release it almost instantly. 
TI1 is operation is referred to as clicking, and it is the conventional manner of 
informing Macintosh that you w ish to select some pan icular object on the 
screen. For example, if you are interested in using the MacPaint software 
product, the first thing you must do is to move the mouse unti l the pointer is 
positioned on the MacPaint icon on the screen, and then you simply click the 
mouse button. 

3 Sometimes you arc expected to cl ick the mouse burron rwice. This is called 
double clicking, and is genera lly used as a shoncut technique for doing 
something more rapidly than usual. For example, when you w ish to rub out a 
drawing made by means o f MacPaint, there are several ways of going about i t, 
but the quickest technique is to simply double·click the eraser icon. 

4 Often, instead of rapidly cl icking the mouse button, you hold it pressed down 
for several seconds, while keeping the mouse immobile. TI1is is a common 
technique for obsctv ing a menu, for example. In such a case, the menu appears 
on the screen as soon as the mouse butron is pressed, and it disappears as 
soon as the button is released. To distinguish this mode of operation from 
clicking, we speak simply of pressing the mouse bunon. 

5 TI1e final variant of button manipulation, which is very impottant in the 
l'vlacintosh context, is known as dragging, and it takes place in four consecutive 
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steps. First, you move the mouse so that the pointer is positioned at the desired 
place on the screen. Then you press the mouse button and keep it held down. 
Next, while still holding the button pressed down, you actually move the 
mouse, "''hich generally causes various graphic events to rake place on the 
screen. Finally, when the poinrer has reached a cettain posit ion on the screen, 
you release the mouse button. There are two familiar examples of dragging. On 
the one hand, we have already mentioned that the bit-mapped screen makes it 
possible to actually drag images across the screen in real time. So, if you wish 
to throw away a particular document, you move the pointer to the icon that 
represents that document, you press the mouse button to select th e document, 
then vou hold the button clown and move the mouse so that the icon is 
dragged towards the trash can, and you finally release the button to indicate 
that you want to deposit the document in the trash can. During the actual 
dragging operation, a flickering outline of the object being dragged moves 
across the screen with the pointer. The other familiar example of dragging 
concerns the selection of an option in a menu. The normal procedure is that 
you move the mouse and press the button to select a particular menu, which is 
immediately "pulled down" onto the screen. You then drag the pointer clown 
over the menu until you reach the particular option you wish to select, and the 
actual selection is indicated by releasing the mouse button. 

There is an interesting surprise in store for newcomers to the Macintosh mouse. 
You invariably discover with astonishment, after using the beast for no more than 
an hour or so, that your handling of the mouse and the mouse button has become 
almost instinctive. In other words, for the first hour, you might have to think 
consciously about the notions of clicking and dragging. But, as soon as you have 
acquired a feeling for these manipulations, you no longer even have to think about 
\vhat you're doing, because your hand and eyes perform the necessaty operations 
almost automatically. 

Vocabulary 
This is an appropriate moment to mention a subject that is quite significant in the 
Macintosh context: namely, the nature of the language that we use to talk about the 
machine. 

In the previous section , precise terms such as "cl icking", "pressing" and 
"dragging" were introduced in order to designate the various types of mouse 
manipulation. TI1is is vety typical of the Macintosh situation in the sense that it's a 
new kind of computer, and Apple has been obliged to invent an extensive 
vocabulaty enabling us to talk about the machine in a clear and precise manner. 

It is well worthwhile going to the trouble to learn this vocabulaty off by heatt 
and to use it consistently, because these terms reappear in all the Macintosh 
literature. 
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Here we encounter yet another major difference between Macintosh ancl the 
previous generation of microcomputers. Although Macintosh is being used to 
tackle many quite different types of applications, there is an undeniable 
resemblance between most ofthe programs you encounter, at least at a superficial 
level. 1l1ey often look much alike in the sense that you invariably find the same 
kind of menus, presented in the same kind of graphic style. 

This is not a chance happening. 1l1e main reason for this uniform ity is the fact 
that almost all software developers are using the same basic routines that arc 
stored in the read -only memOIJI (ROM) of the machine. (See Appendix A for a 
fu ller discussion of this subject.) Funhermore, Apple is encouraging sofrware 
developers to respect various graphic conventions so that we can speak of a 
unique and homogeneous interf ace berween Macintosh and the user. 1l1e 
advantages of this situation are obvious. Once you've learnt how to handle the 
machine in one application domain, you've already acquired sufficient skills to use 
Macintosh for any other application whatsoever. 

Menus 

Let us now take a closer look at th e prec ise manner in which the mouse is used to deal 
\Vith menus. In doing so, vve shall be using the vocabulaty that has already been 
presented, along \.vith several new words. 

With the disk of a typical application program placed in the machine, the user 
might cany out one or rwo elementaty clicki ng operations in order to obtain the 
following kind of image on the screen: 

,. a file Edit Uiew Special 
., 



12 TilE MOUSE CONCEPT 

The narrow white section ac the top of the screen, w ith the Apple image followed 
by four words, is the menu bar, whereas the main pan of the screen, displayed in 
gray, is the so-called Macintosh desktop. There are two icons on the desktop : one 
that represents the disk itself, which happens to be called '·Application" in the 
present example, and a second icon representing the trash can. As for the pointer, 
it is located for the moment in the middle of the screen. 

We meet up, at this point, with the fundamental Macintosh concept of 
selection. To understand fully what this process is all about, you have to realize that 
most activities carried out by Macintosh take place in two steps. First. you sclec1 the 
object or the information you want to work with, and then you choose a panicular 
command from one of the menus, to indicate to the computer what you want to 
do with the selected item. 

For the moment, both objects on the desktop are represented as white icons, 
which means that neither object has yet been selected. To select one of 1he rv.ro 
objects, use the mouse to position the pointer on the desired icon, then click the 
mouse button. Let's suppose that we want to take a closer look at the trash can. We 
stan out by selecting the trash icon. TI1is is done by simply positioning I he pointer 
at tha£ spot on rhe screen and clicking the mouse button. Notice that the trash icon 
is immediately highlighted, in the sense that it changes color from wh ite to b lack, 
as shown in the following illustration: 

,. j file Edit Uiew Special 
, 
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l f, for any reason whmsoever, you wish w change the position of an icon on the 
deskw p, use the dragging technique that was mentioned earlier on. For example, 
you might decide to move the trash can funher up to the left. All you need to do is 
to select the trash icon, keep the mouse button pressed down, and move the 
mouse so that the flickering rectangle with the pointer inside (see the following 
illustration) is positioned at the new spot. At that moment, release the mouse 
button, and the trash icon w ill jump magically to its new posi tion. But let's 
suppose, for the moment, that the position of the trash icon on the desktop has not 
been changed. 

,.. • File Edit Ulew Speclol 
, 

TI1e next imponam srep, if \Ve w ish to find out anyth ing more about the n-ash can, 
is to pull clown a menu. In most cases, it is the File menu that is used first of all. To 
pull it clown, move the pointer to the word '"File" in the menu bar and press the 
mouse button. l11e word " File" is immediately highlighted by being displayed in 
white letters on a black background. As long as you keep the mouse immobile, 
with the button pressed down. the screen appears as follows: 
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l>ut Bor.l: 

I: lose 
1: lose fiJI 

Noricc that the File menu is composed of eight commands. 1\vo of them - Open and 
Get Info -appear in boldface letters, indicating that these commands are valid options 
for the selected object: namely, the trash can. In other words, we have the right to 
either open the trash can, to see irs comems, or ro simply get information on this 
object. But the other six commands, displayed in climmecllerrers, are not valid options 
(at least, not for the moment) as far as the trash can is concerned. 

To choose a particular command, you keep the mouse button pressed clown 
and you drag the pointer down over the lines of the menu. Each rime the pointer 
is positioned at a val id option, the line is highlighted by being displayed in white 
letters on a b lack background. And, to ind icate your choice of a command, you 
simply stop dragging and release the mouse button. In the illustration that fo llows, 
we can suppose that the Open command is about to be chosen: 
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Notice that three of the lines in the File menu have strange- looking symbols to the 
right. Consider the Get Info line, for example. l11e square symbol with loops ar 
each corner is the <~(Command) key, which is located jusr to the left of the 
spacebar on the Macintosh keyboard. l11e appearance of this symbol after the 
expression "Get Info" is simply a reminder that there is an alternative method of 
choosing this command. Instead of pulling down the File menu and dragging the 
pointer down to the Get Info line, you can hit the <x> key and then the letter " I". 
In orher words, it's a sho11cut that allows you to perform an operation from the 
keyboard, \Vithout using the mouse. 

At the end of the dimmed lines for the Dup licate and Eject commands, you 
have what appears to be a different symbol, that looks like a Maltese cross. In fact, 
this is not anorhcr symbol; it's simply the dimmed version o f a reference to this 
same <x> command key. 

As soon as the Open command is chosen for the trash can, the fo llowing 
image appears on the screen: 
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In the middle oft he desktop, the large white rectangle provides us with an example of 
a window. which is a fundamental Macimosh concept that will be dealt with in the 
following chapter. Windows normally display all kinds o f data. However, since the 
trash can is apparently em pry for the moment, this patticular window has nothing to 
show us. The window in fact tells us this quite explicitly: the number of items in trash 
is indicated as zero, and the quantity o f disk space devoted to trash is indicated as OK, 
meaning zero kilobytes. (Don't confuse this "zero ki lobytes" indication with the 
familiar OK endorsement ... which is also used quite frequently in man/ Macintosh 
communications!) 

Notice that the trash icon down in the righthand corner of the screen has once 
again changed its appearance. In its present state, it is described as being boi!OltJ, 
which serves to indicate that the icon has in fact been opened into a window. 

For the moment, let us close the window that we just opened. l11is can be done 
by pulling down the File menu once again, and dragging the pointer down to the 
Close command, as in the following illustration: 
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Notice thm the pulled-down Fil e menu actually covers pa11 of the window on the 
desktop. If ever you suddenly decided m this point , for one reason or another, not to 
close the window, then you would simply keep the mouse button pressed clown, 
move the pointer back up to the word " File" in the menu bar, and release the button. 
111e menu would then disappear, and the entire window would once again be visible 
on the desktop. 

But we have decided to close this window. So, leave the pointer positioned at the 
Close command - as indicated in the preceding illustration - and release the 
button. Both the menu and the window disappear instantly from the desktop, and the 
trash icon - which remains selected . reassumes its initial highlighted appearance. 



chapter 2 

The Window Concept 

In our evetyclay ex istence we encounter all kinds o f w indows, which don't necessarily 
have much in common ·with one anorher, apat1 from the fact that they're transparent 
and generally rectangular: shop w inclmNs, train winclmvs, envelope w inclo,vs . . . . We 
must therefore determ ine the particular sense o f the term "window'' in the Macintosh 
context. 

Maybe the b est starting-point is to ask the question: \XIhat sort of th ings can you 
actually see in a Macintosh '"'indow? In this regard, the example of a \vindow that we 
discovered ar the end o f the previous chapter was nor very helpful, since there was 
nothing whatsoever to see! 

In fact, one o f the commonest things that you can fi nd in Macintosh w indows is 
ordinary text. To sec an example of this, let us select the trash icon, as before, and 
choose another command: Get Info. Ac; irs name suggests, the ro le o f this command is 
to provide us \Vith info rmation concerning the selected icon. So the File menu is 
pulled clown in the usual manner and the command is chosen as shown in the 
following illustration : 

IH 
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The window that appears on the screen (see following illustration) bears the title 
" Information about Trash", and it includes a brief textual description. together with 
a graphic reproduction of the trash icon. We learn, in panicular, the conditions 
under which objects are deleted from the disk by being dragged to the trash can. 

r * File Edit Ulew Special ., 

Kind: 
Size: 
Where: 

Trash 
0 bytes to be deleted 

On the Desktop 

Trash ~ 

Files ond f olders ore deleted by dragging them to the 
Trash. They will be deleted when on applica tion is 
opened, when o document is duplica ted, or when 
eHplicitly requested by "Empty Trash' . 
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Earlier on, we saw that it is easy to close a window by pulling down the File menu and 
choosing the Close command. But there is an even quicker way of doing it. You simply 
move rhe po inter up to the little square in rhe top lefthand corner of the window, 
called the close ho.'(;, and you click it with the mouse button. In our example, as before, 
the window disappears but the highlighted trash icon still remains selected. 

Summary 
Besides text, what other things can we look at through Macintosh windows? This 
question provides us with an excellent pretext for summarizing the various 
Macintosh " things", displayed on the screen, that we have already encountered. 
They are exactly six in number: 

The desktop is a large gray space, occupying almost the entire screen, that can 
carry graphic elements that may be either images ( for example, the trash can) 
or text ( the word "Trash"). Windows, too, can be opened on the desktop. 

2 An icon is a small graphic symbol, with an attached caption, that stands for 
some kind of Macintosh object. So far, we have seen icons representing only 
two objects: the disk named "Applicat ion" and the trash can. 

3 l11e menu bar is a narrow horizontal zone at the top of the screen that conrains 
the image of an apple together w ith the names of several menus. 

4 A menu is a b lock of optional commands that can be "pulled clown" from the 
menu bar onto the desktop. 

5 The pointer is a tiny graphic 5ymbol (often an arrow) that can be moved - by 
means of the mouse - all over the desktop, the displayed icons, the menu bar, 
or pulled-down menus. 

6 A window is a large rectangle ( usually containing information) that appears on 
the desktop when we select an icon and then choose either the Open or Get 
Info commands of the File menu. l11e window d isappears when we close it, 
either by using the Close command of this same File menu, or by cl icking the 
window's close box. 

We are concerned with the question of the kind of " th ings"- apart from text - that 
can be found in Macintosh windows. One answer is that many windows are simply 
fill ed with a variety of icons. So, maybe the best step now is to take a closer look at this 
fltndamenral Macintosh notion ... . 

Icons 
Let us start with an example. Using the same disk as in the previous examples, 
suppose that we select and open the disk-shaped icon, in tLl e upper righthand 
corner, labeled "Applicat ion". Here is the window that appears on the desktop: 
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Tool H•lp 

CJO 
Modules Dossier 

As expected, the icon labeled "Application" is now hollow, ro indicate that it has 
been opened into a w indow. As for the window itself, it encloses four new icons. 
In the top row, the first icon designates an application program named "Tool", and 
the second one indicates the existence of "Help" material (no doubt concerning 
the just-mentioned tool) . In the bottom row, the other two icons represent f olders 
for storing documents. The folder on the left . bearing the caption "Modules", is 
reserved for various components of Macintosh system software, whereas the one 
on the right, an empty folder labeled "Dossiers", is available to store documents 
created by the "Tool" program. (When you purchase a Macintosh application 
program, the chances arc that, instead of our labels ''\llodules" and "Dossier". the 
new disk will carry the names ·'system folder'' and "Empty folder". l11e truth is that 
you can change these names of icons, in an instant, in any way that pleases you.) 

It has already been pointed our that every tvlacinrosh icon stands for some 
kind of object. Now, what exactly is the object represemecl by the initial icon 
labeled "Application"? As you might expect. since the icon looks like a disk, it 
represents the disk itself that is currently inside the Macintosh disk drive. So, in 
opening this icon into a window, what we have actually clone is to ask Macintosh 
to tell us what is stored on this disk. In other words, the w indow provides us with 
the direct01y indicating the contents of this disk, and we learn therefore that the 
disk labeled "Application" contains, at present, exactly four objects (or items), 
labeled "Tool" , "Help", "Modules" and "Dossier". 

l11ere is something that might neve11heless appear strange ro many 
newcomers to Macintosh: namely. the incongruous nature of all the so-called 
"objects" that can be represented by icons. After all , the icon labeled "Application" 
represents a 1\llacintosh disk. the "Trash" icon represents some sort of document 
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removal device, the "Tool" icon inside rhe window represents an applicarion 
program, the "Dossier" icon represents an empty folder, etc. How can we even 
define what an icon is, if it can represent so many different types of objects? 

T11e answer to this question will be obvious to anybody who is familiar with 
the rudiments of microcomputing. All these so-called "objecrs", represented by 
icons, correspond simply to various regions of the disk that is currently inside the 
l'v1acintosh drive. Information stored on a disk - just like information inside the 
main mem01y of a computer - can represent all manner of things: programs, data 
sets to be used by these programs, results created by these programs, etc. So it is 
nm surprising that the icons corresponding to these various blocks of disk-based 
information give the impression that they represent a certain number of different 
types of "objects". 

Any particular block of information on a d isk, no matter what sot1 of 
information it is, can be thought of as a file. In other 'vords, we can define an icon, 
most simply, as a graphic symbol that provides access to a specific disk file. 

T11is notion of interpreting icons as symbols for disk fil es can best be 
appreciated if we make use of the View menu and the by Name command, as 
indicated in the following illustration: 

r • File Edit 
---.....__;'---

LJLJ 
l' lodules Dossifr 

What we are doing, essentially, is to to a 
window ''.:ith names instead of icons for the various disk fi les. The result (sec 
following illustration) confirms the idea that each of the four objects to which the 
icons correspond is in fact a file, for this window even informs us of the precise 
size of each fil e. 

In the same View menu, the by Icon command enables us to return to the 
original style of window presentation. 
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One final question: \XIhat, then, does the disk-shaped "Application" icon actually 
represent? The obvious an .... wer is that it cOtTesponds ro a small .file d irectory stored 
on the disk itsel f. 

Multiple windows 

The Macinrosh desktop resembles a real-li fe desktop in the sense that you can 
place several quite different objects on it, at one and the same time, even i f they 
end up overlapping one another and forming an untidy heap. 

For example, let us select the icon ~vith the caption "Tool" that belongs to 1hc 
window that is currently on the screen. Then we shall pull down the familiar Fi le 
menu (sec fo llowing illustration), and choose the Get Info command. In other 
\vords, we wish to obtain some facts about the disk file that is ,.,ymbolizecl by the 
first icon in the current window. 
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A..:, expected, we obtain the following window enritled " Information abour Tool", 
which is similar to the " Information about Trash" window that we saw earlier on: 

r • File Edit Uiew Speciol 

Tool 

Kind: application 
Size: 92100 bytes, occounts ror 92K on disk 
Where: Application, internal driue 
Creoted: Tuesday, Jonuory 21, 1919 at 3:32 PM 

Modified: Wednesdoy, January 22, 1919 at 5:23 AM 

0 locked 

., 
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Don't bother about the information itself in this window. (One has the impression 
that the person who supplied the dates was either very much in advance of his/ her 
time, or else a liar! 111e truth of the matter is that the programmer who developed 
the protOtype disk that we are using for our examples apparently did not go to the 
trouble of correctly serring the Macintosh clock before starring to work on the 
machine.) 

l11e thing that interests us most in this illustration is the fact that the ne,vwindow 
which we have just opened seems to have been placed on top of the window that was 
already present on the desktop, for we can actually sec a bit of the previous window
containing patt oftheword "available"- sticking our from underthe righthand edge 
of the new window. Bur, i f you look vety closely at this piece of the old window, and 
compare it with the corresponding patt of the complete window that we saw earlier 
on, you can discover three significant differences: 

1 The rop patt of the complete window, containing the title "Application", was 
adorned with horizontal stripes, but they have disappeared from the little piece 
that is sticking out from under the new window. l11is upper section of a 
window is referred to as its title bar, and the stripes are not merely decorative. 
They are a code informing the user that this is the active window on the 
screen. At any patticular moment, only one window can be active, and it is 
distinguished by the striped title bar. l11e active window is in fact the one that 
the user is working with at a particular moment. When there was on ly one 
window on the desktop, it was necessarily the active window. But when there 
are two or more windows on the desktop, the user decides at all times which 
window is to be active. 

2 In the lower-right corn er of rhe complete window, there was a graphic symbol 
composed of a pair of tiny overlapping squares, and this has disappeared from 
the piece that is sticking out from under the new window. This symbol is the 
size box which, in the case of an active window, can be dragged by the mouse 
to change the height and width of the window. 

3 To the right of the complete window, and underneath it, there were columns 
with arrows at each end. In the piece sticking our from under the new window, 
the columns have remained but the arrows are no longer present. l11ese 
columns equipped with arrows are called scroll bar:;, since they are used ( in a 
\\-'a)' that wi ll be explained in detail later on) for scrolling through documents 
that are so big that it is not possible to see their entire contents through the 
window at one instant. 

Notice that the new window called " Information about Tool" has a title bar with 
stripes, indicating that it is the active window on the desktop. On the other hand, it 
is a special case of a window that has neither a size box nor scroll bars. 

How do we get back to the initial situation, with "Application" as the active 
w indow? 111ere are two techniques. If you are no longer interested in the window 
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entitled "Information about Tool", then you simply close it by cl icking its close 
box, and the complete "Application" window reappears alone on the desktop, as 
before. On the other hand, i f you wish to keep the big window on the desktop, in 
an inactive state, then you position the po inter at any location whatsoever on the 
piece of the "Application" window sticking out from under the big window, and 
you click the mouse button. The result is shown in the following illustration: 

,. • File Edit Uiew Special 
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Kind: application 

Size: 92100 bytes, 
Where: H•tp 

Creole~ Tuesdoy,Jonu 
Modified: Wednesday, J 

0 Locked 

The "Application" w indow now overlaps the other one on the desktop, and the 
stripes indicate that it has once more become the active w indow. l11e size box and 
the two scroll bars are also back in place. Notice too that there are no longer any 
stripes in the tit le bar of the window entitled '' Information about Tool". 

Let us now close both these windows, in order to move on to another 
neighboring subject. It is interesting to note that the close box has disappeared 
from the upper-left corner of the w indow entitled " Information about Tool". In 
other words, an inactive window cannot be closed in this manner. The simplest 
technique to close both windo\\·s is to pull clown the familiar File menu and 
choose the Close All command, as indicated in the following illustration: 
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Toot Htlp 

CJCJ 
~es Dossier 

Once you release the mm•se buttun. with the poinrer in this position, both 
windows wi ll disappear insranrly from the desktop. 

Window manipulations 

Let us pur rhe "Application" window back on rhe desktop. Cp unril now we have 
clone this by selecting the disk-shaped icon in the upper-right corner and choosing 
the Open command in the File menu. But there is a quicker technique for opening 
this icon: you simply clouble-cl ick it. 

Once the "Application" window is present on rhe desktop, there is an 
elementary manipulation that may be carried out on it: window dragging. You 
simply position rhe po inter an)'\Vhere in the ririe bar of the winclmv (except for the 
close box), then you hold down the mouse button and drag the winclmv wherever 
you like on the desktop. A flickering outline of the window accompanies the 
pointer during the dragging process (see following illustration). A.r:, soon as you 
release the mouse button, the window w ill reappear in its new position. 
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Heal windows in the evetyclay world have two complementary functions: they 
conceal no less than they reveal. This, after all, is the essence of a window. People 
do not generally live in glass houses, we do not travel in plexiglass automobiles, 
nor do we mail off letters in clear plastic envelopes. The transparent window pane 
is inevitably ser inro some kind of opaque "wall" that prevents us, ar any single 
instant in time, from viewing the entire scene on the other side. 

Macintosh windows behave in much the same way ... but they possess several 
magic powers that could hardly exist in the real world. First of all , it is an 
elemenraty task to cbange tbe size of a Macintosh window, simply by positioning 
the pointer in the size box, in the lower· right corner of the w indow, and dragging 
it over the desktop. A flickering outline of the enlarged or reduced window 
accompanies the po inter during the dragging process (see following illustration). 
Ac; soon as you release the mouse button, the window will reappear on the 
desktop with itS new propottions. 
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Let us suppose now that you use the size box to reduce the proponions of the 
window to such an extent that, as shown in th e following illustration, it is no 
longer possible to view all the four icons on the or her side of the w indow: 

r • File Edit Uiew Speciol 
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TI1e width of the window is !'till sufficient co display the coments, but its reduced 
beigbt prevents us from viewing the two folders clown the bottom. TI1is problem 
leads us into the subject of scrolling, which is important in the Macintosh context. 

Examining the reduced window, we notice that something new has suddenly 
appeared on the right hand side. TI1e {Jertical scroll bar used co be practically blank, 
but now it is fi lled wid1 the following three elements: 

Arrows: \Vhenever the mouse button is used to cl ick one or other of these 
symbols, the contents of the window change. \'\/hen the upwards-pointing 
arrow is clicked, the displayed information scrolls line by line towards the ror 
of the documem; and when the downwards-pointing arrow is clicked (see 
following illustration) , the displayed in formation scrolls in the opposite 
direction. Since there are only two lines in our example, these arrows make it 
possible to view either the top or the bottom half of the scene. 

r 4i File Edit IJiew Special 
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2 Gray area: Clicking in this zone of rhe scro ll bar advances the displayed 
information, to the extent of one full winclO\v. in the direction indicated by the 
adjacent arrow. 

3 Scroll bro.~ TI1is white square In the scroll bar wurks likt: an elevator in a 
building. You can drag it, with the mouse, to any point in the gray area, and the 
corresponding zone of the document will be displayed in the window. For 
example, if you drag the scroll box to the middle of the scroll bar, then it's the 
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middle zone of the document that wi ll be d isplayed in the window, as shown 
in the following illustration: 
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Admitted ly, all this talk about scrolling is not \·ery convincing when we are 
dealing - as is the case at present - with a document composed o f merely 
four icons. But we have already suggested that the " things" that might be 
displayed in a Macintosh w indow can be as voluminous as the contents of any 
disk fi le whatsoever, and so it is imperative that this powerful scrolling device 
should ex ist, in order to enable users to ' ·wander through" lengthy Macintosh 
documents in the most efficient manner. 

Desk accessories 
In the upper-left corner of the screen, in the menu bar, there is an image of an 
apple. This is actually yet another menu that can be pulled clown (see following 
illustration) in exactly the same manner as the File menu. To choose one of these 
so·callecl des/,.~ ac.:cessorie::.~ you simply drag the pointer clown ro the name of the 
desired accessOI)', and you release the mouse button. 
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For the moment, let us place three of these accessories on the desktop, side by 
side (see following illustration): the Alarm Clock, the Calculator and the Puzzle. 
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Here again, each of these three rectangles can be thought o f as a window that has 
been opened on the desktop. Besides, we know that the alarm clock is the active 
\vindow, because it is the on ly one with a close box in the upper-left corner. 

Although these windows have neither scroll bars nor size boxes, they do have 
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title bars, which means that they can be dragged around the desktop just like any 
ordinary window. In the fo llowing illustration, the three windows have been piled 
on top of one another: 
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The puzzle window now has a highlighted title bar and a close box, which 
confi rms that it is the active window. 

TI1e three accessories can be dragged to the edge of the desktop to make 
room for the familiar "Application" window, as in the following illustration: 
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Tool H•lp 

CJCJ 
Modu~s Dossi•r 
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We see that the "Application" window is active, because it has both a close box 
and stripes in the title bar. But nothing prevents us from clicking the calculator, for 
example, which produces the following result: 
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0 0 
Modults Oossifr 

Notice that the close box and the stripes have disappeared from the title bar of the 
"Application" window, whereas the title bar of the calculator is now highlighted, 
and it contains a close box. 

Let us finally close all these fo ur windows by means o f the Close All command 
in the File menu, that we used earlier on. Having done this, we can make sure that 
the "Application" disk-shaped icon is selected, then drag d1e pointer down to the 
last command in the File menu, Eject, as shown in the following illustration: 
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\XIhen w e release the mouse button, the "Application" disk w ill be physically 
cjecred from rhe l'v1acintosh disk drive. 



chapter 3 

The Cut & Paste Concept 

The expression "cut & paste" is used in the press and publishing world to 
designate an everyday activity, carried out with scissors and glue, that consists of 
taking fragments of printed text and reassemb ling them, possibly wid1 illustrations, 
to form pages. Writers, too, often work in a similar fashion when they are preparing 
articles or manuscripts. 

The cut & paste technique might be described in vel)' general terms as a 
three-step process: 

1 Using scissors, you cut out the fragment - text o r image- that interests you, and 
set it aside. Often, the sheet of paper that has just been cut into has to be glued 
back together again. 

2 You locate the place to which this fragment must be moved. Sometimes this 
might mean that you have to use scissors once again to make a "hole", as it 
were, in an existing page. 

3 Using glue, you fix the fragment in its new position. 

Fo1tunately, the Macintosh implementation of the cut & paste technique is not 
nearly so messy, because the scissors and the glue have been replaced by two 
simple commands: Cut and Paste. 

The Clipboard 
Let us deal first of a ll with the cut aspect of the cut & paste techn ique. There are 
three problems that must be solved at th is level: 

1 We have to let Macintosh know exactly what it is that we want to cut. TI1is 
action will be refe rred to as selection: the same term that has been used many 
times already with much the same meaning. We shall see that several d ifferent 
methods exist for the selection of the material to be cut. 

36 
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2 Next we need a command to get Macintosh to actually execute the cut. T11ere 
are two possibilities at this level: Cut or Copy. In the first case, the cut material 
really disappears from the place where the cutting occurred. In the second 
case, the material is copied rather than cut. 

3 Finally, we need a "container" to hold the cut material up until such time as we 
decide what to do with it. This is the role of the Macintosh Clipboard, which is 
one of the fundamental conceptual components of the computer. Anything that 
is cut or copied finds its way immediately and automatically to this Clipboard, 
and it stays there up until another cut or copy command is issued. 

Most cut & paste operations make use of the Edit menu, which is shovvn in the 
fo llowing illustration: 

T11ere are seven commands in this menu, five of which can be issued by hold ing 
down the <:l€> command key and typing a letter. 

·when we choose the final command in the menu, Show Clipboard, the 
"Clipboard" window appears on the desktop, as shown in the fo llowing 
illustration: 
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l11e Clipboard -which is empty in the present example - might be described as 
a rather "ordinary" Macintosh window. It has a conventional title bar and close 
box, together with a size box in the lower·right corner, but no scroll bars. 

We shall see later on - and this is very important in the overall Macintosh 
context - that the Clipboard is capable of retaining not only text but images. 

In order to see how the Clipboard works, what we need now is some kind of 
a document that we might "cut into". By way of an example, let us take the 
simplest source of information that can possibly be imagined in tbc case of 
Macintosh: the calculator. 

First, we'll use the size box to reduce the dimensions of the Clipboard 
window, to obtain more room on the desktop. Then, let us imagine d1at we click 
the number 22 on the calculator keys, fo llowed by the division symbol and the 
number 7. l11is gives us a resu lt, displayed on the tiny calculator "screen", that we 
shall henceford1 refer to as pi (see following illustration) . 

111e title bar of the calculator is highlighted, which confirms that this window 
is active. Let us therefore pu ll clown the Edit menu and choose rhe Cur command. 
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The following illustration proves char pi has been cut out o f the calculator 
window (leaving a zero in its place) and transferred to the Clipboard: 
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Let us now repeat this liule experimem (see fo llowing illustration), starting with a 
blank Clipboard and the value of pi on the calculamr, but using Copy instead of 
Cut. 

A.c; expected, the following illustration shows that pi has in fact been copied onto 
the Clipboard, but it still remains in the calculator window : 
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We can now turn our attention to the paste aspect of the cut & paste technique. 
Here again, there are three problems that must be solved at this level: 

Where exactly is the pasting going to take place? This involves the famil iar 
concept of the select ion of a specific document that is to receive the cut-out 
information. We also need to specify a precise insertion point for the paste 
procedure. 

2 What is it that is going to be pasted in at this point? The an~wer to this question 
is clear: the entire current contents of the Clipboard. 

3 Finally, we need a command to get Macimosh to actually execute the paste 
operation. Its name: Paste. l11is command causes the coments of the Clipboard 
to be transferred ro the insen ion point of the target document, but it does 1101 

erase the Clipboard. In other words, you can paste in the same conrems of the 
Clipboard, if you so desire, at several different points in the target document, or 
even in several different target documents. 

In order to see how this second half of the cut & paste technique works, what we 
need now is some kind of a target document that we might "paste into". By way of 
an example, let us take the simplest information-recording device that exists in the 
case of Macintosh: the desk accessory called the Note Pad. 

Pull down the menu designated by the Apple image, and choose the Note Pad 
as indicated: 
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We have used the size-box and window-dragging techniques to squeeze a much
reduced Clipboard window into the lower-left corner of the screen, to make room 
on the desktop for the Note Pad. 

TI1e Note Pad itself ( sec following illustrat ion) is a block of eight numbered 
sheets of "electronic paper" on which you can jot clown anything you like in the 
way of text. (Unlike the Clipboard, the Note Pad does not accept images.) 

Uke the Cl ipboard, the Note Pad -which is b lank in the present example 
might be described as a rather "ordinal)'" Macintosh w indow. It has a conventional 
title bar and close box, but neither a size box nor scroll bars. \Y/e shall look at it in 
greater detail later on. 

In the upper-left corner of page 1 of the Note Pad, there is a vettical bar ... 
which blinks, in reali ty. TI1is marks the insertion point, and so it is here that our pi 
will be pasted. 

To actually carry out the paste operation, we simply pull clown the Edit menu 
and choose the Paste command. 

The value of pi, recorded on the Clipboard, is immediately pasted onto page 1 of 
the Note Pad, as sho-wn in the following illustration: 
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Notice that the value of pi is still present on the Clipboard . It wi ll stay there - as 
we have pointed our already - up unril another Cut or Copy command is 
executed. 

The Note Pad 

Let us rake a closer look at this usefu l desk accessory called the Note Pad. 
We have already observed rhe case in which a blank Note Pad is opened up 

on the desktop. A blinking vertical bar ( not to be confused with the pointer) marks 
the insertion poinr, which is simply the position at which you can start to add new 
information ro the Note Pad. You can then abandon the fai thful mouse, if you l ike, 
and start using the keyboard ro type something in the 1\'ote Pad, as shown in the 
fo llowing i llustration: 
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I am usmg the keyboard to 
insert a ·message· in the 
Macintosh Note Pad. 

The blinking vertical bar 
indicates the position at whtch 
the next character or space will 
be inserted! 
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The blinking vertical bar moves along as you rype. In rhe present example, the 
insettio n point i~ now located ju~t ro the right of the last character that was typed: the 
full swp following the word " inserted". \'{!hen typing, you don't have to wony about 
hitting < Return> to skip to a new l ine, for the machine does this for you 
automatically. To obtain the blank line between the two paragraphs, though, it tl'as 
necessaty to hit < Return> tw ice. II should be memioned that Macintosh gets upset 
and St<ll1S to beep i f you aucmptto enter more text than can be fitted imoa page of the 
Note ~KI. 

Notice that there is no fami l iar po inter anywhere on the desktOp in the 
preceding i llustration. It's a fact that, when you're entering information into the 
Note Pad, the pointer momentarily disappears, and all you see is the blinking 
venical bar that represents the insert ion point. To make the pointer reappear on 
the desktop, you only have to move the mouse a little. But the pointer that 
reappears on the Note Pad is no longer the fam iliar arrow. It has become a so
called !-beam, as shmvn in the following illustration: 
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I am usmg the keyboard to 
insert a ·message·· in the 
Macintosh Note Pad. 

The blinking vertical bar 
indicates th& position at which 
the next character or space will 
be inserted I 

I 
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This is the type of pointer you' ll encounter in the Macintosh comext whenever it 's 
a maner of entering or editing text. To see how the !-beam pointer works, use the 
mouse m move the pointer just to the left of the word " indicates", then click the 
mouse button. 1l1e result of this operation is that the insertion point changes 
position on the Note Pad, for it is now located at the precise spot at which you just 
cl icked the !-beam. Type in the phrase "(now located earlier on)", for example, 
and the Note Pad w ill appear as in the following illustration, with the insenion 
point still located just to rhe left of the word " indicates": 



46 ·n;E CLT A;-.JO PAS'Jll CONCEPT 

r 4i fil e Edi t Uiew Special 

I am using tlle keyboard to 
insert a ·message" in the 
Macintosh Note Pad. 

The blinking vertical bar (now 
located earlier on) ~ndtcates the 
position at whtch the next 
character or space wtll be
inserted. 

I 
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If you click the l -beam when it is located as shown, anywhere beyond the end of 
the text, the blinking veL1ical bar will return to its former position, just to the r ight 
of the full stop after the word " insened". 

Let us imagine that the Note Pad, when you open it up on the desktop, already 
contains various messages, as indicated in the fo llowing illustration: 
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2 I March 1984: Check with 
Prentice/Hall concerning the 
reproduction of Imagev-~riter 

documents. 

23 March 1984: Phone 
Microsoft to see whether their 

27 March 1984: Ask Apple for 
latest version of MacProject. 

, 



'11-!ENOTE PAD 47 

This is typical of the son of stuff you might jot clown in the Macintosh 1ote Pad: 
brief reminders of things co do, possibly with dates, like in an o ffice diary. 

To turn the page, you simply position the pointer as indicated, in the turned
up lower-lefi: corner of the page, and you click the mouse button. The second page 
of the Note Pad instantly appears on the screen, as show~;~ in the following 
iII usu·ation: 
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3 April 1984: Phone Bruno to 
ask for a detailed explanation of 
Scrapboolt to Scrapboolt 
manipulations. 

4 April 1934: Check with 
Prentice/Hall that their printing 
house can handle my Apple 
Writer diskettes. 

ow, in order to get back to the previous page, you pOSitiOn the pointer as 
indicated, in the other triangle in the lower-left corner of the page, and you click 
the mouse button. The first page of the Note Pad instantly reappears on the screen, 
as shown in the following i llustration: 
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Prentice/Hall concerning the 
reprO<luction of Imagewriter 
documents. 

3 March 1954: PhOne 
Microsoft to see whether their 

27 March 1984: Ask Apple for 
latest version of MacProject. 
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Suppose that we wish tO remove the second message, dated 23 March 1984. We 
use the mouse to position the !-beam just to the left of the message, as indicated in 
the preceding illustration. TI1en we hold the mouse button pressed down, and 
drag the T-beam down across the three lines of text, in a "south-easterly" direction. 
The resu lt is shown in the following illustration: 
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l11e text that has just been swept over by the !-beam is now highlighted, which 
indicates that it has in fact been selected. 

To remove this text from the Note Pad, you merely pull down rhe Edit menu 
and choose the fami liar Cut command, as shown in the following illustration: 

Once the removal has taken place, there is a "hole" in page 1 of the Note Pad (see 
following illustration), because we did not cut out any of the blank lines that 
surrounded the text. You could tidy up the Note Pad by deleting the extraneous 
blanks, if you felt so inclined, using exactly the same removal technique that we 
have just examined. 
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Prentice/Hall concerning the 
reproduction of Imagewriter 
documents. 

27 March 1984: Ask Apple for 
latest version of MacProject. 

I 
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If we call upon the Show Clipboard command of the Edit menu to open the 
Clipboard on the desktop (see following illustration), we naturally discover the 
text that has just been cur. 
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27 March I 984: Ask Apple for 
11-----------1;:;:1• latest version of MacProject. 

, 
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If, for some reason whatsoever, we suddenly decided that this info rmation should 
not have been removed from the Note Pad, then it is still possible to paste it back 
in again. But, as soon as another Cut or Copy command is executed, this 
information will d isappear permanently from the Clipboard. 

The Scrapbook 
After the Clipboard and the Note Pad, there is a third member of the "cut & paste 
fami ly": the Scrapbook. It resembles the Note Pad to a ce1tain extent, in that it is 
used for record ing info rmation. But there are several impottant d ifferences 
between the Note Pad and the Scrapbook: 

1 TI1e Nore Pad holds only eight pages of text, whereas a much larger quantity of 
infom1ation can be stored in the Scrapbook. 

2 The Scrapbook can contain images as well as text. 
3 Information can be recorded in the Note Pad simply by typing on the 

Macintosh keyboard, but this is not possible in the case of the Scrapbook The 
only way of insetting anything into the Scrapbook is to place it first on the 
Clipboard (using a Cut or Copy command), and then Paste it into the 

4 
Scrapbook. 
A corollary of the preceding remark is that information recorded in the 
Scrapbook cannot be edited in the same way as Note Pad messages. We have 
seen the example of a phrase, "(now located earlie r on)", being insetted into a 
Note Pad message. TI1is would nor be possib le in the case of the Scrapbook, 
since there is no !-beam pointer fo r this document. Once a page is recorded in 
the Scrapbook, the only operation that can be carried out on it is Cut or Copy. 

5 TI1e pages of the Note Pad are turned by means of the unusual technique of 
clicking the triangles in the lower-left corner of the window, whereas the 
consultation of the Scrapbook is carried out using a conventional horizontal 
scroll bar. 

In other words, the Scrapbook can be thought of as a more permanent and 
"serious" document than the Nme Pad. To use a real-life analogy, the difference 
between the Macintosh Note Pad and the Scrapbook is similar to the difference 
between a family shopping list and a family phoro alb um; one is an ephemeral 
document, whereas the other is intended to last for a relatively l0ng time. 

To access the Scrapbook, you pull down the menu underneath the apple 
symbol and you release the mouse button on the word "Scrapbook", as indicated 
in the fo llowing illustratio n: 
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·n1e following illustration shows us an empty Scrapbook, with a typical touch of 
Macintosh humor: 

., 

This spoce for rent. .. 
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Since we need some edify ing data to record in the Scrapbook, let us start out w ith 
the following short text, borrowed from Apple's promotional literature, and 
recorded on page 1 of the Note Pad: 
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To tell a Macintosh personal 
computer what you want to do, 
you simply move the mouse 
until you're pointing to the 
object or function you want. 
Then click the button on top of 
the mouse, and you instantly 
begin working with that object.! 

To move this text onto the Clipboard, \VC must first select iL by dragging d1e 1-beam 
down over the eight lines, and then use the Cut command, as shown in the 
following illustration: 
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Here is the result (see following illustration). "111e text has been cut out of page 1 
of the Note Pad, which is now b lank, and moved to the Clipboard. (From now on, 
it is assumed that the reader is sufficiemly familiar w ith the way in which various 
windows are opened, closed and moved around the desktop, so as net to need 
step· by-step explanations. For example, in the case of the following illustration, we 
did not repeat the explanations - provided already on page 37 - concerning the 
procedure for displaying the Clipboard w indow on the desktop. (In case you've 
forgOtten, it's simply a matter of pulling down the Edit menu and choosing the 
Show Clipboard command.) 
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In the following illustration, we have opened the Scrapbook on the desktop, and 
its big window hides most o f the Clipboard. In other words, it is the Scrapbook -
with stripes in its title bar - that is selected, not the Clipboard. In order to move 
our text from the Clipboard to the Scrapbook, we simply pull down the Edit menu 
and choose the Paste command. 



11-!E SCRAPBOOK ss 

To shmv off the result (see following i llustration), we have clicked the Clipboard 
to activate this window and therefore move it on top of the Scrapbook. As you can 
see, page 1 of the Scrapbook now contains a copy of the Clipboard text. 
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Let us record a second page of text in rhe Scrapbook. The following illusu·arion 
shows us page 2 of the Note Pad: 
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And whether you're working 
with numbers, words or even 
pictures, Macintosh works the 
same basic way. In other words, 
once you've learned to use one 
Macintosh program, you've 
learned to use them a111 

, 

As before, we sweep the 1-beam down over the text to highlight it on a black 
background (see following illustration), then we pull down the Edit menu and 
choose the Cut command. 
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Once again, we select the Scrapbook (see following illustration). The big window 
of page ., of the Scrapbook has been dragged over rhe righthand edge of the 
desktop, bur it srill hides a good parr of the Clipboard, which contains the text that 
we are about to paste into the Scrapbook. As usual, we pull down the Edit menu 
and choose the Paste command. 

To leU a Macintosh personal computer what you v onl to do, Y• 
move the mous• until you'ro pointing to tho objool or funotion yo• 
click the button on lop of the mouse, and you inslonUy begin wor~ 
objoot. 

lt of 1 

·n,e following illustration proves that something rather strange has happened. "f11is 
second page that we have just inserted into the Scrapbook is in fact labeled " 1 of 
2": that is, rhe jb:~t of two pages in the Scrapbook. 
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And whether you're working with numbers, words or even pictures, 
Macintosh works the some basic way. In other vords, once you've learned to 
use one Macintosh progr am, you've learned to use thern all. 
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To jump to the second page of the Scrapbook, you click the gray area of the 
horizontal scroll bar. The following illustration reveals that the first page we 
inserted into the Scrapbook is labeled "2 of 2". In other words, each new page is 
inserted into the Scrapbook just before the page that was previously visible on the 
desktop, and all existing pages beyond that point are renumbered and pushed 
back - as it were - towards the end of the Scrapbook. 
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To tell o Macintosh personal 0001putrr vhot you wonl to do, you simply 
move the mouse unt~ you're poil\inq to the object or function you wont. Then 
click the button on top of the mouse, ond you instantly begin vorking with that 
object . 

Obviously, if we go to the trouble of storing information in the Scrapbook, it's 
generally because we intend to copy this information into further documents, at a 
later stage. Let's take the example of an image stored on page 5 of the Scrapbook, 
as shown in the fo llowing illustration: 
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If the Edit menu is pulled clown, and the Copy command chosen, the robot gets 
copied onto the Clipboard. The Show Clipboard command proves that this copy 
has been carried our successfully, as seen in the fo llowing illustration: 

r • File Edit Uiew Spe.:iol 
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. ow that the image of the robor is on the Clipboard , we can use it in any way we 
desire. That's to say, we can manipulate it by means of various application 
programs. r or example, the following illustration provides a trivial example of the 
manner in which it's possible to play around w ith the robot's image using the 
faci lities o f the MacPaint tool: 

This is the end of our presentation of the cut & paste concept ... but the concept 
itself will reappear in the following pages, for it represents one of the fundamental 
procedures in the Macintosh context. 



chapter 4 

The Housekeeping Concept 

In computing, the term "housekeeping" designates a vital activiry related to the 
organization and management of information files, particularly on disks. Macintosh 
uses a software component called the Finder to cany out such tasks. Now, many of 
the Finder's capabilities have already been mentioned. It is the Finder that enables 
the Macintosh user to open icons and to manipulate windows, for example, and to 
cany out cut & paste operations. So, what we intend to do in the present chapter is 
to take a look at other Finder rasks that have not yet been illustrated. 

Folders 

The notion of Macintosh folders has already been mentioned earlier on, bur no 
examples were given of the way in which they are used for housekeeping. 

l11e following illustration shows the directory windo\v of the d isk called 
"Application" that we have been using for all our examples: 

61 
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Notice that three new icons have appeared in the window. What do they represent? 
Without wonying about what "Tool" actually docs, it suffices to say that, every time 
you run this application program, you have the opponunity of creating a new 
document represented by an icon of th is nature. So, we can assume that "Tool'' has 
been run three times, resulting in the creation of the documents labeled 
"Resulrsl ", "Results2'' and "Results3". But don't bother, fo r the moment, about 
what these documents actually represent. 

Let us turn our attention now to the pair of folders called "Modules" and 
"Dossier". To see what's inside the first one, you simply double·click it with the 
mouse button, just as you do to open any icon whatsoever. TI1e result is shown in 
the following illustration: 
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"Modules" is quite a big and irnponam folder, for it comains six fundamental 
software components that occupy more than a third of the disk l11e presence of 
these elements on the disk confirms that ''Application " can be considered as a 
startup disk. This !neans that you can rake such a disk and insert it into the 
Macintosh drive as soon as the machine is switched on, whereas disks that do not 
contain the fi les named "Svstem" and "Finder" cannor be used in such a manner. 

Close "Modules" no~, by clicking the close box, and open the other folder, 
called "Dossier". The result is shown in the following illusmnion: 
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It appears that "Dossier" is a completely empty folder. So, why not make usc of it 
to store awav the three results obtained bv "Tool"? 

Close "Dossier" for the moment, by clicking its close box, so that the directory 
window is once again completely visible. 

Now, to actually move each document into the folder, you simply position the 
pointer on the document icon, then drag it across to the folder icon (see following 
illustration) so that the tl ickering outl ine of the dragged icon actually covers the 
"Dossier" icon. 111en you release the mouse button. 
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Each time that you release the mouse button, the document icon that you just 
dragged actually disappears from the window, because it has been placed - as it 
were - inside the folder. So, after the three dragging operations, the document 
icons appear to have disappeared from the window, as shown in the following 
illustration: 
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But this disappearance is an illusion in the sense that our three documents are still 
there on the desktop, inside the "Dossier" folder. To confirm this, simply double
click the "Dossier" icon, to open the folder. Here is the result, as expected: 
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Now, this operation o f placing three new documents in a previously-empty folder 
can be carried our in another fashion, which you might prefer. So, let's return to 
the initial situation where "Dossier" is empty and the three document icons are 
located in the "Application" w indow. 

First o f all, we double-click the "Dossier" icon so as to open up the empty 
fo lder on the desktop. Now, this time, we are actually going to leave the "Dossier" 
window open on the desktop, alongside the "Application" window, during the 
three dragging operations, as shown in the following i llustra.tion: 
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Instead of dra.gging each document icon onto the "Dossier" icon, as in the 
previous procedure, this time you actually drag each document icon out of the 
"Application" window (see following illustration) and across into the "Dossier" 
window. In other words, it's as if you physically transferred the three icons from 
one window into the other. 
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·n,ere's even an amusing variation on the dragging procedure, if you're really in a 
hurry to insert the three documents into the empty folder. This invo lves the 
technique of mult1jJie selection. Up until now, the general rule was that we only 
ever selected one icon at a time on the desktop. But Macintosh provides a means 
of overriding this rule. To select all three document icons simultaneously, you stan 
out by cl icking the first icon in the usual manner. TI1en you hold clown the 
< Shift> key on the Macintosh keyboard while clicking the two other icons. ·n,e 
result (see following i llustration) is that all three icons are highlighted, confirming 
their selection, and a single drag operation suffices to move all three icons 
simultaneously from the "Application" window to the "Dossier" w indow. 
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I ... 
Anmher elementa1y housekeeping function that you might like to cany out at this 
point is to cbange tbe name of the folder that now contains the three new 
documents. To do so, you simply click anywhere in the title bar of the "Dossier" 
window. (Not in the close box, of course!) At that point, you can immediately start 
typing in a new name using the Macintosh keyboard. The old name, "Dossier", 
disappears instantly, and it is replaced by the new name you type. For example, in 
the following illustration, w e have chosen to rename this fo lder "Results": 
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Tool Help 

CJ 
Modules 
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Now that our three "Tool" results have been safely stared away in a folder labeled 
"Results", we might decide that it is time for us to eject the "Application" disk from 
the machine, just as we did earlier on (see page 35). Let us suppose that we click 
the close box of the "Results" w indow, and then pull clown the File menu. TI1e 
outcome is shown in the following illustration: 
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A5 you can see, Macintosh does not allow us to choose the Eject command, which 
is dimmed. Why is this? 

Common sense alone enables us to understand the reason for this refusal. 
Macintosh considers - quite rightly - that the only "thing'' that can possib ly be 
ejected from the machine is . .. a disk. Now, since the "Results" icon has remained 
selected, Macintosh stipulates that the Eject command is not valid, because the 
notion of ejecting a folder is nonsense. So, what we must do is to deselect the 
"Results" icon and select the "Application" icon in its place. 

There are several ways of doing this. The simplest solution of all is to click the 
"Application" icon itself. TI1e "Results" icon is no longer selected. Ac:, for the 
"Application " icon, it remains hollow, because the directory window is open on 
the desktop, but it turns from white to black, as shown in the following illustration: 
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Since the "Application" disk is selected, the Eject command is now valid. 
Another simple manner of selecting the "Application" disk is to close the 

directory window, either by clicking the close box or by choosing the Close 
command from the File menu. In that case, the d irectory window d isappears, and 
the highlighted "Application" icon- which is no longer hollow - reappears as in 
the following il lustration: 

l'ut Hnt:k 

!:lose 
I:IOS(l fi ll 
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As you can see, the Eject command is once again valid. 
1l1ere are still other ways of achieving the same resul t. 

situation represented by the following illustration, with the 
shown: 
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Let's return to the 
pointer located as 

., 

If you cl ick the mouse burton now, with the pointer in this position, then the 
"Resu lts" icon is deselected, and the hollow "Application" icon turns from white to 
black, indicating that it is selected. 

Let us finally imagine the same situation, but with the pointer located out on 
the gray no-man's-land of the desktop. If you click the mouse button, with the 
pointer in this position, then the " Results" icon is deselected, as before, but the 
"Application" icon is not selected. ln fact, evety icon on the desktop is wh ite (see 
following illustration), and the Eject command is no longer valid. 



72 THE HOUSEKEEPING CONCEPT 

But, since we wish to get the ''Application" disk our of the machine, let us imagine 
that we have selected the icon as required, and chosen the Eject command, as 
indicated in the fo llowing illusrrarion: 
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As soon as you release the mouse button, Macintosh purrs like a contented cat for 
several seconds, while making sure that all the ftles have been correctly closed, 
and then the "Application" disk suddenly pops our of the front of the drive, like a 
candy bar in a vending machine. 

Disk-to-disk transfers 
With most professional microcomputers, there must be a procedure that enables 
the user to copy files from one disk onto another. 

In the case of Macintosh, this need arises, for example, when we create a large 
volume of documents using an application program. Normally there won't be 
much room left on the startup d isk that houses the application program, so the 
best solution is to transfer documents, as they are created, from the startup disk 
onto a data disk 

Let us imagine that we have a completely blank disk called "Data" , and that 
we would like to transfer the "Results" folder from the "Application" stmtup disk 
onto "Data". 

TI1e Macintosh disk drive is empty for the moment, since \Ve have just ejected 
the "Application" d isk ( \'(laming. Don't turn the power o ff, then back on, 
othe1w ise nothing in the next few pages will work as indicated!) Now, all we need 
to do - without touching either the mouse or the keyboard - is to insert the 
"Data" disk in the drive. After a bit of humming and purring - during which t ime 
a wristwatch icon appears on the desktop, indicating that Macintosh expects you to 
be patient - the fo llowing display appears on the screen: 
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Notice carefully the different tones of the seven icons on the desktop. l11e "Data" 
icon is highlighted in black, to indicate that it is currently selected. The trash.can is 
white, as usual, indicating that it is present on the deskto p (which might appear to 
certain readers as a curious location for a trash can!), but not selected. But look at 
the "Application" icon and the four icons in the directo ry file window. They have 
all turned light gray. 

This is the code used by Macintosh to inform the user that the "Application" 
disk is no longer present in the drive - which you knew, in any case - but that it 
still plays the role of the startup d isk. (Don't forget that "Data", as we have pointed 
out already, is not a startup disk, since it does not contain all the software 
components that we observed earlier on in the folder called "Modules".) 

In a way, you might say that Macintosh considers that the "Application" disk 
and its contents are virtually present in the machine, even though the d isk has 
been physically removed, temporarily, from the drive, and replaced by the "Data" 
disk. If ever you had turned off the power to Macintosh after ejecting the 
"Application" disk, it would not have been possible to turn the power back on and 
insert the "Data" disk. If you try to do this, Macintosh will d isp lay an image of a 
growling face, because the machine is not satisfied unti l it bas "digested" a sta11up 
disk. 

Double-click the "Data" icon. Its directory window - which is completely 
blank - will appear on the screen, as shown in the fo llowing illustration: 
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We have now reached the point at which we can actually carry out the transfer of 
the "Results" folder and its contents from one disk to the other. As before, when 
inserting the three new documents into the folder, there are two ways of going 
about this task 

The first method (see fo llowing illustration) consists o f closing the "Data" 
window and then dragging the "Results" icon across to the "Data" icon. 
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TI1e second method consists of leaving the "Data" window open on the desktop 
and then dragging the "Results" icon over onto this open window. Ac, soon as you 
release the mouse button, Macintosh does several things. First, it informs you that 
three files ( the number of documents in the "Results" folder) have to be copied 
fi-om one disk tO the other. Next it pops the "Data" disk out of the drive. And 
finally it displays a message, as in the following illustration, requesting you to 
insert the "Applicarion·· disk in the drive. Don't be disturbed by the curious little icon 
in the message; it's merely a visual aiel designed to inform you that one disk has to 
be removed fium the drive, and anather inserted in its place. 

At this point, Macintosh stans to behave in a manner that invariably surprises 
newcomers to the machine. It has just popped out the "Data" d isk and requested 
you to inse11 the "Application" disk Well, once you do as rold, Macintosh 
immediately pops out the disk you just inserted, and asks you to put back the 
"Data" disk. No sooner do you do this than the machine pops out the 
"Application" disk and asks you to reinsert the "Data" disk. And Macintosh carries 
on like this for two more rounds, until it finally settles down - apparently satisfied 
- with the "Applicat ion" disk in its drive. 
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People who see Macintosh acting in this way for the first time generally 
believe that the machine has run amok, and that it can no longer make up its mind 
about which disk it wants. But the truth of the matter is simply that Macintosh is 
obliged to carry out its disk-to-disk information transfers in a series of relatively 
shon steps, moving the data block by block. Don't forget that Macintosh is basically 
a single-disk machine with a main memory of 128K. Data that is to be moved from 
one disk to another must transit by the main memory, which explains why the 
process must be carried out in a series of steps. 

All this SV..'apping of disks would be tedious on any other machine besides 
Macintosh, pa1ticularly if the user had to constantly open and close the gate of the 
d isk drive. But Macintosh makes the job effottless, because it physically ejects the 
disk to be removed, and you then simply push in the other disk with a slight 
movement of the hand. Admittedly, at times the user feels a little like a robot, 
sitting in from of Macintosh and med1an ically obeying the machine's instructions 
to insert disks into its drive. But that's a small price to pay for the reassurance that 
Macintosh is taking care of the copying job in a faultl ess manner. 

(Naturally, if you happen to have a second disk drive plugged into the back of 
your Macintosh, then this minor problem of disk swapping simply ceases to exist.) 

Once the transfer o f the "Results" folder is completed, you can double-click 
the icon in the "Data" window to verifY that the three documents have in fact been 
copied onto the data disk. l11e result is shown in the following illustration: 
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lf you now open the "Application" window on the desktop, you'll see that the 
original "Results" folder and its contents are still in fact present on the stanup disk. 
ln other words, the process that we've been describing as a d isk-to-disk transferof 
information is in fact a copy operation. Remove the o riginal fo lder on the startup 
disk by dragging it to the trash can . 

Instead of copying a whole folder of documents from one disk to another, we 
could use this same technique for copying a single document such as "Results] ", 
or an application program such as "Tool". 

l11e same technique can be used to copy an entire d isk. For example, if you 
want "Data" to contain an entire backup copy of the "Application" disk, then all 
you have to do is to eject "Application", insert "Data", and drag the "Application" 
icon onto the "Data" icon. Macintosh makes sure that all the fil es are copied from 
one disk to the other. In this case, since all the system documents in "Modules" 
are copied onto "Data", the latter d isk becomes a proper startup disk ... and so 
maybe you feel that it sho uld be called , say, "Backup" instead of "Data". It's 
extremely simple to change the name of a disk. All you have to do is to double-
· click the "Data" disk icon to open it, type in the new name (which immediately 
appears in the title bar), then click the close box to close the directo1y window. 

Copying documents on the same disk 
As a final example of an imponant housekeeping feature of the Finder, let us look 
at the Duplicate command in the File menu, as shown in the fo llowing illustration: 
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Since the ''Results" icon has been selected, it is this fo lder and its contents that will 
be d uplicated, as shown in the fo llowing illustration: 
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NOtice that the prefix "Copy of" has been added to each new icon name. 
We can even open the orig inal folder and the copy, simultan eously, on the 

desktop, as shown in the fo llowing illustration: 
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We have already seen (page 68) that it is very easy to change the name of a folder. 
In the same way, you can easily change the name of a document such as "Copy of 
Resultsl ". To do so, move the pointer - which assumes the fo rm of an 1-beam -
just to the right of the current name. Next, click the mouse button and use 
<Backspace> to delete the current name. 111en, type in the new name. The 
operation is terminated by moving the poimer away from the new name, and 
clicking the mouse button. 

In other words, we can create any number of folders we like, simply by 
duplicating existing foJders, replacing their names, and changing their contents 
(which may involve throwing the o ld coments into the trash can) . 

Furthermore, fo lders can contain, not only documents, but . .. other folders. 
After all , that's how we organize information in reaJ.Jife contexts. In a lawyer's 
office, for example, we might d iscover that a big dossier, once opened, contains a 
pile of smaller fo lders, and so on. 

Here's an example (see fo llowing illustration) of two open folders labeled 
"Series A" and "Series B". 
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The folder named "Series A" contains three documents: "Results! ", "Results2" and 
"Results3". Ukev.,ise for the folder named "Series B": " Results4", "ResultsS" and 
"Resulrs6". 

Let us suppose now that we store away these two folders in a big fo lder 
labeled "Results", as shown in the following illustration: 
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Nothing prevents you from opening simultaneously all these folders on the 
desktop, as shown in the following illustration: 
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So, this Macintosh housekeeping concept - involving documents, folders, copy 
functions and a removal function (the trash can) - is not only powerful and easy 
to use, but also foolproof. It's most unlikely that you' ll ever lose an important 
document by inadvenence, because the presence of the icons on the desktop 
allows you at all times to actually see what objects you're working with. 



chapter 5 
"MacWrite"- Word Processing 

Word processing, today, has become one of the O!OSt popular applications of 
microcomputers, and so it is nor surprising that MacWrite was one of the first 
major programs developed for Macintosh. 

The design of MacWrite has been based upon two avant-garde word 
processing concepts: 

1 When you are creating a document with MacWrite, its appearance on the 
Macintosh screen is exactly the same as it will look once it has been printed on 
the lmagewriter printer. This means that there are never any unpleasant 
surprises when you ask Macintosh for a hard copy of what you sec on the 
screen. A coro llaty of this essential fact is that the text displayed on the screen 
does not contain any of the embedded commands that burden most word 
processing systems. 

2 The screen on which MacWrite documents are created is essentially a grapbic 
device, because of the bit-mapped display mode used by Macintosh. Now, 
MacWrite utilizes this property of the screen in two spectacular manners. On 
the one hand, for text, you are offered a wide range of type styles and fonts. On 
the other hand, when the text needs to be enhanced with graphic material such 
as illustrations and charts, these can be created by means of MacPaint and/ or 
MacDraw, and then incorporated effottlessly into MacWrite documents. 

Both NlacWrite and MacPaim are generally housed together on the same disk, 
called "Write/ Paint", whose directory window might appear as in the following 
illustration: 

82 
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Here again, as in our previous examples, "Modu les" is a folder containing half-a
dozen software componems that enable "Write/ Paint" to function as a startup disk, 
whereas "Dossier" is an empty folder that can be used later on for holding 
documents created by either MacWrite or MacPainr. 

Double-click the icon labeled "MacWrire" ro statt the program running. After 
several seconds, the screen will appear as in the following illustration: 
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insertion point 

If the window is labeled "Untitled", this is merely to indicate that it is a new 
MacWrite window that does not yet contain any information. Naturally, as soon as 
we statt to create a document in the window, one of the first things we'll do is to 
change the tenn "Untitled" into a meaningful title for our document. 

Notice that there is a blinking vett ical bar that indicates, at all times, the 
insertion p oint fo r the character tJ1at you are about to type. 

TI1ere is also an J.beam poimer on the desktop, and you can click it to change 
the insenion point. 

Now, Mac\Xtrite has the reputation o f being an extremely "friendly" word 
processing tool . . . and one of the keys to that friend liness is the fact that you can 
stan to use it immediate ly, as soon as this window appears on the screen, without 
having to get involved with any o f the menus or strange· looking symbols up at the 
top o f the screen. So, let us do exactly that, by typing the text that is shown in the 
following illustration: 
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You can start to cr~ate a new document, using Mac Write, as soon as this 
"Untitled" Window appears on the scr*n. without having to change any of 
the abOve parameters. In that case, your text appears on the Macintosh 
scr*n in a pr~t format. font and style. The preset format corresponds to 
printed text with lines slightly Jess than six inches long, left-aligned and 
single-spaced. Th~ preset font is New York, and the preset style is 12 -point 
Plain Text. Thanks to the word wraparound feature or MacWrite, you don't 
have to worry abOut hitting the Return l<.ey at the end of lines~ 

I 

MacWrite has a word wraparound feature, which means that you don't have to 
wony about hiuing the < Return> key at the end of lines. As soon as MacWrite 
realizes that the word being typed can nor fit into the room left at the end of the 
current line, the entire word jumps to the beginning of the following line. f\:othing 
prevents you, though, from using the < Return> key if you pan icularly wish to stan 
a new line before reaching the right margin of the current line. 

The fact that we have paid no attention to the things up at the top of the 
screen, when entering this short text into the machine, merely means that 
MacWrite has made use of a number of preset parameters to govern the way in 
which our text appears in the w indow. 

First, there are the parameters dealing with the format of the text. The preset 
format corresponds to primed text with lines slightly less than six inches long, 
left-aligned and single-spaced. just below the word "Untitled" there is a scale 
marked in inches from 1 to just over 7. If you look closely, at either end of this 
scale, you'll see tiny black arrowheads. TI1ese are the left and right margin 
markers, and you can check that they are just under six inches apart. 

Next, look at the group of three rectangular striped boxes below the figure 3. 
TI1ese are the space boxes. Norice that the one on the left is highlighted by a black 
background. It's the single-space box. 

Look now at the group of four rectangular striped boxes below the figure 6. 
These are the alignment boxes. Here again, the one on the left is highlighted by a 
black background. It's the left-alignment box. 
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This entire section - including the scale in inches, the margin markers, the 
various boxes, etc. - is referred to as a ruler, and we shall be returning to this 
important format device later on. 

Another preset parameter in the text that we just typed is the f ont. I f you pull 
down the Font menu (see following illustration), you can verify that the name of 
the preset font - the one with rhe tick alongside- is New York. 

You can start to create a new 
"Untitled· Window appears on the 
the above parameters. In that 
screen In a preset format, font 
printed text With lines slightly snn Frontlsto left-aligned and 
single-spaced. The preset font is New York, and the preset style Is 12 -point 
Plain Text. Thanks to the word wraparound feature of Mac Write, you don't 
have to worry about hitting the Return key at the end of lines. 

., 

There are eight other fonts we could choose from, but let's not wony about them 
for the moment. 

The remaining preset parameters concern the style of our text. If you pull 
clown the Style menu (see following illustration) , you can verifY that the preset 
style is 12-point Plain Text. 
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Here again, let's not srop to investigate the other style possibilities, because a more 
urgent task awaits us: we have to save our rexr on disk, with a meaningful title. (An 
accident such as a power cut can occur at any moment, and one must get into the 
habit o f regularly saving new documems: once every twenty minutes or so.) 

To do this, we pull down the File menu, as indicated in the following 
illustration, and choose the Save As command: 

:=---.!-"'::;" .=::.--==-=~-=---~---- -
·-------

a new document, using Mac Write, as soon as this 
appears on the screen, Without having to change any of 

ult In that case, your text appears on the Mactntosh 
Q format, font and style. The preset format corresponds to 

printed text with lines slightly less than six Inches long, left-aligned and 
single-spaced. The preset font Is New York., and the preset style Is 12 -point 
Plain Text. Thanks to the word wraparound feature of Mac Write, you don't 
have to worry about hitting the Return key at the end of Unes. 

., 
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At this point, Macintosh reacts with a new type o f message (see following 
illustratio n) known as a dialog box, because the machine needs to communicate 
with the user in order to obtain several elements o f vita l information . 

Soue current document os 1 

I First teHt I I 
i 
! Mj!JUI., Cnncel 

Write/Point 

Eject 

@ Entire Document 0 TeHt Only 

corresponds to 
t-atigned and 
style is 12-polnt 
Write, you don't 
es. 

, 

Since we are saving this document for the first time, Macintosh asks us to supply a 
name, to be typed in the w ide rectangle inside the dialog box. Let's call our 
document "First text". 

TI1e three round·cornered rectangles inside the d ialog box are referred to 
simp ly as buttons, w hereas the two small circles down the bottom are called radio 
buttons (pressing o ne releases the other) . The general idea is that we can dialog 
with Macintosh simply by using the hardware button on the mouse to click various 
software buttons in the dialog box. 

In this panicular dialog box, the Entire Document radio burton is preset, 
which is what we want. The button that interests us, of course, is Save, which is 
highlighted as soon as we dick it. If we had clicked the Cancel button, Macintosh 
would have reacted just as if we had never chosen the Save As command in the 
File menu. In other words, the Cancel bunon can be used to move back to a 
previous state if ever we happen ro choose the wrong command. 

As for the Eject button, it can be clicked whenever you want to save your 
document, not o n the "Write/ Paint" startup d isk, but on some other disk: maybe a 
data disk w ith no application software, only documents. 
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Printing using the Imagewriter 

Now that our "First text" is safely stored on the "Write/ Paint" disk, maybe we can 
think about getling a hard copy of it. l11is is achieved by pulling dO\vn the File 
menu and choosing the Print command, as indicated in the following illustration: 

a new document, using Mac Write, as soon as this 

~~-~-··· appears on tlle screen, Wltllout having to change any or 
U In that case, your text appears on tlle Macintosh 

font and style. The preset format corresponds to 
printed text with lines slightly less Ulan six inches long, left-aligned and 
single-spaced. The preset font is New York, and the preset style is 12 -point 
Plain Text. Thanks to tlle word wraparound feature of MacWrite, you don't 
nave to worry about hitting tlle Return key at the end or lines. 
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We are immediately confronted with anorher dialog box, as shown in the following 
illustration: 

,.. . Edit Search Format Font Style 

Quality: 

Page Range: 
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printed text witllllnes slightly less Ulan six Inches long, lett-allgned and 
single-spaced. The preset font is New York, and the preset style Is 12-polnt 
Plain Text. Ttlanks to tlle word wraparound feature of MacWrlte, you don't 
have to worry about rutting tlle Return key at the end of lines. 

, 
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There are radio butto ns and boxes for four different aspects of the printing 
operation that is about to take p lace: 

Quality: High quality printing on the lmageWriter is e legant but slow. Standard 
quality, faster than High quality, is the preset option. It provides the same 
degree of resolution as the Macintosh screen. Draft q uality, the fastest, can only 
be used for text. 

2 Page Range : All, the preset option, indicates that the entire document is to be 
printed. Otherwise, click the From/ To button and indicate the bounds o f the 
part of the document that is to be printed. 

3 Copies: TI1e preset value is 1. 
4 Paper Feed: Click the Cut Sheet option if you intend to hand·feed single sheets 

of paper into the lmagewrite r. TI1e Continuous option, which is preset, concerns 
fanfold stationery. 

In our case, we have asked for a single high-quality copy of our document on a 
normal sheet of paper. Clicking the OK button tells Macintosh that we've selected 
all the appropriate options in the dialog box, and that we would like the printing 
ro stan. But Macintosh (see fo llowing illustration) is not the son of creat.ure who 
likes to rush things .... 

Format Font Style 

Please insert the neHt sheet of paper. 
Click OK to con tinue, Cancel to terminate 
printing. 

To cancel, hold down the 88 lcey and type 

Plain Text. Thanks to tile word wraparound feature of MacWrite, you don·t 
have to worry about hitting tile Return key at tile end of lines. 

.., 

Two more d ialog boxes appear on the screen. In the upper one, the little icon with 
a human face and an exclamation mark reminds us that we have to put a sheet of 
paper in the lmagewriter. Click OK to let the machine know that we've done so. 
Then the second d ialog box provides us, in a friend ly manner, with an easy means 
of halting the machine if ever something goes wrong during the printing process. 

Finally we obtain the following printout of our document: 
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You can start to aeate a new document, using MacWrite, as soon as thia 
"Untitled" window appears on the screen, without having to chanae any of 
the above parameters. In that case, your text appears on the Macint05h 
saeen in a preset format, font and style. The preset format corresponds to 
printed text with Jines slightly Jess than sii inches Jona, lert-llla:ned and 
single-spaced. The preset font is New York, and the preaet style is 12-point 
Plain Text. Thanks to the word wraparound feature of Mac Write, you don't 
have to worry about hitting the Return key at the end of lines .. 
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At this point we have therefore used MacWrite to complete the entire sequence of 
events fro m the typing of a text up until its printout as a hard copy, and including 
its safe storage on disk. Maybe we could consider that our day's work is done, and 
that we can set aside our word processing until tomorrow. In that case, we pull 
clown the File menu and choose the Quit command, as indicated in the fo llowing 
illustration: 

a new document, using Mac Write, as soon as this 
appears on the screen, Without having to change any of 

In that case, your text appears on the Macintosh 
ormat,font and style. Tile preset format corresponds to 

printed text with lines slightly less than six inches long, lett-aligned and 
stngle-space<l. The presetrontis New York., and the preset style Js 12-polnt 
Plain Text. Thanks to the word wraparound feature ot MacWrite, you don't 
!lave to worry abOut hitting the Return key at the end of lines. 

., 

The text disappears from the screen, and the directory window of the "Write/ Paint" 
disk reappears on the desktop, as shown in the following illustration: 
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r • File Edit Uiew Special 
., 

0 0 
Dosoior 

Notice that there is a new icon in the window, named "First text": the MacWrite 
document that we have just created. 

To physically eject the "Write/ Paint" disk from the drive, pull down the File 
menu - as usual - and choose the Eject command. 

Format modifications 

In order to discover the possibilities of MacWrite, let us imagine that, the following 
day, we decide to carry our a whole series of modifications on the text that we 
have just written. 

It's best to start our with f ormat modifications. They are the easiest to 
understand, in the sense that they alter merely the form of the document, but not 
irs content. 

·n1e following illustration id entifies most o f the format devices contained in a 
Mac\XIri te mler, some of which have already been mentioned: 
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,. * File Edit Seurch Formut Font Style 
, 

;o Untitled 

~-i-·•·-L ... i ....... J.?,_i.~ .. .l ... ~.i.-• .. .l~ ... i ...• _L •. ..J •• ~-J.L__._J_,...J.~ . .J~L•-i;·•···L .•. .J.tl •... i-• .. .l ...•... i-•··:.13 ~ 

~~ -~~ ~CE1~~ mm 

L ::~ ~ E~!• ' Alignmlnt boxes I 
~tab well ~~;- ~Ei~~- iiilli 

Left margin space ,,,,,, 
::· 

~~:~~~~: box ~ii!r 
marker Single IJiiJI 

L_ _____ space 

box 

I 

MacWrite and the ltnagewriter are designed to funcHon with standard-sized paper. 
8'/2 inches wide. The ruler scale starts at 1 and ends just after 7 because this 
provides for a left margin of about an inch and a right margin of about an inch and 
a half. (1l1ese margin widths are only meaningful in the case of continuous- feed 
fanfold stationety, held in a fL-xed position by the Image-;vriter p ins. Single sheets of 
paper can of course be placed at any position along the platen.) In any case, it is 
impossib le to print a line w ider than 6% inches. Since the left and right margins are 
preset respectively at 1 '/8 and 7 inches, this means that the preset width of a line is 
57/ 8 inches. 

To vmy the line width, either of the little black arrowheads in the ruler can be 
dragged along the scale by means of the mouse. But if you look carefu lly at these 
two symbols in the preceding illustrations, you'll notice that they're nor ident ica l. 
In fact, the one on the left is a double symbol, composed of rwo separate pans that 
can be dragged along the scale in an independent manner. The triangular patt at 
the top is the actual left margin marker, and it h ides a tiny arrow which is the 
indentation marker for new paragraphs. We shall see examples of the use of these 
markers in a short while. 

1l1e t:wo tab wells cont:ain a stock of tabs that can be dragged out and placed 
underneath the scale. Notice that there is a preset tab at the 5 '/2 inch mark 1l1e tabs 
from the well on the left work for text, whereas those from the well on the r ight 
(which have a dot inside the triangle) function for numbers that have to be aligned 
with respect to their decimal po ints. To get riel o f a supertluous tab. you merely 
drag it downwards and it disappears inro thin air. 
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Indentat ion marker 

Left margin marker 

The three space boxes provide different spacings between lines, as indicated. 
You select the desired spacing by clicking the corresponding box, which is 
immediately highlighted in black. 

1l1e alignment boxes offer four possibilities: left-alignment, center-alignment, 
right-alignment or full -justification. 

Now, in order ro try out all these different formats, let us reopen the MacWrite 
document called "First text". To do th is, we do not need to tOuch the "MacWrite" 
icon, for the Open operation is carried out on the "First text " icon itself. We either 
select the "First text" icon and choose the Open command from the File menu 
(see following illustration), or else we simply double-click this same icon. To 
understand why this is so, you have to get back to the intuitive notion of objects 
and icons that pervades the whole Macintosh concept. At the beginning, when we 
wanted to create "First text", the object that we needed was the tool called 
"MacWrite", and so that's why we opened that particular icon. But now that "First 
text" actually exists, it has become the object that interests us. l t is ncvenheless 
true that, in opening the document called "First text", we shall also gain access 
once again, in a transparent manner, to the MacWrite application program. 



FO RMAT .\10DIFICATIO:>IS 91 

Once our familiar text is back on the desktop, let us stan our by changing the 
position of the indentation marker and the left and right margins, as shown in the 
fo llowing illustration: 

,.. • File Edit 'Search Format Font Style 
., 

First teHt 

.!. .. .J .... ... L ..... .... .. :J.?··-·•-• .. i··•· .. , ...... .J.~ .... .._ •. ...~ ............ .. .l.1 . ..J ...... .J ....... , _ .•. J.~ ........ _l.. ... ···• ... ·..:J..:.~ ......... .J ........ .... .. .l.7l:!: 

~~ ~[§1§1 ~~~~ I 
You can start to create a new document, 

using MacWrlte, as soon as this ·untitled" Window 
appears on the screen, Without having to change 
any o! the above parameters. In that case, your 
text appears on tlle Mactntosn screen in a preset 
format, font and style. The preset format 
corresponds to printed text with lines slightly less 
than six Inches long, left-aligned and single-spaced. 
The pr~et font is New York, and the preset style Is 
12-point Plain Text. Thanks to the word 
wraparound feature of Mac Write, you don't have to 
worry about hitting tne Return key at the end of 
lines.! 

I 

!l!ffi 
h=m 

Iii!!! 

llil~ 
td!,. 

~111; 
a~ I. 

liil.l. 
'·II· !ill; 

~ Q] 

l11e format of the text changes instantaneously, as soon as you drag each marker to 
its new position along the scale. 

Th is time, we'll keep the markers in their current posi tions, bur we'll click the 
full-justification box, at the righrhand end of the ruler. The result is as follows: 
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,.. • File Edit Search Format Font Style ., .. . .. . ·- ... . .. - First teHt 

.!.t. ... J.-.,.J ... .t. •• .J ........ !_.~ ... L . .l ... !" .. .l . ..J ... .I ••• l.~.a ... .I-. .L..l. . .t. ••• J_,a..,.l.1 ... .1 ••• .t. •• J ... .t..,.J-... .J.~ .... J.,,.a,:!:·"-'···A··.l:~• ... J .. . "-·1-o~. ... ! - ... J. 

l£il~ ~~E) ~~~~ mw 
You can start to create a new document, 

using MacWrite, as soon as Ulis "Untitled" window 
appears on the screen, WIUiout having to change 
any of the above parameters. In tbat case, your 
text appears on the Macintosh screen in a preset 
format, font and style. The preset format 
corresponds to printed text With lines slightly less 
than six inches long, left-aligned and single-spaced. 
The preset font Is New York, and Ule preset style Is 
12 -point Plain Text. Thanks to the word 
wraparound feature of Mac Write, you don't have to 
worry about bitting the Return key at the end of 
lines~ 

I 

Finally, we'll drag the indentation marker back to the same position as the left 
margin, to avoid paragraph indentation, and we' ll click the middle space box and 
the center-alignment box, which gives the following result: 

,.. • File Edit Search Format Font Style 
., 

First tent 

J •.. .~-.• _L . ....... . {?_._. ....... L. . .... _,.J.~,_a.~ ... L •. ..J ..... .1.1 .. 1-•-· J...~.._..J.~ •... '-~k•·-'-•-1~ ... ! .. • . .J.~ ... !.~.J.J 

t---:l£il=e:.:...;:~=-;,......__---='-=-'-=' =-' =' =-'--____;'=&;;;!C=-=''=:....:'' =;:&i!!i!=':..::'~='-f~~~: 
!"'; You can start to create a new document. using 

MacWrite, as soon as this "Untitled" window 

appears on the screen, without having to change 

any of the above parameters. In that case, your 

text appears on the Macintosh screen in a preset 

format, font and style. Tile preset format 

corresponds to printed text With lines slightly less 

than six inches long, left-aligned and single-spaced. 

The preset font Is New York, and the preset style is 

12 -point Plain Text. Thanks to the word 

I 

Ui!; 

ll~l: 
'1:11 
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1l1e last few lines of the text have now moved down below the lower edge of the 
document window, but you can access them easily by means of the venical scro ll 
bar. 

Insertions and deletions 

1l1e MacWrite manipulations that we shall be looking at now are capable of 
changing the actual contents of previously-created documents. 

In many of the MacWrite illustrations up until now, the pointer has been 
present, at various places on the desktOp, in the fami l iar form of an arrow. But, if 
you move the pointer onto the part of the MacWrite document window where text 
is entered, it changes into an !-beam. 

In the following i llustration, the blinking vertical bar that represents the 
insertion point is located at its normal position: that is, just after the last character 
that was typed (a full stop); and the !-beam pointer has been moved, by means of 
the mouse, to a position in the middle of the text. 

You can start to create a new document, using Mac Write, as soon as 
this ··untitled· Window appears on tlle screen, Without having to change 
any of tlle above parameters. In tllat case, your text appears on tlle 
Macintosh screen in a preset format. font and stylelThe preset format 
corresponds to printed text Witll lines slightly less an slx Inches long, 
left-aligned and single-spaced. The preset font ls ew York, and tlle preset 
style is 12-point Plain Text. Thanks to tlle word aparound feature of 
Mac Write, you don't have to worry about hittln tlle Return key at tlle end 
of lines .!~ 

insertion 
point 1-beam 

., 

If you click the mouse buuon, w ith the 1-beam in this posrtron, the blinking 
vertical bar will disappear from its present location and move to that spot on the 
screen. This means that, if you then stat1 to type on the keyboard, the characters 
will be inserted at this new position, not at the end of the text. 

111e following illustration shows what happens i f we move the insertion point 
to this new position, and then hit the <Return> key: 
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,.. • File Edit Search Format Font Style ' 
§] First teHt 

-k-•····-1·-•·-t··...i.?._. .. ~ ... L ...... •-·•-.l.~ .... l... ..... L •... , ...•.. .J.1 ... ,._ •... L. •... ,_ .•.. .J.~ •... ,_ .•. l;:·•-L .... l!L!.. .• _.L.._, ___ •.. J}~ 
~~ ~~s ~~~~ ~nm, 

tllis "Un~~~~~:~~toa~;:::s ao~e~ed:C:r~~:.n~~~~~ ~a~:~.c~~~;~n as ! __ ,: i_;:_:_,:~_.,)_.,i:_.' 
any ot tlle above parameters. In that case, your text appears on tlle 
Macintosh screen In a preset format, font and style. jj~j j 

§1~~~~~~~~~f:~~~Ef~~r~li~~r~~t. ll 

Hitting <Return> on the keyboard tells MacWrite that you \).:ant to start a new 
paragraph. The operation that we have just carried out can be described as 
insertion of a character into the existing document. Notice that the insertion point 
is still located just to the left o f the word "The", whereas the !·beam pointer has 
been moved clown to the lower region of the w indow. If you clicked the mouse 
button, with the l ·beam in this location, the insertion point would move back to its 
original position, just after the final fu ll stop in the text. 

At the beginning of the second line of the text, we have used the 
demonstrative pronoun " this'' when referring to the "Untitled" window. This is no 
longer coherent, since the name of the current w indow is "First text". So, to make 
the sentence comprehensible, let's cany out a deletion operation on the word 
"this", then we'll insert " the" in its place. 

111e deletion o f a word is a two-step process. First, you use the mouse to 
position the !-beam pointer somewhere in the middle of the word to be deleted, 
and you double-click the mouse button. 111e word is immediately highl ighted in 
black, as shown in the fo llowing illustration: 
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" • File Edit Search Format Font Style 
., 

D First tent 

-k··'···' ···L'-J -'··J:Z, ... L•.-l ...•... L. • . _I.~, .. .l ... L • .L,_L~ ... I.1 ... L.•- L•.-l ...•.. J.~,--,~-:;!:~ ·-·L-•-j·~'···'-· '·-L~ ... l ... • .. l:?IQ 
~~ 1~11 II I ~I II 11=1 m 

You can start to c::::=e a ~w document. using Mac';ite,-==soo:::: l!:iii 
IUII"'Untitled"" Win<low appears on tne screen, wltnout having to change mm 

~?cl~to~~ :::~ ;~r:~:;:;~f~~m~~\~~:~~~u:t~:. appears on the j~~~j 

§~~1~~l~R~~?~i~£~~~~gfA;ti~:g~r~:~~gt Ill 
mm 

Second, you pull dmvn the Edit menu and choose the Cut command, as shown in 
the following illustration: 

,.. J. .,.... 
,. File ~Search Format Font Style 

., 
-D t: nn·1 Undo :)[:2 ~ First tent 

.1-:.l ... , ... J..., ... !. . ... .1 ,...J .. ~ .. .J.1 ... L., ... l '···'·-'··.1.~'-· '-·'·:.!:·•··· '-· '·-l.~ ... l •.. .l ... , ... L.•-Jl ~ 
~ ~ Copy "' 3CC ~ ~ ~ ~ ~ ~ li 

'1. Paste 3CU tea new document. using Mac Write, as soon as !1i!!J 
DI"'UntJ ·················-····-····-_··········-···-····-· rs on tne screen, Witnout having to change Jiijii 

any of th Show Clipboard . In tnat case, your text appears on the ililii 

Macinto~~!c;;:~e~nf~r~=~~~:~;~~~~~~~ ~~~n~~1~xt witn lines slightly ijliil 
less than six inches long, left-aligned and Single-spaced. The preset font is ;;,,,, 
New York, and tne preset style is 12 -point Plain Text. Thanks to the word iilJ:i 

~:':~~;".~•;:.'::,:~'o~~~::'te, you don'thave to worry abouthittlng tile ~ 

:::::; ··:::: 
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The word " this" disappears instantly from the document (see following 
illustration), and the remaining text is automatically shifted to the left to fill up the 
hole left by the removal of the word. 

~ a File Edit S<Hin h formn t font '>tyh.> 

First teHt 

.~..J.-• .. J ...•.. t~ .. .J.? •... J_.,_L~i-• . .1~.-'-•·-L•--'-•···l~:\_.~-., .. J .. ~ .. .J •. ~.J.~.-J.~.;!·•·-J ...•. ..J.~.-J ...•... L~J...~_l! 

~~ ~ I II I ~ lall~l l === l 
You can start to create a new document, using Mac Write, as soon as 

.. Untitled .. Window appears on the screen, Without having to change any of 
the above parameters. In that case, your text appears on the Macintosh 
screen in a preset format, font and style. 

The preset format corresponds to printed text With lines slightly 
less than six inches long, left-aligned and single-spaced. The preset font is 
New York, and tlJe preset style is 12-pointPlain Text. Thanks to the word 
wraparound feature of Mac Write, you don·t have to worry about hitting the 
Return key at the end of lines. 

l:!D Cllpboord 
this 

~ 

IQi ~ 

If you pull clown the Edit menu and choose the Show Clipboard command, you 
can veri~' (see preceding illustration) that the Clipboard contains the word that has 
just been cut out of "First text". 

Incidentally, it's interesting to note that there are no less than jour ways of 
now removing the Clipboard from the desktop: 

J Click the Clipboard close box. 
2 Pull down the File menu and choose the Close command. 
3 Click the MacWrite document window alongside the Clipboard. 
4 Pull clown the Edit menu and choose the Hide Clipboard command. 

As soon as the Clipboard disappears from the desktop, and the MacWrite document 
window becomes active once again, we find that the blinking ven ical bar reappears 
at the ve1y end of the first line of our text, after the word "as' '. So we merely have 
to type in the word "the" on the keyboard, and we obtain the following result: 
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'" • file Edit Search format Font Style 
., 

First teHt 
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You can start to create a new document, using Mac Write, as soon as jjjjjj 
thej"UnUUed" Window appears on the screen, Without having to change any mm 
of the above parameters. In that case, your text appears on the Macintosh mm 
screen in a preset format, font and style. ::!!!: 

Tile preset format corresponds to printed text With lines slighUy ~m: 
less than six Inches long, le!t-allgned and single-spaced. The preset font Is ii!i!i 
New York, and the preset style is 12-pointPlaln Text. Thanks to the word i!!lii 
wraparound feature of Mac Write. you don·t have to worry about hitting the mm 
Return key at the end of lines. ii:i!i 

mm I :;:;:: 

TI1ese two operations- deletion of "this" followed by insertion of " the" - can in 
fact be combined, enabling us to speak of replacement. Only two srcps are 
involved: 

1 Use the mouse to position the l·beam pointer somewhere in the middle of the 
\VOrd to be replaced, and double·click the mouse buuon. 

2 Tyve the new word. 

Let us now examine the deletion of a whole block of text. In the following 
illustration, almost three lines of text have been selected, and are now highlighted 
in black: 
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t,:. I t-::t · ·;tj , !ttt-: :!I?LtJ:· 
···:! •: · .... ! Tl•- !:1-: -1 i ·:ll l 1: 

hanks to the word 
wraparound feature o! Mac Write, you don't have to worry about hitting tlle 
Return key at the end of lines. 

1l1is selection is carried out - as explained already in the chapter on the cut & 
paste concept (page 48)- by dragging the 1-beam pointer dmm alongside the three 
lines, and then <tcross to the spot in the th ird line where the selection is to encl. 

The Cut command, from the Edit menu, is used to carry out the deletion of 
the selected text. 

If we open the Clipboard ( see following i llustration), we rediscover the 
deleted text. 

" 45 File Edit Seen h r ormnt ront ~ ttj i P. 
., 

First teHt 
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You can start to create a new document, using Mac Write, as soon as 
the "Untitled" window appears on the screen, without having to change any 
of the above parameters. In that case, your text appears on the Macintosh 
screen in a preset format, font and style . 

Thanks to the word wraparound feature of MacWrite. you don't 
have to worry about hjtting the Return key at the end of lines. 

t:o Clipboord 

he preset format corresponds to printed text with lines slightly less 
than six inches long, left-aligned and single-spaced. Tne preset ront Is 
New York, and the preset style is 12 -point Plain Text. 

~ 'Qj 
t-
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Nmv suppose that we decide that, instead of permanently deleting these three 
lines, we would like to move them ro anorher place in the "First rexr" document: 
say, at the encl. TI1e following illustration shows how this is clone: 

,.. • File .... Seorch Formot Font Style 

~0 Undo Typing :ICZ ~ First teHt 

., 

.~..J .•. , .• .J ... '-·! ·-··[ ;~-;·········-··· ···-····-··-·~~: ;;- ~-·'·· ~J.1_!~ . ..J.~ .. .l ... L • .J.~~L•-l;:·•···'···~J~ ... ! ... ~L.-l .. ~-ll g 
~~ [O!Hj :•:C G ~~~~ 1m;! 

-···~---~···-:._ .. :) ... -.... ·--··-:···-·· a new document, using Mac Write, as soon as i!~!! 
~e~~~~ s~ow Clipboard a~nc::. ~~:~:::~~~~:~~~~ ~a~~!~:y iill:i 

::::~:{~~£~{.~k~r:JE~~l~~·~~Z'.~d·~~;.~~/o" don< ~~ 

\Y/e want the displaced lines ro appear as a third paragraph, so the blinking venical 
bar had to be set at the right position, as indicated in the preced ing illustration. 
Th is operation rook p lace in two steps. First, the 1-beam was moved to the lower 
region of the window, and clicked, which set the insenion point just after the final 
full stop. Second, we hit < Rerum> , which moved the blinking venical bar to irs 
present location. 

Now we pull down the Edit menu and choose the Paste command, so that the 
contents of the Clipboard w ill be transferred ro the document w indow, starting at 
the inse1tion poinr. 

TI1e final result is shown in the following illustration: 
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You can start to create a new document, using MacWrite, as soon as 
tile "Untitled" Window appears on tlle screen, Witllout having to change any 
of tlle above parameters. In that case, your text appears on tb.e Macintosh 
screen in a preset format, font and style. 

Thanks to tile word wraparound feature of MacWrite, you don't 
have to worry about hitting the Return key at tile end of lines. 

The preset format corresponds to printed text witll lines slightly 
less tb.an six inches long, left-aligned and single-spaced. The preset font is 
New York, and the preset style Is 12-polnt Plain Text. I 

I 

.., 

If you were ro open the Clipboard now, you would find that the three lines are still 
there. In other words, the same Clipboard information could be pasted into several 
clitlerent places in a document. l11e Clipboard w ill lose its current information, of 
course, \''hen the next Cut or Copy command is c-arried our. 

There is anorher way of deleting characters in a MacWrite document. You simply 
position the !-beam pointer at th e righthancl end of th e text to be deleted, and you use 
the < Backspace> key. But the deleted characters are nor sent ro the Clipboard in this 
case. On the contrary, they are permanently lost. 

For a newcomer to MacWrite, probably rh e most d i fficult operation to get used to 
is the selection o f fragments of rexr (as in the preceding example) that are to be 
deleted, replaced or moved. If you don't have a steady hand on the mouse, the black 
highlighting has a tendency to run o ff in the wrong direction. l11ankfully, there is a 
very handy trick, in two steps, for highlighting precisely and rapidly. First, you position 
the !-beam pointer to the immediate left o f the text to be selected , and you click the 
mouse button. l11en you position the !-beam pointer to the immediate right of the text 
to be selected, you hold down the < Shift> key and you click the mouse button , 
whereupon all the text between the r·;vo bounds is highlighted in black. 
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Pretty print 

One of the most striking features ofMacimosh is the elegance and variety of its graphic 
output, both on the screen and on the lmagev.rriter primer. Naturally, MacWrite takes 
full advantage of this property of the machine. 

Let us look at an example. The following i llustration - a document entitled 
"Second text"- shows half-a-dozen lines of ordinal)' New York font in 12-poim Plain 
Text style: 

Many professional people have to write technical reports, 
manuals, articles tor magazines, publicity documents, etc. 

It's usefUl to have a machine that lets you type an entire 
phrase in italics. On the other hand, some things are best said 
in boldface. 

Chapter headings need to be big ... 

I I 

., 

If you want tO change the style or type size of any particular part of this text, the 
first thing to do is to use the mouse to drag the 1-beam pointer over the characters 
that are to be modified . l11ey are immediately highlighted in black (see following 
illustration). 

Then you can pull clown the Style menu and choose from several d i fferent 
typographical styles and sizes. 
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Chapter headings need to be 
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Ill [piDik:D{I 
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., 

TI1e following illustration shows the same document presented in an assonment of 
Plain Text, italics and boldface: 

,.. • File Edit Seorch Format Font Style 
., 

![] Second teHt 

l._._ ... ·l::·~· ... ······J?•.-• ... ~.L.....o ..... ~ .......... ..L .... ,_,_L'.\.. .... _~..J.~.-'··· .... 1~-'···•-:!:. .. ·· ·'·~·.J.~ •... , ...... :J,;~·-'-'·...l. 

~~£~ ~~EI ~~~- ijlli: 
Many professional ~pte have to write technical reports. '·•·•· 

manu~~:sa~~;:~~ :;~~~g:z:::~t!~b~~~~e~oc;:et~~ e:; rl!, •• i,~.:',:· .• J ... ~ .. : ~'i •. ··,:l··'!::;.:; •. · 

~ntJr~ p1Jn1s~ in it~'llks. On the other hand, some things 
are best said in boldface. 

Chapter headings need to be big... !ijl!: 

I 
lr 
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Here are samples o f several differenr fonts and sryles that are o ffered by MacWrite: 

This i5 New York Coot in 12-point Plain Text style. 
'l'bU is New Ycwt font in 12- polnt Bold tlyle. 
This is New York font in 12-poinl Jt•Jic .1/yle. 
TIH.6 1.6 N~JY Tork fo111 111 12-poilll llold 111/Jc .61}'1~. 
TlalJ II !flY Tort tnt In 12-poblt Oot.U.u ttyl8. 
Tille 11 •ew Tert tnt Ia 12-telat llla•ew ltJle. 

This is Toronto font in 12-polnt Plain Text style. 
This is Toronto font in 12- point Bold Style. 
This is Toronto font in 12 -point Italic style. 
This is Toronto ront in 12-polnt Bold Italic style. 
Thll 11 Tcronto font 1n 12-polnt OUtline ltyle. 
Thlt 11 TOI'On\o fon\ ln 12-poln\ lhadow 1\gle. 

This 11 Chltago font In 12-polnt Plain Teat style. 
Tills Is [lllc•t• f••• •• 12-11a1at lelll 111111. 
This Is Chlc11g11 f1111l Ill 12-pll/111 11111/C si!JIIf. 
T~/6 /6 t:~/e11g11 fll•llll 12-JIIII•IIII/1111111/e dgiii

'IJI)ta ~ lmlbqJD Ollmlllbl u I-{JD8D{IIIbJOJD ~ 
'IJIJa1 ~ lmlllqJD fllmllllb ~~~ EmQmD DIIDD. 

1t{Jts ts loPou font tn tS-potnt llatn ltut stple. 

For the author ofrechnical reports, articles or books, it's hard ly an exaggeration to say 
that working w ith a Macintosh, MacWrite and an Imagewriter is a littl e like having your 
own private printing press tucked away in a space no bigger than a travel bag. 
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Rulership 
Up until now, our MacWrite examples have included a single ruler at the 
beginning of the document. In fact, nothing prevents us from inserting any number 
of different rulers in the document being created by means of MacWrite. 

Suppose that we are producing a document called "Third text", that starts out 
as shown in the following illustration: 

~- -- -~-::=-=- - -_ -:--=-~--=-~---- -::·:-
-- --- -- -·---- -· ----·-

The possibility o! being able to ln~rt new rulers at 
any point In a Mac Write text has two conSiderable 
advantages~ 

., 

At this point, judging from the text, we are about to write two subsidiaty 
paragraphs, describing the "two considerable advantages" of ruler insertion in 
MacWrite. In order to give these paragraphs a distinctive layout, let's insert a new 
ruler. TI1is is clone by pulling down the Format menu and choosing the Insert 
Ruler command, as shown in the fo llowing illustration : 
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Edit Search 
., 

111e first ruler set the left margin at the 2" mark and the right margin at the 6" mark, and 
there v.:as no paragraph indenration.111e new ru ler (see following illustration) can be 
set quite differently: left margin at the 2%" mark, right margin at the 5" mark, and 
paragraphs that actually stalt %" to the left o f the left margin. 

r 46 File Edit Search Format Font Style 

. . _·_-·=...:..._~:=:- .: --~-- ... --:- - - Third teHt 

1 

2 

It is very simple to use a quite 
different format right in the 
middle of a text. 

The rulers don't interfere with 
the text, because you can hide 
them whenever you like. 

., 
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The two numbered paragraphs cotTespond perfectly to the new format 
We would now like ro see the complete documenr w ithout the two rulers. 

This is achieved by choosing the Hide Rulers command in the Format menu, as 
shown in the following illustration: 

1 It is very simple to use a quite 
different format right in the 
middle of a text. 

2 The rulers don't interfere with 
the text, because you can hide 
them whenever you like. 

TI1e final result is shown in the following illustration: 

,. • File Edit Search Format Font Style 

~0 Third teHt 
The possibility of being able to inser t new ru1ers at 
any point in a Mac Write text has two considerable 
advantages: 

1 It is very simple to use a quite 
different format right in the 
middle of a text. 

2 The rulers don't interfere with 
the text, because you can hide 
them whenever you like~ 

., 

., 

I 
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If we now wish ro pur rhe rulers back imo the displayed rexr, we simply choose the 
Show Rulers command in the Formar menu, as shown in rhe following i llustrarion: 

,.. • file Edit 

1 

middle of a ooxt. 

2 Tbe rulers don't inoorfere witll 
tlle ooxt, because you can hide 
tllem whenever you like. 

., 

Maybe we might decide to remove hoth a ruler and a b lock of text In that case, we 
drag the pointer down over the ruler and the text to be removed, in order ro 
highlight them (see following illustration), and then we choose the familiar Cur 
command in the Edit menu. 
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To be precise, there's only one thing you cannot cut out of a MacWrite document: 
namely, the first ruler. 

People who have worked with the old-fashioned methods of layout 
specifications in word processing, using all kinds of embedded codes, will surely 
agree that the MacWrite concept of rulers is ingenious. As usual, you can actually 
see, instantaneously, the effect of a new ruler upon the layout of your documem, 
and so there is no possibility whatsoever of ambiguity. 

Another remarkable feature of MacWrite concerns the top and bottom page 
margins, called headers and f ooters. ln many conventional word processing 
systems, the handling of this subject - that might be referred to as "page breaks" 
( for wam of a more precise term) - is frankly messy. MacWrite, on the other hand, 
proposes the simple and elegant solution of autonomous windows, with mlers, for 
both the header and the footer. 

To get at such goodies, you use one or other of the powerful commands of 
the Format menu, that have appeared in several of the preceding illustrations. 
Show Header, for example, gives rise to the following window: 

r- • File Edit Search Format Font Style 

. -
- - Header 

mJ 
-~-L. . ... I... . ... L. ... . l.? .... L~ .. L . ... t..~ ... l.~ . ... L._L . .. L. . .. J~L . .l ...... J .. ~ .. L . .. l~-L•·;!:·•·...I .. ~.J.~.-L ... L . .. L•-1 

l£il ~ ~ ~]§] § ~ [:1 [j5] -

mastering your macintosh 

., 

We have imagined here the case of an author who would like the title of his book 
- "Mastering your Macintosh" - to appear at the top of evety page of the 
typescript. 

Here's an example of the outcome of choosing the Show Footer command: 



FIND IT AND CHANGE IT 1 13 

r 4li File Edit Search Format Font Style 
., 

-~·-'-~-'-~..._._j~_. ... ~.L._........J~~L.. • .....I.~ . ..J.......!..'!_..__._.L._J_ •. .J~-•--~_k-. ..J ...•... ~•-'·~···L-•~4 

~r.i) -~E) ~[&]~~ 

chapter 5 

For both the header and footer w indows, any quantity of standard text can be 
typed in ... such as document tirles, chapter names, etc. In add ition, the user can 
drag down any of the three little icons just below the title bar: page number, 
calendar date and clock time. So, the author can prim out numbered pages that are 
stamped with the references of the exact momenr at which they were produced. 
\'V'hat more could you ask for? 

Find it and change it 

Quite often, in word processing, we want to find all the occurrences of such-and· 
such a term, maybe w ith a view to substituting another term in its place. 

Look at the following short document, for example, entitled "Circular" : 
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I realize today, Sarah. that you are the most Important woman In my Ufe. 
Every time I think of you. my dearest sarah. I realize that we should see 
each otller more often ... and that's wtly I'm asking you to spend a weekend 
with me In cann~ as soon as posSible. I hope youu understand, darling 
Sarah, that I think of you day and night, and of you only. AU my love ... 
I 

I 

, 

Let's suppose that we want to locate all the occurrences of the word "Sarah". To do 
so, we statt out by pulling down the Search menu and choosing the Find 
command, as shown in the following illustration: 

-:=-~ ====== ~~- ------=-~-------- --- ---~~-

I realize today, Sarah, that you are tile most Important woman In my life. 
EVery time I think or you, my dearest Sarah, I realiZe tllat we should see 
each other more often ... and that's wtly I'm asking you to spend a weekend 
with me in Cannes as soon as possible. I hope you·u understand, darling 
Sarah, that I think or you day and night, and or you only. All my love ... 

, 

A dialog box appears on the desktop (see following illustration), asking us to spell 
out what it is we want to search for in the document. Notice that it doesn't matter 
whether you use upper o r lower-case letters. 
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r li File Edit Seanh f"ormut f"ont ~tljh.' 

Find - --- -

Find whot l._s_n_n_n-'~-------------------'l~ 
[ Find Nettt J ® Whole Word 0 Portiol Word 

I realize today, IIIII that you are the most Important woman In my liCe. 
Every time I think of you, my dearest sarah, I realize that we should !>* 

each other more often .. . and that's Why I'm asking you to spend a weekend 
with me in cannes as soon as possible. I hope you'll understand, darling 
sarah, that I think of you day and night, and of you only. All my love ... 
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1l1e first "Sarah" is highlighted in black. You can then cl ick the Find Next button 
to carry on searching for funher occurrences of the same word, as shown in the 
following illustration: 

r li File Edit Se<Jr<h f"ormnt f"ont ~ttjh.' 
., 

= Find 
1 l snnn~ , ... JJ ":f"'-·- find whot 

I~H ~ l Find NeHtj ®Whole Word 0 Portiol Word 

I realize today, Sarah, that you are the most important woman In my life. 
Every time I think of you, my dearest 11B1 I realiZe that we should see 
each other more often ... and that's Why I ·m asking you to spend a weekend 
with me In cannes as soon as possible. I bope you·u understand, darling 
Sarah, that I think of you day and night, and of you only . All my love ... 

1-

If ever you decided that the most recemly-found occurrence of the word does not 
interest you, it's possible to call upon the Undo Find Next command in the Edit 
menu (see foiiO\ving illustration) in order to rerum to the previous occurrence. 
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~ - . - - .. - --·--
_..;: ~ --~ -~~-- . .: :...=::-::-~:=-~-=--

0 Partlnl Word 

Show Clipboard 

I realize today, sarab. that you are the most Important woman In my U!e. 
Every time I think of you. my dearest- 1 realize that we shoUld s~ 
each other more often ... and that"s Why I'm asking you to spend a weekend 
with me In Cannes as soon as possible. I bope you'll understand, darling 
sarah, that I think of you day and nlgbt, and or you only. All my love ... 

., 

TI1ere is also a Change command in the Search menu, as shown in the following 
illustration: 

I realiZe today, Sarab, that you are the most Important woman In my It! e . 
Every time I think or you, my dearest Sarab, 1 realize that we should ~ 
each other more often ... and that's why I'm asking you to spend a weekend 
with me In cannes as soon as possible. I hope you11 understand, darling 
Sarall, that I thlnk o! you day and night, and of you only. All my love ... 

., 
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Let's suppose that we intend to change every occurrence of "Sarah" into "Marie
Louise". TI1e precise manner o f doing this is shown in the fo llowing illustration: 

,. • File Edit S(~ <Jn h J'ormut Font ~ tylt~ 
, 

• Change 
1 Find what 'sarah li :f""'-'-
~J Change to 
~ 

: Marie-Louis~ 
(Find NeHt ) ( [ hnogP.. thPn Find ) [ [ hong•~ ) ll.bhJ.mpi 

@Whole Word 0 Partial Word 

I realiZe today, Sarah, that you are the most important woman in my lite. 
EVery time I think o! you. my dearest Sarah, I realize that we sbould see 
each other more often ... and that's why I'm asking you to spend a weekend 
with me in cannes as soon as possible. I hOpe you11 understand. darling 
Sarah, that I think o! you day and night. and o! you only. AU my love ... 

r-

Clicking the Change All button in the dialog box means that we Mmt ro change eve1y 
occun·ence of the argument word, nor just the first one. Macintosh, ever conscious of 
the dangers of behaving in a foolhardy manner, asks us (see illustration belmv) if we're 
really sure that we know what we're doing. 1his kind of 'Ml111ing is called an ale1t box. 

,. • File Edit Se<Jn h Formot Font ~ h.Jh.• 
, 

Chan e 

Find what I Sarah 
Change to 1-~-a-rl""'e""'-""'L""'o""'ul""'s""'e---------------fliil 

(Find NeHt ) ( [ hOOIJP. thPil t=ind ) (t: hoogp ) ( Change All ) 

• Whole word Partial word 

WARNING! •change All• Is NOT Undo-able! 

I1U llill'r11J ( cancel ] 
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As soon as we click the Go Ahead button, the irreparable modification is carried 
out, and we obtain the following elegant result: 

" • File Edit Search Format Font Style 
., 

Circular 

.~...a ........ L... ........... !.?....l_. ... L • ....a_._l.~ . ...a.~L._l_..._L1.. . .~. ..•. .J ...... _ ........ J.;? ...... ~-_!·•·· ... ~ . ..l.~ •. ...a ...•... L .•... .L. ..... :J} I£ 
~~ -~[3 ~~~~ 1f: 

TI1at brings us to the end of our presentation of MacWrite. We shall nevettheless be 
returning to this subject later on, to show how images created by MacPaint and 
MacDraw can be incorporated into MacWrite document&. 

No doubt the most astonishing thing about MacWrite is the fact that, in a text 
processing environment, so much can be carried out by means of the mouse 
alone, without having to use the keyboard. Once you've gotten into the habit of 
using MacWrite and the mouse to churn out correspondence and professional 
documents, it's practically impossible to revert to antiquated methods of text 
preparation. There is no longer any sense in carrying out guessing games about the 
marketing potential of Macintosh, but it's probably true to say, retrospectively, that 
this machine, armed with MacWrite, could have been offered to the public as no 
more than an avant-garde word processing system, and already it would have 
become a best seller. 



chapter 6 
"MacPaint" - Image Processing 

Apparently it was :-.iapoleon Bonaparte who once declared that a freehand sketch 
provides more info rmation than a thousand words. He was right, for once, but it 
remains a t~tct - even today - that professional people have never really acquired 
the habit of insening sketches into their correspondence and rep011s. Why is there 
this reluctance ro use images? Maybe one explanation is that we have become 
accustomed to using simple machines -such as the typewriter and the telephone 
- which make it easy for us to communicate by means of written or spoken 
words. whereas the idea of producing sketches has always seemed to be a 
relatively onerous task that is best left to graphics anists. In panicular, there has 
never been a simple machine, like the typewriter, that would enable people who 
are not necessarily anists to produce attractive sketches that could be inserted into 
their t)1)ed documents. 

That machine now exists, and its name is . . . Macintosh. l11e processing of 
graphic material is a fundamental concept in the case of this new machine, and it is 
no accident if Macintosh has appeared on the market with two splendid software 
tools in this domain: MacPah1t for freehand image processing, and MacDraw for 
structured technical drawing. 

Electronic painting 

MacPaint is housed on the 5ame disk as MacWrite, and it is opened in the normal 
manner by double·clicking the directory icon labeled "MacPainr". 

After a few seconds, the distinct ive MacPa int window arrives on the screen, as 
shown in the following illustration: 

11 9 
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It is a fact that about 90% of the possibilities of Mac Paint can be grasped intuitively 
once you sit down in front of a Macintosh and start to play around with this 
software tool. Even a child with no training whatsoever in the manipulation of a 
personal computer can rapidly attain this level of performance. (Maybe that last 
sentence should be changed to read: "Especially a child with no training 
whatsoever .. . ",because children are often more successful than adults in geuing 
used to a revo lutionary concept such as electronic painting.) 

To the left of the main window, there's a block of 20 icons that represent 
painting tools of many different kinds. Underneath the main window, there's a 
block of 38 patterns that you might think of as your paleue of painting colors. And 
the lower left corner of the screen proposes several alternatives for line and border 
widths. 

In order to learn the names of the various MacPaint tools, you can pull down 
the so-called Goodies menu, as indicated in the previous illustration, and choose 
the Introduction command. The result is as follows: 



ELECfRONIC PAINTING 

+- spray paint @] +- no border 

} 

line & border 
widths, m~ltiple 
copy spacmg 

current 
pattern patterns 

l ,-----~~----, 

To get rid of this display, click the Cancel bunon in the lower right corner. 
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'I11e pencil is probably the best tool ro start out with. To use it, you move the 
pointer onto the pencil icon and click it. When you move the pointer back onto 
the main window, it has acquired the same form as the pencil icon, and you draw 
simply by dragging the pencil pointer over the window, as shown in the following 
illustration: 

., 

..,_ -- o 
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The pencil always draws lines of the same width, irrespective of the indications 
down in the lower left corner of the screen, and the color does not depend on 
which pattern has been selected. The rule for pencil colors is elementary. If you 
start dragging the pencil on a white background, the trace is black and it remains 
black as long as you keep the mouse button held down, even if the pointer moves 
over a black zone on the window. Inversely, if you stan dragging the pencil on a 
black background, the trace is white. 

later on we shall see that the pencil has another ve1y imponant role to play, 
when parts of an image are enlarged for point-by-point modifications. 

To rub out parts of the screen, click the eraser icon, just below the pencil 
icon. TI1e pointer rakes the form of a white square (see fo llowing illustration) that 
you can drag across any part of the image that you wish to erase. 

To erase the entire window, simply double-click the eraser icon. 
Let us turn next to the brush, whose icon appears just to the left of the penci l. 
The brush is used for sketching in the same manner as the pencil, but it 

operates in a more complex fashion. 
Before actually manipulating the brush, let us pull down the Goodies menu 

once again and choose the Brush Shape command. Alternatively, you can simply 
double-click the brush icon. The outcome is shown in the following illustration: 
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• • / " :'·· .. 

I D , 

He re we have a choice between 32 d ifferent "shapes" for our brush. The present 
shape is the one enclosed in a square, but we can choose anorher shape simply by 
moving the pointer onto it and clicking it. Let's choose the second ·biggest square 
shape. 

1l1e following illustration shows the result of using this brush to trace a word: 
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Before using the brush, we moved the pointer down to the pattern that is located 
four from the righthand end of the top line, and we clicked it, making it the 
current pattern. As you can see, the brush actually does its painting using the 
current pattern as its "color". 

Let us now erase the contents of the window, and select the spray paint tool, 
whose icon is just above the pencil. And let's choose plain black paint down at the 
bottom of the screen. The following illustration shows what you can obtain by 
dragging the spray paint tool around on the window: 

The tool with a big letter A for icon enables you to insert text into MacPaint 
images. In much the same way as in MacWrite, you have access to a Font menu, a 
FontSize menu and a Style menu. On the next page, there is an example of an image 
containing te.xt. Once the text has been entered, MacPaint no longer "thinks" of it as 
text, but as just another part of the global image. 
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, 

Text can be inserted easily Into any MacPatnt image. 

(this arrow, too) II 

Rubber banding 
In the Macintosh context, one frequently encounters the concept of rubber 
banding. What is meam by this expression? 

Let's start out with the case of one-dimensional rubber banding. Imagine that 
you're holding on tO one end of a stretched piece of elastic, the ather end of 
which is pinned to the top of the table by a thumbtack Ac; you move your hand 
over the table tOp, the extended elastic changes direction, and lengthens and 
shortens. 

This phenomenon is simulated by the line tool, whose icon is located just to 
the left of the eraser. I f you click this icon, the pointer reappears on the drawing 
window in the form of a cross. As soon as you press the mouse button, MacPaint 
reacts as if you had just tacked down one end of the piece of elastic at the current 
position of the cross. Then, as you hold the button down and move the mouse 
around, you can actually follow the evolutions on the screen of an elastic- like 
straight line that changes direction, lengthens and shonens, according to the 
movements of the mouse. 

When you finally release the mouse button, the line ceases tO behave like a 
piece of elastic, and its current form is recorded on the screen, as shown in the 
following illustration: 
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e 

-
In this window, the positio n of the metaphorical thumbtack (where the line was 
started) is dov.rn in the lower left corner of the window, and the cross marks the 
spot where the mouse button was re leased and the line ended. 

We have he re a first example of a tool that takes into account the setting of the 
line width down in the lower left com er of the screen, as shov.rn in the following 
illustration: 

r 6 File Edit Goodies font fontSize Style 

• 
,.,_ . 



RUDBER BANDING 127 

TI1is illustration shows four lines traced with the different widths. To change the 
line width, you simply position the pointer on the desired width and click it, 
whereupon a check mark appears to the left of the selected line. 

Incidentally, if you wish to draw lines that are either perfectly horizontal or 
venical or inclined at 45• , then all you have to do is to hold down the < Shift> key 
while you're dragging the pointer. 

Let us now turn our attention to the case of two-dimensional rubber banding, 
which means that it's as if we were using a closed rubber band instead of a length 
of elastic. Here, the general idea is that the metaphorical rubber band is attached to 
one point, and that its fixed shape ( rectangle, ellipse) can be enlarged or reduced 
simply by dragging the pointer. 

This behavior is exhibited by some of the ten drawing tools whose icons 
appear in the lower half of the block. 

To use any of these tools, click the desired icon, and then drag the pointer 
around the window, as usual, to draw. In the case of all these ten tools, the poi mer 
itself is in the form of a cross. 

TI1e five tools on the left are referred to as hollow shapes, because you end up 
with black line drawings on a white background. l11e width of the lines is 
determined by the serring down in the lower left corner o f the screen. 

TI1e following illustration demonstrates the use of the ho llow rectangular 
shape: 

r • File Edit Goodies Font FontSize Style 
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D 
D 

TI1e five drawing tools whose icons appear below the eraser are referred to as filled 
shapes. TI1ey behave like the ho llow shapes, except that the resulting line drawings 
are filled in with the current pattern. 

The following illustration shows us various rectangles that are filled in with an 
assortment of patterns: 
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The round-cornered rectangles and ellipses behave in a similar manner. The 
following illustration shows us an assortment of ho llow and fi lled shapes made 
with these tools: 

, 

DO 
- • 
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Freehand drawing 

The heart-shaped icons just below the ellipses are used for sketching irregular 
shapes. The hollow heart is just like the pencil, except that it takes account of the 
line width setting down in the lower left corner of the screen. The filled heart is 
more complicated, in the sense that the shape has to be closed in order to be 
fi lled. So, as soon as you stop dragging the pointer, and release the mouse button, 
MacPaint closes the shape by tracing a straight line from the point where you 
stopped back to the beginning of the curve. 

l11e following illustration shows samples of various irregular shapes drawn 
with these tools: 

The two tools down the bottom are for drawing series of connected straight lines. 
As long as you ho ld the mouse button pressed down, the line b eing drawn at any 
particular moment reacts like a piece of elastic, in that it follows the pointer to any 
spot on the window. Then, as soon as you release the mouse button, the line is 
terminated, and you can start dragging the pointer in another direction ro draw 
another line. Finally, to terminate the drawing, you double-click the mouse button. 

In the case of the tool for fi lled shapes, MacPaint closes the series of straight 
lines by connecting the point where you double-clicked to the beginning of your 
series of lines, and this gives rise to one or several painted polygons, as shown in 
the following il lustration: 
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One final precision: If you select the dotted line down in the lower left corner of 
the screen, that means that filled shapes will be painted without borders, as shown 
in the following illustration: 

, 

--=-===--· -:..:~-=:_-::::::;.-::_7. ~ ----- ------- ---. 

·111111111 1
11 
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You can replace any of the 38 existing panerns by panerns that you yoursel f design. 
This is done either by pulling clown rhe Goodies menu and choosing the Edit 
Pattern command, or by double-clicking the panicular pattern that you wish to 
replace. Let's imagine that we want ro replace one of the vettical-striped patterns, 
as shown in the following illustration: 

1l1e square on the left contains an enlarged fragment o f the panern that you see in 
the square on rh e right. 

The black and wh ite points in the square on the left are changed by pointing 
ar them and clicking them. As rhe points are modified , rhe overall pattern evolves 
ar the same time. 

1l1e final resulr might be as shown in the following i llustration: 
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., 
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Click the OK button to confirm that we wish ro retain this new pattern, which we 
shall now use to do some paiming. The new pattern immediately replaces the o ld 
one in the box down at the bottom of the screen. 

There's another tool called the area fill - represented by a pot of paint, just 
to the left o f the spray paim icon - that can be used for painting. 

First of ail , let's draw the word "apple" (see fo llowing illustration), using the 
paint brush. We then select the pot of paint. Now, each time we move the pot of 
paint onto one of the lerrers in "apple", and click it, the letter is fi lled up with the 
newly·designecl pattern. 
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just above the icon in the form of a letter A, there's a dotted rectangle that is used 
for the selection of parr of a Mac Paint picture. 

Let's suppose that we draw a rabbi t in the middle of the screen. Next we click 
the selection icon. "When we move the pointer back onro the main w inclow, it 
appears as a small dotted cross. If we move this cross to a spot just to rhe top left of 
the rabbit's head, and then drag it down diagonally across the image, a flickering 
dotted rectangle appears around the beast, as shmvn in the following illustration: 

___ :._~ ---=-~=-~.:.._.....=;.....::..-.:-= . -·-- - --
--------

i-~---------- : 
I I 
I I 
I I 
I I 
I I 
I I 

~---------- -..<. 
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We now say that the rabbit is selected. It may happen that the position of the 
rectangle does not satisfy you; for example, you might have sratted the dragging 
from a position that's roo low, and clipped off patt of the ears. In that case you 
simply undo the selection by clicking at some position outside the present 
rectangle, which disappears instantly. Then you can reselect the rabbit 

Once you've selected something in rhe MacPaint window, there are all sorts of 
things you can do with it. Let's statt off with the simplest operation, which consists 
of shifting the image around on the window. To do this, you move the pointer 
inside the selection rectangle. In this position (see following illustration), the 
pointer ceases to be a dotted cross, and becomes an ordinaty arrow. Now you can 
drag the image to any spot you li ke. 

., 

:~-------- ~-: 
I I 
I I 
I I 
I I 
I I 
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Another interesting thing you can do with a selected image is to use the cut & 
paste concept that we presented in Chapter 3. To do this, pull down the Edit menu 
and choose the Copy command. This means that the image of the rabbit is copied 
onto the Clipboard. Next, undo the present selection by clicking at some place 
outside the dotted rectangle. l11en pull down the Edit menu once again and 
choose the Paste command. A selected copy of the rabbit reappears in the middle 
of the window, as shown in the fo llowing illustration: 
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You can however get the rabbits to multiply without having to use the cur & paste 
technique. Simply hold clown the < Option> key as you drag the image. l11e result 
is sh0\·\'T1 in the follmving illustration: 

:-~--- ----~--: 
I • I 
I I 
I I 

~ L_ _________ j 

~ 
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'TI1e lasso, to rhe left of the clotted rectangle icon, provides an alternative manner of 
selecting something in the MacPaint window. Instead of enclosing the selected 
image in a rectangle, the lasso places a flickering t ightened "rope" around the 
selected item. From that point on, you can operate on the selected image in 
exactly the same way as for the rectangle. 

Let's get back to a single rabbit in the middle o f the window. TI1ere's stil l a 
copy of the original animal on the Clipboard, so all we have to do is to double
cl ick the eraser to clear the window, then pull down the Edit menu and choose the 
Paste command. Next, let us select this solitaty creature with the lasso. l11e outline 
of the rabbit, once selected, stal1s to shimmer in a curious manner, almost as if it 
were animated. :"-low we' l l drag a copy of rhe selected image to various pans of the 
window, while ho lding down the < Option> key, as in the previous example. l11e 
result is shown in rhe follmving i llustration: 

., 

===------
--=-=-~--=-=---=::.__::;_-- --

Let us double-cl ick the eraser to get rid of this multitude of mammals, and rerum 
to a single specimen in the middle of the screen. It remains selected by a 
rectangle, because that's the ·way we copied it into the Clipboard earlier on. 

We can pull down the Edit menu and choose the Flip Horizontal command, 
as shown in the following illustration: 
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Here's the result: 
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Let's drag him up ro a corner o f the screen, and paste in another copy of the 
original rabbit in the center of the window. l11is time we'll choose the Flip vertical 
command from the Edit menu, which produces the following result: 
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The < Option> key allows us to drag a copy of this inverted rabbit across to the 
right , then we'll reselect the one in the middle of the window and ask for the 
Rotate command from the Edit menu. l11e result is as fo llows: 

r • File Edit Goodies Font FontSize Style 
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Having dragged this new specimen across ro the right, let's paste in another copy 
of the original. This time we'll reselect him w ith the lasso instead of the rectangle, 
and then ask for the Invert command from the Edit menu. 111e result is a sleek 
black-coated species, as exhibited in the following illustration: 

Using a random assortment of all these techniques, we can arrive at the son of 
result shown in the following illustration: 
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We come to yet another MacPaint possibility that is based upon the concept of 
selection: stretching and sbrinking. Once again, let us erase the window and paste 
in a copy of the original rabbit. To change the dimensions of the selected image, 
you simply hold down the <X> (command) key while you cany out dragging 
operations. TI1e following illustration shows us, for example, a stretched version of 
the image: 

When you stretch or shrink an image in this manner, it is likely to become 
distonecl w ith respect to the original form. If you wish to avoid this distortion, hold 
down both the < Shift> key and the <X> (command) key as you carry out your 
dragging. 

l11ere is still another possib ility that involves selection using either the lasso 
or the rectangle: the Clear command. Uke Cut, it erases selected images, but it 
does not put the erased image omo the Clipboard. 

In the following illustration, we have selected the black rabbit, and the Clear 
command is about to be used to remove this somber animal from the MacPaint 
window: 
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Let us abandon our rabbits now, and turn to the splend id sample of "MacPainting" 
that is shown in the following illustration: 
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TI1e MacPaim window provides us, at any panicular moment, with lin le more than 
hal f of the total painting. To see a reduced version of the entire picture, either pull 
clown the Goodies menu and choose the Show Page command, or simply double
cl ick the hand-shaped icon that is located just below the lasso. The result is as 
follows: 

TI1ere's a dotted rectangle around the part o f the picture that is currently displayed 
in the MacPaint w indow. If you suddenly decide that you would like to erase the 
entire picture, all you have to do is to position the po inter just to rhe right of the 
image, and drag the picture away to the right. 

If, on the other hand, you wish to return to the normal MacPaint window, then 
cl ick the OK button. 

TI1e hand-shaped drawing tool that we have just mentioned is in fact a scroll 
device. I f w e click it, we can then drag different ponions of the entire painting into 
the w indow, as shown in the following illustration: 
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l11e final MacPaint feature that we are going to examine is referred to, in the 
Goodies menu, as Fa/Bits. (Only someone from Apple Computer cou ld have got 
away with such a curious term. 111e serious employees of a typical international 
corporation manufacturing business machines would have surely prefetTed an 
expression such as "enlargement faci lity" or "zoom" .) 

What we want to do is to put an earring on our lovely Oriental. Statt by using 
the dotted rectangle to select the zone that will receive the e-.m ing, as shO\vn in the 
following illustration: 
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Now pull down the Goodies menu (see following illusrrarion) and choose rhe 
FmBirs zoom faci lity. l11e same result could have been obtained by double-clicking 
rhe pencil icon. 

Brush Shope 
Brush Mirrors 
Introduction 

~ -----·---------

~ 
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The following illustration shows a blown-up point-by-po int version of the selected 
rectangle, with a normal-sized reproduction of the same zone in the upper left 
corner of the window: 

:-:-:::=========.= -=----=-~ -· ------ - --

Use the familiar pencil to click in the black and white points that 
elegant earring, as shown in the following illustration: 

r • File Edit Goodies Font FontSize Style 
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., 
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To get back to the normal window, either doub le-cl ick the pencil icon, or simply 
click the small rectangle in the upper left corner of the screen that comains a 
normal-size representation of the selected area. 

To obtain a hard copy of a MacPainr document, pull down the menu and 
choose the Print command. l11e result is shown in the following illustration: 

It's a lovely earring, and the graphics designer is attracted by the temptation of 
creating an equally-esthetic MacPaint necklace to decorate the bare bosom of the 
young lady. But let 's leave beauty aside, and get on with th e subject. . .. 

Let's imagine that you have a "Wri te/ Paim" d isk with the following directory: 
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r Iii File Edit Uiew Special 

The three icons in the lower r ight corner of the direcro•y window - labeled 
" l3u ilcling", 'Japanese" and "City" - represent documents created by MacPaint. 
:"Jmv, if we open \llacPaim and then pul l down the File menu, there's a Print 
Catalog command that enab les us to obtain a hard copy of the catalog of MacPaim 
documents, in a reduced form, as shown in the following illustration: 

MacPaint documents on di sk Write/Paint 

-
;:11' ·- ,.,. 
I . I . --· .. ~ '·-

!&.: 
1.. . •• J 

_....,. 
~ ••• 

Japanese Bui I ding City 

\Y/e arri,·e at the end of our presentation of MacPaint. Apan from such minor 
subject<> as the Brush Mirrors command in the Goodies menu (which enables you 
to produce symmetrical shapes), practically all that remains is to take a look at the 
Short Curs command in this same menu. as indicated in the follo,ving illustration: 
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It tells you (sec following illustration) how to cany out a dozen or so typical 
MacPaim operations in the most rapid fashion. 

IOptionii!::)Mulllple Copies 

loptionl Patterned Lines & Borders 

laptionl {I Scroll FatBils 

!!::] {I Enter or leave FetBits 

!!:::) ~ Change Font Size 

!!:::) !shift I ~ Change Font 

Double 
Cllel( 

., 

Select Window 
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For example, the key in the top left corner of the .\llacimosh keyboard offers a 
shot1cut that functions in the same manner as the Undo command in the Edit 
menu: it al lows you to rub out your most recent painting operation. ( If you usc 
this undo function a second time, it puts back \vhat ' vas just rubbed out. ) 

Write/ Paint relationships 

One of the most remarkable features of .\llacimosh - as we have po inted out 
several rimes already - is that there is no conceptual barrier berween rexr-based 
activities and image-based activities. 

l.c t us return ro MacWrite for an instant. to produce the following text: 

r • File Edit Se11rch Form11t Font Style 

~0 Untitled _: - - - - --

J .... J ... ~. ••• L ... &-•·f?. ... l ... •-L~o ... & .... .. J~.-~ ... .... J ...... .J... .... .l1 ... , ... ,_J_,,.,J ... a .J.~ .. .1...•-_! .. , ... J ... • • .!_~ .... ,,.,, ... l.. .. .. . & ... .a ••• l.. 

~~ ~§E) ~00~~ 
The purpose of this text, prepared 
by means of the macWrite word 
processing tool. is to inform you 
that the following image of a 
rabbit - created using the 
ffiacPaint graphic design tool -
was transferred to ffiacWrite via 
the Clipboard: 
Likewise, the following image of a 
fish was transferred to mac Write 
via the Scrapbook~ 

I 

., 

When we actually call upon the Clipboard and Scrapbook to insen rhe appropriate 
images, here is the result, p rimed out by MacWrite: 
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The purpose of t.his text.. prepared 
by means of t.he macWrit.e word 
processing tool. is to Inform you 
that the following Image of a 
rabbit. - creat.ed using t.he 
macPalnt graphic design tool -
was transferred to macWrite via 
the Clipboard: 

Likewise. the following Image of a 
fish was transferred to macWrit.e 
via the Scrapbook: 

Tn put a rvtacPaint picture into the Scrapbook, you have ro cut and paste it via the 
Clipboard. !Jkcwise, to insert a Scrapbook image into a MacWrite document, you 
have to copy and paste it via this same Clipboard. A5 pointed out already, eve!)' cut 
& paste operation on Macintosh involves this famous Clipboard. 
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Screen dumps and snapshots 

Since wc\·c brought up the subject of images insened into textual documents. 
maybe it 's rime to explain ro inquisiri,·e readers just how the various illustrations in 
this book were obtained. 

Naturally, we got them from \llacinrosh itself, using the lmagewrirer printer. 
But we used two quite different methods, and readers wi ll have no trouble in 
distinguishing between the two results. Most of the illustrations arc simple screen 
dumps, which arc ohwinecl by pressing, fi rst, the < Caps Lock> key, and then, 
simultaneously, the following three keys: <Shift>, <x> and the number 4. If you 
happen to be holding down the mouse button to obtain the display that you wish 
ro print out, then the screen dump will be printed as soon as you release the 
button. (One feels, at times. that Macintosh was designed ideally for people with at 
least three hands!) 

But cenain illustrarions have been obtained using the quite remarkable 
technique of so·callcd s11apsbots. l11e general idea is that it is possible at most 
rimes to store away. on disk. an image of the current screen display. To clo this. you 
merely press the follm,·ing three keys: <Shift> , <x> and the number 3. l11e 
contents o f the screen arc then stored as if rhcr were a !vlacPaint document. The 
first snapshot is labeled "Screen 0 .. (see foilowing illustrat ion. sho"·ing the 
"\Vrite/ Painr " d irectory), and you can store up to ten of them on the disk. Each of 
these snapshots can be .. touched up .. using classica l MacPainr f~tciliti es, making it 
possible to acid in textual exp lanations and all sorts of high lighting gadgets such as 
arrmvs and boxe:;. 

r 41 file Edit Uiew Special 
., 

l"loc'w'rlte MocPofnt Scrttn 0 

[][] 
Dossier 
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Once you've finished processing a snapshot with the MacPaint tool, and obtained a 
nice high-resolution hard copy, you can simply throw the disk-based snapshot 
document into the trash can, making room for further snapshots. 

There is no doubt about it that Macintosh, thanks to this snapshot technique, 
is the first personal computer that is capable, narcissistically, of handling its own 
image. 



chapter 7 

"MacDraw'' - Graph Processing 

There are many superficial similarities between MacPaint and MacDraw, but the 
two products function quite differently, and they are designed to cany out different 
types of tasks. 

Let us imagine an example. In MacPaint, suppose that you create a striped 
circle that is then partly hidden by an an overlapping white circle (see following 
illustration). ·n1e two circles are henceforth b lended into a single image, and there 
is no way of " removing" the white circle in order to rediscover the hidden part of 
the striped circle. 

macPaln\ 

mac Draw 

a single 
graphic 
object 

0 

153 

two 
autonomous 
graphic objects 
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ln MacDraw, on the contral)', there is a concept - graphic objects- that does 
not exist in MacPaint. This means that you can continue to consider the two circles 
as a pair of autonomous objects, even though they may be overlapping for the 
moment. You can request that the striped circle be placed on top of the white one, 
or you can simply move the two circles apan on the screen so that both of them 
are completely visible. 

1his idea of being able to refer specifically to autonomous elements of a 
drawing brings us closer to the manner in which most simple technical 
illustrations are created, and the expression "graph processing" - although it 
might not be entirely appropriate - has been reta ined ro designate this kind of 
image production. 

Sets of objects 

TI1e notion of MacDraw objects can best be demonstrated by means of a simple 
example. 

The following illustration shows us seven short te,.,:tual elements on an 
untitled MacDraw w indow: 

Fill Lines Pen 
, 

6602tamny 

Apple computers 

66oooramny 

Apple II 

macintosh 

Apple/// 
Lisa 2 

Since these textual elements can be manipulated separately, we can enclose them 
in all kinds of "boxes" (see following illustration), and we can move all these 
objects around on the MacDraw w indow as freely as we like. 
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Don't forget that, when we enclose a phrase in a box, botb the phrase and the 
box can continue to be tho ught of as autonomous graphic objects. In other words, 
we can easily break them apart if we so decide. 

,. a File Edit e Fill LIRII Pen 
., 

I Apple computers I 
( 6&ooo tomnv J 

·n1is set of objects can be reassembled quite differently in the MacDraw window, 
using conventional dragging techniques (see fo llowing illustration). Some objects 
- the ellipses- have been discarded, whereas others- all the lines and arrows 
- have been added. 

,. a File Edit Fill Lines Pen 
., 

Apple II Apple Ill macin\oeh Lisa 2 
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So much fo r this brief example, which was merely intended to provide a rough 
idea of the sort o f diagrams that might be executed by means of MacDraw. Let us 
now get around to actually using this software tool. 

Demonstration 

l11e directo1y of the "Draw" disk is shown in the following illustration: 

,. • File Edit Uiew Special 
., 

The icon named "MacDraw" is the program itself. "Modules", as usual, is a fo lder 
containing half a dozen elements of system software, and "Dossier" is an empty 
folder that we might use later on for fi ling away the drawings we create. 

As soon as we double-click the "MacDraw" icon, the screen appears as 
follows: 
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Notice that the main window is divided into a grid of rectangles, to help us in 
laying out graphic objects in an orderly fashion. You can pull down the Layout 
menu (see following illustration) and ask that Standard Rulers be placed along the 
top and left sides of the MacDraw window. 

,. • File Edit 
., 
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You can use the scroll bars to access a global surface that is e ight inches wide and 
ten inches high. The same menu offers a Hide Rulers command (see following 
illustration) to restore the screen to its original state. 

,. j File Edit Fill Lines Pen 
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The ten icons to the left o f the window designate functions similar to those we 
encountered in MacPaim. For example, an ellipse can pe obtained by clicking the 
hollow ellipse icon and dragging the pointer over the window, as shown in the 
following illustration: 

,. j File Edit Fill Lines Pen 
., 
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Notice that the ellipse is enclosed in a rectangular perimeter composed of eight 
b lack po ints. TI1ey are referred to as handles, because they enable us to manipulate 
the elliptical image in several ways. TI1ese handles are displayed on any newly
created graphic object, but they disappear as soon as anorher object is selected. At 
any particular moment, these handles reappear on only the most-recently selected 
object or objects. 

In the following illustration, a narrow vertical rectangle has been superposed 
over the le ft half of the ellipse: 

r * File Edit Lines Pen 
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We can paint this selected rectangle with any of the 36 "colors" offered by the Fill 
menu, as shown in the following illustration: 
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We clicked one o f the striped "colors". Here's the result: 

,. • File Edit Fill L111ea Pea 
, 

. . ........................................ 
: . : ~ : . . . . . . . . . 

. : ................ ... : .. .. .............. : ............ . . . . . . . . . 

• 0. 0 ••••••••• 0. 0. 0 . . . . . . . . . . . . . . . . 
.................................... . . . . . . . . . . 

In the Arrange menu, there's a command cal led Send to Back, as shown in the 
following illustration: 
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Flip Hor1zontal 
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., 

The selected object - the striped rectangle - is effectively sent to the back of the 
white ellipse, as shown in the following illustration: 

., 

······································· . . . . . . . . 

Notice, however, that the rectangle remains selected. Its middle pair of handles 
remain on top of the ellipse. 

Now we'll click inside the ellipse, to select it, and choose another "color" as 
shown in the following illustration: 
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., 

Here's the result: 

" • File Edit Type font fill Lines Pen 
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We can drag the rwo objects apart if we like (see fo llowing illustration). To do this, 
you simply position the pointer on the object and drag it. 

,. .. File Edit Fill 
, 

. . . 
• • 0 • • ••••• •• • 0 ••••••• • . . . . . . 
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In the Arrange menu (sec following illustration), you have Rotate and Flip 
commands similar to those that we saw in MacPainr. 

&roup 
Ungroup 

Lock 
Unlock 

, 
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Notice that we have painted the objects with different patterns. This "color" change 
could not have been carried out quite so easily in MacPaint. In MacPaint, if you 
place the pot of paint on a striped circle and attempt to paint it b lack, the program 
will paint only the space between the pair of stripes that are touched by the icon, 
because they form a closed boundary and MacPaint cannot "understand" that you 
want to paint the entire circle. 

The fo llowing illustration shows the result o f rotating the rectangle and 
placing it behind the ellipse: 

, 

• •••••••• • • -- •• - • • ~ • ••••••••••• ' •••••• ~ •• • •• - • • •• • •• • ••••• ~ ••• 0 • • 0 •• • •• 

. . . . . . . . . . . .. ....... . . . . . .. . . -. . . . . . . . . . . . . . . . . . ..................................... ... . . . . . . . . . . . . . . . . .... .... . i .... .. ... ! ... ...... j .... ..... ! .. .... .. . 
• • • 0 ••••••• • ••••• ~ ••••• • ••••••••• • ••• ; •• • ••••••• • ••••• • •• ~ ••••••••••• • ••••••• ~ •••• • ••••••••••••• 

11--t--hn--

All our examples are composed of simple figures that could be printed out (using 
the Print One or Print commands from the File menu) on a single sheet of paper. 
But the Drawing Size command of d1e layout menu makes it possible for a single 
MacDraw document to extend over dozens of adjacent sheets of paper. 

\Vhat in fact are the handles used for? As you might have guessed , you can 
drag them to enlarge or reduce the dimensions of the object. Here again, this 
enlargement or reduction is quite d ifferent to MacPaint·sty le stretching and 
shrinking. For example, if you stretch a figure with narrow stripes in MacPaint, the 
stripes change their appearance. In MacDraw, on the other hand, if you enlarge an 
object that is fill ed with narrow stripes, you end up with a bigger object that is 
filled with exactly the same narrow stripes. l11ese d ifferences are sho,vn in the 
following illustration: 
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ffiacPaint. 

-stretched figure 

mac Draw 

enlarged object 

Since there is no eraser device in MacDraw, unwanted elements of a drawing must 
first be selected and then removed by means of the Clear command in the Ed it 
menu. 

It's almost a pity - whatever that means! - that MacDraw will probably 
always be compared with its sophisticated younger cousin named MacPaim. 
(MacDraw is a direct descendant of LisaDraw, whereas a forerunner ro MacPaint 
did not exist in the good old Lisa days of several months ago.) The truth o f the 
matter is that both products are excellent tools for making pictures . . . even 
though it would be dishonest not to acknowledge the fact that MacPaint is a far 
more user-friendly tool than MacDraw. 

Rather than uying to choose betv.reen r..·tacPaint and MacDraw, the more 
intelligent approach is ro exploit both tools, together, along with l'v1acWrite. In that 
vein of thinking, let's conclude this all-roo-rapid overview of l'v1acDraw with an 
interesting demonstration of the procedures for cany ing our a Scrapbook 5wap 
between this product and MacWrite. 

Scrapbook swapping 
It has already been po inted out that disk-to-disk operations with Macintosh arc 
frankly weird, because the machine rakes complete control of the situation and 
stans ordering you to swap disks like a robot, without bothering to inform you 
what it's actually all about. It's clisconcening in a comical way, but not really 
annoying . ... 

As long as you cany out your cut & paste operations via the Clipboard, there's 
no problem whatsoever in changing from one disk ro another, because the 
Clipboard is a global desktop device that is nor attached to any specific disk. 

Things are more complicated if you want to use the Scrapbook created on one 
disk as a source of clara for a tool on a second disk. \XIhar we intend to do now, by 
way of an example, is to make a MacDraw figure and store it in rhe Scrapbook on 
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the disk named "Draw", then transfer this Scrapbook to the disk named 
"Write/ Paint", so that we can finally use MacWrite to produce a text that 
incorporates the image created by MacDraw. 

We have ro start our by a bit of fol'\vard thinking at the level of the target disk, 
''Write/ Pa int". In its "Modules" fo lder, this disk already contains an object called 
"Scrapbook File". Now, i f we attempt later on to transfer a second "Scrapbook File" 
onto this disk, there'll be a names confl ict .. . so we'd better do someth ing right 
away to avoid this problem. 

The "something" that we can do depends on whether or not there's anything 
w011h keeping in the current Scrapbook on the "\'\'rite/ Paint" disk. I f nor, then no 
.sweat: you simp ly drag "Scrapbook File" into the trash can, and you can be sure 
that this radical measure will eliminate any potential conflicts about names. On the 
other hand, if you have sentimental reasons for w ishing to retain the "Wri te/ Paint" 
Scrapbook, then you should ar least change its name. "O ld Scrapbook" is as good a 
choice as any, as indicated in the following illustration: 

(!g) 
Findtr 

Let's get back now to MacDraw. Napoleon himsel f would have found it a splendid 
tool for drawing triumphal arches, because it's easy to respect symmetry. 

Once our arch is completed (see following illustration), we use the Select All 
command from the Edit menu to select the entire set of components in the 
drawing. 
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RI.'Shdpe 
smooth 
unsmooth 
Round £ oroPrs ... 

Pen 

......... : .. ~ ........... : ....... fl· ............ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
....... .. : ......... :.... . ............ : ...... ... : ......... :... . ... : ..... ............. : .. 

., 

Al l the handles re-appear on the screen, as shown in the following illustration: 

,. 4i File Edit FIll Lines Pen 
., 

II ; 

. . .. ... .... .... ... ....................................................................................... . . . . . . . . . . . . . . . 
. . . . .. : . . . . . 

··· · :· ··· ·~·· ···:···· :· · ··:·~ · :····· · · · : · 

........ : ............ ~ .. ....... .. .:.. ... ~ .. ~ ......... : .. W4J ... : .................. : .. 
. . 
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Next, we pull down the Edit menu and use the Copy command to put the arch 
omo the Clipboard, then we open the Scrapbook and use the Paste command to 
put a copy of the arch onto the first and only page. 

Don't be worried if you find that the triumphal arch appears to have been 
amputated a bit, both at the top and bottom (see following illustration) . TI1at's 
merely what you might call an "optical illusion", clue to the fact that the Scrapbook 
window is re latively small ; rest assured that the entire arch is present on page 1 of 
the Scrapbook 

r j File Edit Fill Lines Pen 
., 

1¢1 
I o1 of 01 I 

Now, the information that goes into the Scrapbook is in fact retained in a disk file 
in the "Modules" folder called "Scrapbook File", as shown in the following 
illustration: 

IEl Modules 
8it..s 2171C ill feWff !IOI:n~ ..... 

~ ~ [!g) ~ D 
~ 

SYSTEM FINl£R fo1AGE'YRITER PrTtttr PrTtt Filt 

0 D D 
Cf1>bo<rdFilo Nolo Po<lfilt ~FiiP 

lQ 
IQl IQ IQJ 
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(Notice that the person who developed this product has preferred not to use the 
Macintosh-shaped icon for the Clipboard, Note Pad and Scrapbook files. 1l1is 
decision is regrettable in the sense that th e icon representing a sheet of paper is 
already used for documents created by l'vlacWrite.) 

We want to transfer "Scrapbook File" to the "Write/ Paint" disk So, the fi rst thing 
to do is to drag it over to one side of the desktop, as shown below: 

,. lit File Edit Ulew Spetllll 
., 

D D 
C~d Flit Not• Pod Flit 

Now we can close d1e "Modules" and "Draw" windows by clicking their close 
boxes, and eject the "Draw" d isk as indicated in the following illustration: 

Edit 

Put Bact 

Close 
( lose fill 

., 
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It may happen - depending upon the exact manner in which you terminate your 
use of the "Draw' d isk - that you fall upon a dialog box (see fo llowing 
illustration) with an Eject button. Whichever way you terminate, the important 
thing is to get the "Draw" disk out of the machine, to make way for the 
"Write/ Paint" disk. 

~( Open 1 I Draw 

I 
I 

) I Cancel 
10 

Once the "Draw" disk is ejected, put the "Write/ Paint" disk in the drive. If you 
open the "Modules" folder (see following illustration), you can see that the file 
called "Old Scrapbook" is still there, but what we want to do now is to get 
MacWrite to use the Scrapbook borrowed from the other disk. 
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, 

11 0 
Dosrter 

(!2) ~ l9 
Findtr C~d Filt Not• Pod Filt Old Sor-~ hlogtwrit.r 

Drag the "Scrapbook File" icon onto the "Write/ Paint" directory window (see 
following illustration). l11is triggers off a series of swapping operatio ns involving 
the "Draw" and "Write/Paint" d isks, and the final result is that the latter d isk 
houses, at last, the "Draw" Scrapbook. 

., 

MocPoint 

o D 
Dossifr Scropboclc fio 

l.Jse MacWrite to create a document such as we see in the following illustration: 
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1ffim ~D ~ I!JJJ tlllim 
![Qlffi(s~(l§ I!Wlffil ~ ficooJl}D 

~ Wtrn1 rub§n Olli§ ftmllll~gJ 
~Mim1 ~ ~U!OOl ~ b 
~ ~~ llimll!D 
[ffi(!l ~ nm b ~n 
~mb~ 

Next, open the Scrapbook in the usual manner, by pulling down the menu 
associated with the apple icon, as shown in the following illustration: 

r w File Edit Sean h rnrmnt ront ~ tyle 
, 

From Draw to Write 
~1-J ..•.. .L. J . .•. ,r~. Ill ,:~ 11 t5 tO 

Scrapbook -
~lil 

ern -roD -
l'n 
!Ill 

~ m 
roo 

~ ~ 
ljJj 

IQI 191 
I• or I I PK:T -
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Once you use the Copy command, the arch is transferred onro the Clipboard. Then 
you can use the Paste command to insert the picture into the MacWrite document 
we just prepared. TI1e result, when primed, is as follows: 

'* ... ~ ~ tUilCEJ 
Wn 'tfA _. ,.,.,...,.,, W. 

w. ... IMlQ ·~ 
~-~~· rz • 22 ~ fi&llitiWtJ w. 
... • 2 , .. II .. jit'ifilfil ........ ..,.,..,. 

Maybe that's as good a point as any to leave the subject of these graphics-oriented 
Macintosh products, and to get back to the sort of thing that we normally associate 
with computers: namely, calculating. ... 



chapter 8 

"Multiplan" 
Electronic Worksheet 

The Microsoft Multiplan tool enables you to develop worksheets on the Macintosh. 
What exactly is a worksheet? Basically it's a rectangular grid of rows and 

columns that form cells. Inside the various cells vou can record elements of 
information. Quite often, the element of information. in a particular cell is in fact a 
.formula explaining how the value of that cell must be calculated using the values 
in other cells. 

Eve!)' time you change the data inside a single cell, Multiplan recalculates the 
value of eve1y other cell on the worksheet. 

Using Multiplan, you can carry out such tasks as budgeting, investment 
planning, sales forecasting, etc. In fact you can create a Multiplan model of any 
real-life situation that can be represented quantitatively by a rectangular grid of 
rows and columns. The horizontal axis of the grid frequently represents time, and 
the vertical axis then indicates the magnitude of some particular event (e.g., sales 
volumes) at specific moments in time. But Multiplan models could be created for 
countless different types of happenings. TI1ere's even a famous jazz musician who 
uses the electronic worksheet technique to schedule his future concerts. 

Manipulating the worksheet 
TI1e directo1y of the "Multiplan Master" disk is shown in the following illustration: 

174 
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r e5 File Edit Uiew Special 

The icon named "Multiplan" is the program itself. "Modules", as usual, is a folder 
holding six elements of system software, and "Dossier" is an empty fo lder that we 
might use later on for filing away the worksheet that we are about to create. 

As soon as we open "Multip lan" , the screen appears as follows: 

r e5 File Edit Select Format Options Calculate 
, 

··············· ··· ··················· ... · ·· ·· ··· ·· ···· .. .. ................ .. ..... .............. ............ . . 
-- ··········· ·· ···· · ·· · ·· · ········· · ........................... ....... . ·· ·············· ·· ·· ·· ····· ··· ······ · 

..... ......... .... ..... ... .. ... .... ..... ·· ··- · ·· ..... ... ... .. . .. ..... ......... ....... .. .. ......... . 

.. .. ... ....... .. ........ ... ..... . ....... ........... .... ... .. ... ... .. ....... .. .. .............. .. ...... . . 
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NOtice, first of all , that there are six names in the menu bar. We'll look at the 
menus themselves later on. 

Most of the screen is taken up by the worksheet window, labeled "Untitled". 
In fact, the six columns and fowteen rows that you see at present are merely the 
upper left corner of the worksheet, which can contain up to 255 rows and 63 
columns. The scro ll bars are used in a conventional manner to move to any part of 
the entire worksheet. 

The b lack cell w ith the narrow white border is the current cell At any 
particular moment, when creating or running a Multiplan model, the current cell is 
the one in which the user is currently working. In fact, this nOtion of a current cell 
is quite similar ro the Macintosh concept of selection that we have encountered 
many times already. As you might have expected, selection of a new currem cell is 
carried out simply by moving rhe pointer to the cell in question and clicking the 
mouse button. 

Between the menu bar and the title bar of the main window, there's a SO· 

called f ormula bar. To the left of this formula bar, the cell register displays at all 
t imes the coordinates of the current cell: here Rl Cl, for row 1 and column 1. 

l11e main zone of the formula bar - w ith a blinking vertical bar to indicate 
the insettion point - is where you actually describe the manner in which the 
value of the currenr cell is to be derived. To enter information into this formula 
bar, you first have to click it, and then you can use the keyboard to specify the 
formula or the value for the current cell. For example, ler's suppose that we enter 
the word "Paris" into the first cell on the worksheet. l11e fo llowing illustration 
indicates the appearance of the screen just before the < Return> key is hit: 

" • Fi le Edit Se lect Format Options Calculate 

. . ..... ..... ........................................................... .... ....... ................... ......... . . . . 
... ...... .. ..... .. : .......... .. .......................... .. .. .......... .. : .. .. ......... ..... .... .. ........ .. . . . ················ ········· ············ .................. ··················· ···· ···· ·········· .... ........ . ... . . . . . 
········· ·· ··········· ··········· ·· ·· ........................ ................................ .... ........... . . . . . .. ... .......... ... : ... .. .... ... .. ................... .. ................. .. : .. ..... ........... .... .. .. ... .... .. . . . . . . ·· ··· ··· ···· ·· ·· ·········· ····· ······ ......... ... ... ... ······ ············· ·· ··· ············· ... ...... ........ . . . . . . . .......... .. .. .... ................ ...... .................. .... ......... ... ..... .. ........... .. ....... .. .. .. .. . . . . .... .. .. ... ...... .................. ........ ................... ............................. ....... ............. . . . . . . ............... .. ..... ............... ........................ ................................................ . . . . 
.................... ....... ....... ... .... ........ ..... ....... .. ....................................... ....... . . . . . . .. .. .. .. ..... ... ... ........... ..... .. ..... ...... ........ .... .. ... .. .............. .... .. .... .................. . . . . . . .............................................. .... .... .................................................. ...... . . . . . ~- ~~= 
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Between the cell register and the word we have just typed, a so-called cancel icon 
has appeared, ind icating that the contents of the current cell are to be canceled 
and replaced by what \ve are typing. 

Norice that the word being typed in the fonnula bar appears simultaneously in 
the highlighted current ceiL 

As soon as we hit < Rerum>, the screen appears as fo llows: 

r IIi File Edit Select Formot Options Colculote 

- - -··············· ·· ·· ···· ·· ·· ············· ···· ····· ······················· ·········•······· ··· . . . . 
0 • • • . . . ···· ····· ············································· ···· ············· . . . . . . . . . . ·············· ············· ··· ····················-··•··· ························ ·················· ··· ··········· . . . . . . . . . . . . . . . ............ .. ................................................. .. .. ... ... .................... .. .. .. ... ....... . . . . . . . . . ................ . : .................. : ............ ...... : ....... ........... : ....... .. ...... ... : .... .... ... ...... . :: 

: : : : ................. : ......... ... ...... : ............. ..... : ....... ........ ... : ................ . : ........ ... ..... . . . . . . . . . . . 
..... ....... .... . : ......... .. . ... . .. : .... ..... .... .. .. . : .. ..... ... . ....... : .................. : ........ ........ . . . . . . . . . . ........... ...... : ......... ......... : ................. : ... .. ............ : ............. ..... : ........ ........ . . . . . . . . . 
................ . : ......... .. ... .. .. : ....... .... ....... ................. .. : ............. .... : ........ ... ..... . 

: : : : ................. : ... ... .... ....... . : . .. .. ....... . .. . .. : ....... . ....... : ............. ... .. : .......... .. ...... . 
: : : : : ................. : ...... .. .......... ; .. .. . ... .. .. .. .. .. : .. .. .......... .... : ... ...... ......... : .. ... . . ...... . .. . 
• 0 • • 

: : . . . .. . ... .......................... 

Cell R1C1 has now received the value ''Paris", and the next cell has been selected. 
If we want to select a d ifferent cell , say R11 C5, we move the pointer there (sec 

fo llowing illustration) and click it. Notice that the pointer, as soon as you move it 
onto the worksheet window, takes the form of a cross. 



178 "MULTIPL\N" - ELEcrnONIC WORKSHEET 

r 45 File Edit Select Format Options Calculate 
, 
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....... . ....... ::: ::::::::::::::·:::::·:::: ::::::::::: :::::::::·:::: :: :~: :: ::: : ·: ::: .::::·::··::::·: . . . . . 
.. ..... ... : .. . . .... .. ...... : ......................... . . . . . 

As far as po inters are concerned, Multiplan is a star performer, with no less than 
five different models, depending on the part of the screen where the po inter is 
located. In the menu bar and menus it's a conventional arrow; in the formula bar, 
an l·beam; in the worksheet window, a cross; in the scroll bars, a little hand with a 
pointing Anger; and there's even a Celtic cross for the title bars of windows. 

Calculations 
Let us examine the simplest calculation imaginable: the addit!on of two numbers. 

In the fo llowing illustration, cells R3C2 and Rl lC3 have received respectively 
the values 9 and 7, and ce ll R8C5 is selected: 
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r a File Edit Select Format Options Caltulate 

. . . . .. .. .. .. .. ... . .. . .... .... ... ...... .. ... . ... . .... ... .. ..... .... .... ... . ···· ······ ·· ·· · · ·· · ·· ·· ··· · ··· . . . . 
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. . 
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. ...... ..... ... ... .... .... .... .. .. .. ..... ···· ··· ······ · ·· ·· · ···· ··· · · ···· ·· . . . . . . . . .......... .... ............ ... ... ........ . ······· ············· . . . . 7 

.... .. .... .... ..... ·· ···· ········ 

\XI11at "''e would like to do is to write a formula instructing Multiplan to put the 
result 9 + 7 in the current cell. 

\'1/e stan out by typing an equals sign, which informs the machine that we are 
about to enter a formula. Now. to let Macintosh know that the first term to be 
summed is the value in cell R3C2, we actually move the pointer to this cell and 
click it. At that point, the screen appe-ars as follows: 

r a File Edit Se lett Format Options C11ltul11te 

. . S} . 9 : 

. . .. ...... .. ... .. ........... . . 
.. .. .. . .. ... . .... ··· ··· · · ·· ·· ·· ··· · ··· . . ::::::::·::: ::::::::::IJEtiiiJII :::::: ::::: :.:: . . . . 
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Instead of calling this cell R3C2. Multiplan refers to it as R[- S]C[- 2]. l11is is the 
re/atioe address of cell R3C2 with respect to the current cell , R8C5. l11e numbers in 
square brackets indicate how many rows and columns there are between the 
current cell and the cell we just clicked. The pair of negative numbers indicate that 
the cl icked cell is 5 rows up from the current cell, and 3 columns to the left of it. 

Next, we type a + sign on the keyboard, and we select the second term of the 
addition, cell R11 C3, by moving the pointer there and clicking it. The relative 
address of this second cell is R[+3]C[- 2]. That's to say, it's 3 rows down from the 
current cell , and 2 columns to the left of it. 

l11e following illustration shows the final formula: 

r • File Edit Se lect Form11t Options C11lcul11te 
., 
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A"> soon as we hit < Return> , to indicate that the formula is complete, cell R8C5 
receives the result 16, as shmvn in the follo,ving illustration: 
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r • file Edi t Select Format Options Calculate 
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We could have obtained this same result in another manner. Let's return to the 
point where we selected cell R8C5 and typed an equals sign to indicate that we're 
about to enter a formula. This time we' ll create rhe formula itself in a slightly 
different fashion. 

If you pull down rhe Edit menu (see following illustration), there's an 
interesting command called Paste Function that allows you to browse through a 
list of over forty Multiplan junctions. 

Select Format Options Ca lculate 

Undo Typing 
Cut 
copy 
Paste 
U!'llf 

Show Clipboard 
l' 1~s1e <m<l Link ... 
!Jnlinl< ... 

!'ill flight 
OJI UOUIJI 

Sort .. , 

:•:FI 
:•:U 
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A dialog box (see following illusrrarion) includes a mini-windo\\· - called a list 
box- with the names of nine functions in the list. You can use the vertical scrol l 
bar to move through the entire list. 

r • File ll!JII Select Format Options Calculate 

II RBCS 1®1 = 

Untitled 

I t I 2 I 3 J .. J 5 l 6 

tr.=' ::;J.::· ··=···=··· ·==~··=···=·· ·;···=····=···~===···=····~· ···· ········ · ····" 
RBS() 
AND() 
HTAN() 
AUERAGE() 
COLUMN() 
coso 
COUNT() 
DELTA() 
OOLLHH() 

... ......... ........ .. ................. .. ..... . . . . . . ... ....... ········-· ······ . ··················· . . . . . . .. ... .. .. . .. ....... ................. 
OK . . .. .............. .. ... . .. ...... .. .. ··· ··· -···· ··· . . . . 

Cancel 
............ . ...................... ... ........... . . . . 

~' :::::::::: :: ::: ::: :::·:::: :::::::::: ::: ::: ::·:::::: 
~=r====="===~====!J .... ..... .... : ................ : ....... .... .. .. .. . hl1 .............. .. .. : .................. : ... .............. : .................. : ........... ....... : ................ . 

Let's scroll through to the SUivi function (see following illustration). Having 
selected this function by cl icking it, we only have to cl ick the OK button in order 
to get the function pasted into our future formula. 

ROUND() 
ROW() 
SIGN() 
SIN() 
SORT() 
STOEU() 

Select Format Options Calculate 

Paste Function 

Cancel 

. . . . ...... ... ....... .... ................... .... .. .... ... .... ... ........ .......... . .. ..... .. ......... ...... . .. . . . . . . 
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TI1e function, as it appears in the formula (see following illustration), has no 
argument. SUM is a function whose argument is a list o f elements separated by 
commas, and - as you might expect - the purpose of this function is to add 
together all the elements in the list. In our example, we have only two elements to 
be summed, so it's now up to us to select these two cells . 

...... ...... .. ........... ... . 9 .. : ......... .. .... ............. ................... .............. ...... . . ' 

..... .... .. .. ....... ......... ...... ........ . . ... .. ..... . . . 
. . ..... . ..... .... ······ ······ ······· ...... ... .. ... .. ... .............. .. . . . . . 

.................. ................... .. · · · ··- · ···· ··-· ·· · ··· · ··· · ···· ·· . . . 
......... : ........... ...... : .......... ....... : ... .......... .. . . . . . . . . . . ............... ......... .. .............. .. ............ ..... .. .... . . . . . . . . . ~ .............. " .. I .................. ~ ...... .. I • ••• • ••• • ~ . ....... . ...... .. . j . . . . . . . . . . . . . . . . . . ! ~ 
·· ······=·· ··· ··" ' " ''' '' :-- -·· ...... . .. .. . ... .... .. ....... : .. .. .... .......... ; .... .. . . ... ....... ; : 

. : 7 : . . 
..... ........ .. .. .............. .. .. .. . .. . .. .. .... . ... ...... ...... .. .... . .. . . . . . .. . .. . ..... 

. . ... .. ....... .. .. .. .. ... ..... .. . .... ....... ...... .. .... ... . , . .. . ........... .. . ..... .. .. .... . .. . .. .. .. . . . . 

We do this in the same \V<lY as before. First we move the pointer to cell R3C2 and 
click it. Its relative address appears in rhe formula bar as RI- 5]C[-3]. We then 
type in a comma, to separ"<He the t\vo elements in the list. :'-lext we move the 
pointer to cell R11 C3 and cl ick it. Its relati\·e address is inserted in the formula as 
R[ +3]C[- 2]. TI1en, ro indicate that rhe formula is complete, we hit < Return>. 
TI1e Anal result is shown in the following illustration: 
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r e5 File Edit Select Format Options Calculate 

. . . . ... ... .... .... .... ······· ·· ···· ··9··:··· ···············:······ ···· ·······: .................. ;···"············· 
... .... .. ... .. .. . . ······· ·····-····· :···-······· ·······:·· ··· ······ ·······:······ ··· ··· ···· ··:·· ············· ·· · 
····· ····· ········ .......... ........ : ... ........ ....... : .. ... ............. : ........ .... ...... : ............. .... . 

: : : : . . . . .... ....... .... ... ············ ·· ·· ················ ····· ·· ········· ···························· ····· ·· ···· ······ . . . . . . . . 
.................. ·· ··············· ·:··· ············ ···:·· ················:--- ········ ··· ·· ··:· ··········· ····· · . . . 
....... .... .... ... ....... ...... ..... : .... .. ... .. .... ... : .. ..... .... .... ... ~· · ·· ·· · ··· • · · · ·· · · 

......... ..... ... . ············· ·····:·········· ..... ... :·· ···············< >······ ·· ······· ·· . . 

.. .. .. . ...... .. .. ········ ·· ··· ··· ·· ;" ' '''' '' '"'" ''':·· ............. .. : .... .... ... ... .... ; .. .. .... .... .. ... . 

... ......... .. .... ...... ... ........ . ; .. . .. ... ... ... .... ; ... . .... .. ... . . .. . ; ... .. ........ .. ... ; ................. . 
0 0 0 0 0 0 0 0 0 0 ° ' ' ' < ' 0 0 '0 ' 0 ' o o o o o T oo o o o o o ~ o o o o o o o o o o o o o 0 ,? 0 0 : 0 O , O 0 0 0 O O 0 0 O O 0 O O O O: O O 0 O 0 O O O O O O 0 O O O O 0 0 ~ 0 O 0 O 0 0 0 0 0 0 O 0 0 0 0 O 0 0 O: 

. . 
... .. . .. . ... .. .. . ···· ·· ······· ·· ·· ·: ·· ······· ·· ·······:······ ············: ···· ··· ···········:····· ········ ·· ···: 

• •• •• • • • •• ••• •••• • •• • •• • • •• • •• • • • • : •• • •• ••• •• • •••• • • • : •• • • • • ••• •• • • • • •• • : • • •• ••••••••• •• • • • : ••••• ••• •• ••• • • ••• f• . . . . . . . . . 

In this ve l)' e lementary example, the formula using the SUM function is almost 
identical to the previo us formula. But Multiplan functions can be most handy in 
more complicated situations. 

Here is a list of most of the functions available: 

Matbematic .functions 

ABS(number) 

AVERAGE( list) 

COUNT(list) 

EXP(number) 

!NT( number) 

L.N(number) 

I.DG10(number) 

MAX( list) 

MJN(l ist) 

MOD(number to divide, 
number to divide by) 

NPV(rate, list) 

Absolute value of a number 

Average of the values in the list 

Counts the number of items in the list 

Exponentiation 

Integer portion o f a number 

Logarithm, natural 

Logarithm, base 10 

Maximum value in list 

Minimum value in list 

Remainder after division 

Net present value o f list at rate 



CALCUlATIONS 

ROUND(number, 
number of digits) 

SIGN( number) 

SQRT(number) 

SIDEV(list) 

SUM (list) 

Trigonometric junctions 

ATAN(number) 

COS( number) 

SIN(number) 

TAN(number) 

Logical functions 

IF( logical-expression, 
value-if-true, 
value-if-false) 

AND( list) 

NOT(logical-expression) 

OR(lisr) 

TRUE() 

FAL5E() 

Text functions 

OOUAR(number) 

F!XED(number, decimals) 

LEN(text) 

MID(text, start-position , 
number -of-characters) 

REPT(rex't) 
number-of-rimes) 

VALUE( text) 

Rounds a number to number of digits 

Sign of a number 

(1 positive, - 1 negacive) 

Square rom 

Standard deviation 

Sum of numbers in list 

Arctan gem 

Cosine 

Sine 

Tangent 

185 

Chooses which value ro give depending 
on the logical values o f an expression 

True if all values in list are true 

True if false, False if true 

True if any value in list is true 

Tnte (logical value) 

False (logical value) 

Dollar representation of a number 

Fixed format of a number 

Length of text 

Extracts characters from a text value 

Repeats text number of rimes 

Changes rex1 value ro number 
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Otber functions 

COLtJrviN() 

ROW() 

INDEX(area, subscripts) 

LOOKUP(number, table) 

"MULTIPLAN" - ELECTRONIC WORKSHEET 

Column number 

Row number 

Gets a value from are-J located 
by subscripts 

Looks up a value in a table 

To use one of these functions in a fotmula, either you t)11e the function name on 
the keyboard, or you use rhe Paste Function faci liLy in the Edit menu. 

Demonstration 

Let us now work through a complete example in Macintosh Multiplan, for that's the 
best way of seeing how this tool functions. 

Imagine the case of a freelance programmer who has just created an 
entertainment product that is going to be marketed by a software company, and 
suppose that rhe programmer has decided to use a Multiplan model to figure our 
how much money she's likely ro earn in rhe way of royalt ies. l11e company 
calculates royalties in the following manner: 10% of the sales price for rhe first 
thousand copies sold , 15% for the following t\¥0 thousand copies, and 20% on all 
sales beyond these fi rst three thousand copies. ·n1e sales price has not been fLxed 
yet, and so the Multiplan model should allow us ro propose various d ifferent 
values, so as to sec rhe incidence of the sales price upon the royalties. 111e model 
-which deals w ith sales over a 1:\velve-month period - is designed in such a way 
that we can propose the volume of sales for the first quarter, and then suppose that 
sales vary each quaner by such-and-such a fixed percentage (which may be either 
positive or negative). 

Let's suppose that the heroine of our case study has devoted the necess.:uy 
time and energy (about twenty minutes' work) to the construction of a Multiplan 
moclel called "Royalties", that is novv stored mvay safely on the disk, as shown in 
the following il lustration: 
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~ • file Edit Uiew Speciol 
., 

~I 
Multiplan Ra<jolli•• 

~ 

0 
Doss~r 

Double-cl ick the "Royalties" icon to open the document. TI1e main pan of the 
worksheet then appears on rhc screen, as shown in the following illusrration: 

r W file Edit Select Formot Options Colculote 
., 

. : RO YALTI ES . . ...... .......................................... .... .. .. .... .. .. ........ ... ....... .... ....... ...... . . . . ========= . . - . ....................... ................. ... . .... .... ..... .... ... .... .... ... ...... . .. . ..... .. .... .. . . . . . . -. . . . ..... . .. . .... .............. ........... ... . ... . ....... ............................................. ..... .... 
_a_l_e_s_ ll r. tc_e:: .. _ $_~_q_._o_o ........... ~~a.rt.~_rlx . xo.~.i.a_t '-on. : : ..... o.-. ~o ....... '·· -· ·· ........... . 

' . . . 
.. ..... : ......... . ... .. .. : ..... .. .. ... .. .... : .................. : .................. : .......... ... ... .. 

. . .. . . . . . . . . . . . . ; ... ....... ........ : ... _J_a~ ~.M.a.r .. : .. :<\P. r.~.J-~~ ... : _. ~ u_I ~.s.e P. .. .. : .. ~~! ~~-~-~ ... . 
. . 

.. . . ...... . ...... : ........... . ..... : . ... ........... .. . : ......... .. ....... : .. 

. . .. .. .. . . . .. - ~IJO.I).ti~y __ s_O I d: .: ..... _8~~ .. .... ; .... _8_0~ .. .. .. . : ... __ 8_0~ .... ... : .. . . __ 8~~ .. ... .. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ' ' . . . . ' . . . . . . . . . . . . . . 
..... . :<\ .c~u.n1_ul.~ .t.e~ . sa_l.~_s: .: .. .. _8_0~ .. .. .. ... .. . 1 _6~0 .. .. ... .... _2_4 ~0 ... ... ... .. . 3~~0 .. ... . . 
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l11is section of the worksheet -which might be thought of as the visible part of 
the iceberg - is quite easy to understand. The programmer has imagined the case 
in which her product would be selling for $40, at a regular rate of 800 copies per 
trimester. (A quanerly variation of zero means that sales figures remain stationary 
all through the year.) During the first quarter, she sells less than a thousand copies, 
and so her royalties remain in the 10% bracket. In the second quarter, she breaks 
into the 15% bracket for 600 copies, and she remains at this rate of royalties for all 
sales in the third quaner. Finally, for 200 of the copies sold in the fourth quarter, 
she moves into the 20% bracket. 

Worksheets are useful, above all, for answering questions of the "What If ... ?" 
variety. For example, our programmer might like to ask the following question: 
\Xlhat would the royalties amount to if the product were to be sold for $50 instead 
of $40, if sales for the first trimester were 750, and if there was a 2% increase in 
sales every trimester? 

111e answer is provided in the following illustration: 

,. 4i File Edit Select Format Options Calculate 
., 

0 0 0 0 e.~. pr,1c.~.=: 0 0 0 $,5.0 .'. o.o. 0 0 0 0 0 0 0 0 00 0 ~~~.r .t.~.~~.~ 0 xa.r.1.~~.1~~ ; : 0 0 0 0 .?:. qo, 0 0 0 0 0 0 :0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 00 . . . ' . . . . . . 

. ::::: :: ::::::: :::::::::: :: :::::: :: :: :::: )~~~:~~~: ::: : ~P.~~j:~~ ::: :: )~:~:~:~~P. : ::: :: jj~~~~e~:: : : I :: 
. . . . . . . . . . . ·· ···· ··.······ ·· ····· ·· ·· ········ ···· :·· ··· ··· ··· ···· ···:· ······ ··· ·· ··· ···:· ·· ·· ······· ····· ·:·· ·· ··· · ······· ··· . 

... . .. .. . ... . . ~~o.~.u.~r .. ~.q) .d= .: .. .... ?.sq .. .. ... : .... . .?.~~ ...... . :oo ... .?.~q· ··· · · .: ... .. 7.9~ ... .. .. , . . . . . 
• 0 

::::: h:~~~~n:~;:a~:e~ : ;,~:~:e:~: : :::::: :?:s~:: :: :: :l::: :: i :s ;: s.:::: :::: ::: :2~~s: :::: :: : : ::: :J:o~ i ::::::: ; • . . . . . . . . . . . . . . . ........ . .. .. .. .. ..... .... ..... .. ... .. .. . .. .... ..... .. . ..... ... .. ... ..... . .. .. ... .. . . ... . .... .... .. .. . ....... ... 

n:t.l!! .~~.~~ .r:.oy~!!.1.~~: .: .. oo~.n~~ ... ... : ... Ja.~~~ .... oo : ... ~. 1 .~7!.~ ..... : ... ~.2.q~!.? ..... . . . . . . . . . . . . . . . 

Now, Multiplan appears to be a vety simple roo! to use when you look at 1t 
from a superficial level, as an obse1ver. But we must examine the actual 
"mechanisms" behind these results, for they are not necessarily child 's play. 

To discover d1is hidden pan of the iceberg, let's scroll down the worksheet 
some eight rows, as shown in the following illustration: 
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~ • File Edit Select Formot Options Colculote 
., 

•••••••••••••••••• : ••••••••••• •. •• .• • : ••••• ••• • ••.•••••• :··················: •••••••••••• •••••••••••••••.••• •• •• . :! . 

. . . . . . ~s~~.~.~).~!.e~ . ~.~.1.~.~ : .: ...... ?.5~ ...... . : .. ... ! .~.1. 5 ....... ~ .... . ?.~~~ ....... .... . J.q~! .. ..... i: 
. . . . ............ ...... : .. ................ : .. .. ... ... ..... ... : ..................................... .................. :: 

~.<:~~.~.~ ) .a!.~~ .~.o.~~ l .t.t.~~: . ~ .. . _$,3_7~0 .. .. .. : .... ~.8.8~3 .. .... : ... ~. ! .~ ~ ' .~ ........ EO~ 1.2 .... . . . . . . . 
10/. rate must be applied TRUE : FALSE . FALSE FALSE 

:~: # i.~i~ : ~~:~:~~: :~~ : ~~P.i :~:~~ :::: f.~~~( :: T: ::Jii~E::: ::::::: :: :r:li~E:::::: ::: :r ~:L~E::::: .· 
~ox .. r.~ t~ . ~.':'~! .. ~~ .o.~P.! .~.~~ .. .. F.~.~~E ..... : .... F. ~.L~~ ..... : .... F.~.~~~ ......... ..r.~~~ ...... • ! 

. . . . . . . . .............................. ... ........ ...................... ................................................. 
:Total I O'l. : 3750 . 5000 . 5000 5000 .................................................... .. ......................................................... 

ftrst total 15'l. : 0 : 3863 : 97 15 0 .. · · .. · · s~·~·~~d' ·i~iai · i·s·'l.· .. ·~ ... · · · · ·o .. · · .. · · · ~ · · · .. · · o· · · ..... · ~ · .. · ... ·o· · ... · · · · · · .. i.s.ooii · .. · · 
..... ............................................... ......... .... .. ...................... ...................... 

20'1. : 0 : : 9 12 

l11e seven lines in the lower half of the screen reveal what is happening, behind 
the scenes, each time you tun this Multiplan model. 

For each trimester, there are three logical flags that indicate - by means of 
the values TRL!E and FAlSE - which of the rates must be applied in the 
calculation of royalties. One of these flags must always be TRUE, to indicate the 
end-of-trimester royalties rate, and the other two flags must be FALSE. We shal l 
shonly see how these flags actually function. 

l11e four lines at the bottom of the screen indicate the accumulated royalti es 
in each rate bracket. Notice that the royalties at 15% are broken clown into rwo 
pans: the first total is updated so long as the encl-of·trimester rate is still 15%, 
whereas the second total is used as soon as the 20% bracket has been attained. 
(This minor technical problem will become clearer in a moment or rwo, when you 
see the actual formulas for these various cells.) 

Let's stan at the beginning. There are three or four different kinds of cells on 
this worksheet. First o f all, it's interesting to realize that this "Royalties'' model uses 
only 59 of the 16065 cells available on the worksheet: that is, less than balf a 
p ercent of the global capacity of the worksheet. In other words, most of the cells 
remain empty. 

If we look at the 59 cells that do in fact contain something, this "something" is 
of three kinds: legends, such as "Sales price: " in cell R5Cl ; numbers, such as the 
sales price of fifty dollars in cell R5C2; or f ormulas. 
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As far as legends are concerned, we should poim out that they only occupy 
the cell in which they start, even though they give the impression of flowing 
beyond the cell boundary omo the neighboring cell. For example, the legend 
"Accumulated royalties:" occupies only the cell R13Cl , and the neighboring cell 
R13C2 remains unused and therefore completely empty. In orher words, the cells 
themselves must be thought of as mini·windows that can hold more than meers 
the eye. We'll see, later on, rhar there's a command that allows you to actually 
widen any column on the worksheet. 

Let us tum now to the three cells on the "Royalties" worksheet that contain 
simple numbers. In the following illustration, the pointer has been positioned at 
cell R9C3: 

r a File Edit Select Formot Options Colculote 

: : : ........ .. ........ : ..... .. ......... .. : ......... .. ... .... : ............ .. .. ....... ......... .. ... : ............... .. . . . . . 
... .. ............. : .. ... ..... ...... · · :·· ····· ·· ~~Y:~~.T.'.E.~ ... ......... : ···· ············· . ~ ... ····· .. ....... . 

· · ·· ·· ·········· · [·· ······ ··········~··· ··· · · ·~~-~-~~~-~-~~ -- -·· ·· ·· ···~ ·· ········ · ··· ·· ··~ ···· · · ·· ···· · ··· · ! 

: ::( ~~: P.~i~:~:=~::: ~~~:.:~:~::::: ~:::::: ~~~,::~:H x: ~~~:(~~:i:~~= ::::: :?:.: ~~ :::::: ~: : :: :: : :::::::::: ! 
:::::::::::::::::::::::::::::::::::: l: :: :j:~~~~~~: :::: ~r.r.:_:~:~~ ::::: )~i~~:~P. :: :: l :: q~\~~:~:~:: :: I 

: .... ............. : ....... ........... : ..... ...... ... .... ! 
......... ...... ~IJO.r:tt.I.~Y .. ~~... 765 : 760 : 796 ' • • ................ . : .................. : ·· ·· · ······· · ·· ·· · :· = . . . . . ................ .. : ... .... ........... : .................. : .... ..... ......... : ...... ............ : .. .... ........ .... . '• 

...... ~~~u.r:r:t.~) .~ ~.e~ .s.a.t.e.s=.: ...... ?.5~ ...... . : .... . 1 .~ .1.5 .. ... .. : .. ... ?.~~~ ....... ; ... .. 3.~~ 1 ... .. . . ! !: 
. . . 

., 

In the formula bar, we discover the value 750, which is simply the currenr contents 
of the cel l. I f you wc:1nt to change this value, all you have to do is to type the new 
value on the keyboard and hit < Return>, then Multiplan would recalculate the 
entire model to take account of this modification. 

There are t';vo other cells on the worksheet that can be changed in the same 
way: R5C2, which contains the sales price in dollars, and R5C5, which contains the 
quarterly variation expressed as a percentage. 

Besides the cells containing legends, and these three cells containing 
straightforward numbers, all the other non·empry cells on the worksheet contain 
formulas. 

Let us start with the simplest formula of all, as shmvn in the following 
illustration: 
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r • File Edit Select Format Options Calculate 

. . . .. .. . " . '' .... .... .. .... .. .. .. .. .. ....... .. .. ... .. .... . .. . . .. ... .. ... . .. .. . ... .. .... ... ....... ... .... ... . 
. .. . . .. . . .. . . .. . .. : ... ... ............ : ... . J.a~~~~a.r_ .: ._ ,A.pr.~J_u~ .. . : .. ~u.l~.?.ep .... : .. q~; t :-:D.e_c _ .. . . . . . . . . . . . . . ' .•.. ... ........ .. ....... . .. .. .. ... • ... .. .. ........•.. . •• .. •.• .... • ' .. ....... . ... ..... ... ...... .. . 

... .... . ... . ... C?~a-~_u ty __ s_~) .d: _ : ..... .7~~ -- -· .. ... .... 7_6~· -·· .. ....... .1.8~ .... .. . ' · ... . 7_9~ .... .. . . . . . . . . . 
......... .. ...... : ....... .. .. ... .. .. : . .. .. ... . .. . .. . ... . 

1515 . 2295 . J091 . ...... ... ......... : .. ................ :- -· .. ············· ! 
. ...... ........... : .................. : ..... ... .. .... ... : .. .. .. .. .. ... .. ... : ....... ........... : .. .... .. . .. .. .. ... : 

1\.c~u.rn_ul _qt_e~ .~.o.~~~ .u.~~: .: ... _$_~_7~0 ...... : . ... ~-~-8~J ..... : .. J! _4 _7 1 _~ ..... : .. J2.0~! _2_ . .. . . . . . . . . . . . . 

Up in the formula bar, the relative address R[ - 2] C indicates that the value of cell 
Rl 1C3 (the accumulated sales at the end of the first trimester) is identical to the 
value located t\vo rows flllther up in the same column. Obviously, for this first 
trimester, the "aGcumulated" quantity is identical to th e quantity sold during the 
trimester. 

Cell R9C4 provides us with a more interesting formula, as shown in the 
following illustration: 

r • File Edit Select Formot Options Calculate 

ROYAL TIES 

.. /l..c~u.rn_u l_o ~-~~ .sa_l_~_s : ...... _7_5~ . .. ..... . _1_5 _1_ 5_ ... . . ... ..2.~ ~5. .. .. .. . ... _J()~ 1_ ..... . 
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The ROUND function - which was no doubt pasted imo this formula just like 
SUM, in our earlier examples- gets rid of unwamed fractions. TI1e formula states 
that sales for the second u·imester must be calculated by multiplying (asterisk 
symbol) the number in the previous column by the quanerly variation, cell R5C5, 
viewed as a percentage. 

Why is ce ll R5C5 referred to in the formula, exceptionally, by its absolute 
address, instead of a relative address? The reason is that this fo rmula for R9C4 can 
now be copied, as such, for the two remaining cells in the row: R9C5 and R9C6 
(sales for the third and founh trimesters, respectively). If the formula for cell R9C4 
had used the relative address of cell R5C5, then it would not have been possible to 
simply copy the same formula for cells R9C5 and R9C6. 

Now let's look at the formula fo r cell Rl1C4, as shown in the following 
illustratio n: 

"" li File Edit Select Format Options Calculate 
., 

. . . . . . ............. .... ........................................................................... .... ........ ......... 

'''''"''"''''" ': " '' " ''"'''"''•l••••'"''~~!·~~L:~·=:••• "• O •••••~O•Ooo•• oo O•••••• • •l•O•O • ••OO• • •ooooo o . . . .......... ................ ... .... ......... ......... ........... ........................................ ......... . . . . . . . . . . 
........ ......... : . ... .... .. ... ... .. : ... ... ..... ...... . : .................. : .................. : ........... .. .... . 
. . . e.s. pr. lc.e.:: .. . ~.s.q .'. o.o ..... : .. .... ~~~.r.t~r.) r x~.r.'.~ ~.~.~~: : ... .. ?:. ~9 ..... .. ; .. ... .. .. ........ . . . . . . . . . . ......... ........ .. .... ..................................... ............ ........ ................... ....... ... ... 

.. .. .. .. . . .. .. . ... : .. .. ... .. ....... .. : .... ~.o~ :-.r~1(1r .. : .. P.-P.r. :-.J.u~ ... : .. ~u.\:-.~.e P. .. .. ~ .. R<:t~~e.c ... . . . . . . . . . . . . . . ......... ........... ...... .. ....... .... .......... ............... ................................... .............. 

.. .. . . ... .. . ... ~~a.n.ti.t y. s.ol d:.: .... . . 7.5~ .... . .. : .. .. . .7.6~ ... .... : ... ... 7~~ .... ... . ... ... ?.9~ . ... .. . . . . . . . . . . 

: ::: :: ~:~~~~:~;~t:~~ : ~:~:~:~~ ; ::: : : :::?:~~ : :: ::::iwwM:::::?:~ ~s:: : : :: : ~ : : :: :3:q~1: : :: : : : . . . . . . . . . . . . . . ...... ....... ... .. .................. .. .. .......... ..... ... ..... ............. ......... ............ .. ..... ......... 
P.o.~f:U.rn.~l.a t .e~ .r.O)'(ll t.iiJ~ ; . ; ... . $_3.7~9 ... ... : .. .. ~.8.~~3 ... .. . ~ ... ~. ! .~ n~ ..... ~ ... gq~ !.? ..... . . . . . . . . . . . . . . . 

To calculate the accumulated sales for the second trimester, Mulriplan is instructed 
to add the quantity sold during the current trimester (the number two rows up in 
the same column) to the accumulated sales at the end of the previous trimester 
(the number one co lumn back in the same row). TI1is same formula can be 
copied, identically, for the cells RllC5 and R11C6. 

Let's move clown to the lower half of the model in order to examine several 
quite meaty formulas that use the so-called logical functions such as IF, TRUE, 
FAlSE, AND and NOT. Here's the formula for cell Rl 5C3: 
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............... ~~~.n-~1-~Y. -~-~! .d:.: ...... ?.~~ ... .. .. : ...... ?.6~ ..... .. : ...... ?.~~ ............. ?.~~ .. ... . . . . . . . . . . . . . .................................................... .. ......................................................... 
Accumulated soles: : 750 : ISIS : 229S 3091 ··························· ·· ·· ·· ·· ·· ···· ········ ······· ···················· ············ ······ ··········· ·· ···· . . . . . . . . . . . . .......... ... ......................... ........... .... .. .. .... .. .. ................... .......... .......... ....... 

~-c~u.r.nl! ! .~ t.~~ -~.<?.~ !l! ~-I~~:.: ... J3.7~9 .... .. : .... ~.6.6~3 ... ... : .. J !.~!. ).~ ... ..... gq~) .? ... . . . . . . . . . 

.t.O.?-.. r!l~~ -~.u~~- ~~ -~-~P.! .... ~A..~~~· ·· .. : .. .. ~A..L~E ....... JA..~~~ ... . 

. t.S.?·.t!lt~ . ~.~:~.s t. -~~ -~-~.P.l ....... .. ~A..~~~-· ... : ...... ~.R~~- . .... : ... ... ~.R~~- . ... . .... f. A..~~E .. . . 
~9.?·. t!lt~. ~.~:~.s~. -~~ . ~-~P.l .t.~~ .... ~A.~~~- .... : .... -~ A..~~~- .... : .... -~ A..~~~-......... -~-~~~- ... . . . . . . . . . . . . . ................... ....... .......................... ........... ......................... ...... ················· 

:Total 1 0'1. : 3750 : SOOO : 5000 SOOO ........ .. .. .. .................. .................... .... ........................................................ 
First total IS'I. : o : 3663 : 97 1S 0 ....... .. ................. .. .......... ..... ....... ..................... ........ ........ .............. .. ...... ... 

Second tota l IS'I. : : 0 : 0 .. ..... .. ... .... ... .......... .. ............................... ......... .............. .. ....... ··· · · ·· · ·· ·· ····· · 
:rotol 20'1. : : o : o 

The argument of the IF function is a list of three elements, separated by commas. If 
the first element - a logical expression - turns out to be true, then the second 
element supplies the value of the function. But, if the logical expression turns out 
to be fal se, then the value of the function is supplied by the third element. As you 
have no doubt gathered, a so-called "logical expression" is something that must be 
either true or false. 

Here, the logical expression is a comparison between the value that is four 
rows up in the same column (the accumulated sales at the end of the current 
trimester), and the number 1001. More precisely, Multiplan is to ld that, if it's true 
that the accumulated sales are less than 1001, then the value TRUE (second 
element in the list) should be inscribed in cell R15C3. On the other hand, if it's 
not true that the accumulated sales are less than 1001 , then the value FAlSE ( third 
element in the list) should be inscribed in cell R1 5C3. Incidenrally, don't wony 
about those curious pairs of empty round brackets after the function names TRUE 
and FAlSE; that's merely a syntactic id iosyncrasy of no importance. 

In other words, this cell must read TRUE if accumulated sales are below the 
thousand mark, or FAlSE otherwise. That's what we mean when we speak - as we 
did, earlier on - of a "logical flag". 

Obviously, this same formula can be copied, identically, in the three other 
cells in the row: R15C4, R15C5 and R1 5C6. 

Let's move down to cell R16C3, as shov.n in the following illustration: 
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r li File Edit Select Formot Options Colculote 

......... ..... . ~~~.t:~.t.i.\Y .. ~.o) _q;_: ...... ?.~~ ... .... : .... .. ?~~ ... .. .. : ...... ?.~~ ... .. .. : ... ... ?.9~ ..... . 

::::: : ~~~~~:+~:~~ : ~:~:~:~~~: l ::::: :?~~: ::: :: :; ::::: i ~:~: ~: :: ::::;:: :: :?:?~~ ::: ::: ;:: :: :~:9~ c::: 
:.;:c~~.:n-~i·~~-~~ ·r-·c,·yai ~-~·~;:·: ·· .. i.i?sii · · · · ·:· ·· ·i·a·a63-· · ·· ·: · · ·$ i ·4 1 ;·i; · · · · \ · · ·$io9 i.i. · ·· 
·· · ···· · ··· ··· ·· ·· :·· ···· ·· ··· ··· ···· :··· ········· ······ :···· ······ .. ······:·· ··· ·············:· ····· ······"''' i 

::}H~;; :;.~;:::; ·;~~;::-:~:ad·: :· ~~V/ :: : :: :: · <~~s~:-_::.; : .·: ;~t~~ :::: I 
~~-'1.. :.~!": .~.l!.~ ! .. ~": _o_~P. ) .1.~~ .... _F ~-L~~- .... : .... .f~.~~E ..... [ .... _F ~-~~~- .•.. : .... .. T.~~E- ... . 

· · · · · · · · · · · · · · · · · ·: i ~-i ~-~ · i ·a·'l.· · · · \ · · · · ·:i7sii · · · · ··\·····socii ······\···· ·s·oaii · · · · · · \ · · · · ·s·oaii · · · · · · 
· · · · · ·· · · · F"i~;·i ·i~i~-~ · ;·5·1.· · ··: · ······a········ ·:··· .. :3863 · · · · · ·: ·· · .. 9.7 ·~· 5· · · · · · · :····· ···a········· 
::::::: ~~9:~~~ :\~\a:~ : ) :~:~:::::: : :::: :P:: :: ::: ::::::::: ::q:::::::: T ::::: ::o:: :::::::::: :Js:q~O. : :::: · 

:rotol 20'1. : : : : 

., 

TI1e argument of the AND function is a list of logical expressions. If all of them 
tum out w be true, then the function returns the value TIWE, otheiWise it returns 
the value FAlSE. 

If cell R16C3 is to be TRUE, then rwo things are necessary: the cell one row up 
in the same column must 10T be true, AND the value of the cell five rows up in 
the same column (accumulated sales) must be less than 3001. In other words, this 
logical flag is set to TRUE as long as more than a thousand, but not more than 
three thousand, copies have been sold; orheiWise it's set to FAlSE. 

This same formula can be copied for the other cells in the row: R16C4, R16C5 
and R16C6. 

Let's move down to the next cell , as shown in the fo llowing illustration: 
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., 

... .... ........ ~~~.':l.ti.~Y .. ~.~1.~:. : ... . ..... .... ..... .. ..... ......... .......... ... ........ . . . . . . . . . . . . ·········· ·· ··· ··· ·········· ··········· ·· ·· ········ ··············· ···· ·············· ·········· ....... .. ....... . 
Accumulated soles: : 750 1515 . 2295 3091 .. .... ...... ..... ..................... ..... ..... .. ......... ....... .... .... ..................................... . . . . . . . . . . ..... . .. .. ... ..... . ......... .. .. .... ... .... .. . .... .... . .. .. .. ... .... . .. ..... . ............ ... . .. . .. .. ........ .. . 

P.-.cc:~.rn.l!l.at.e~ .:.o:~~l .t.l .e:J: . : .... E~~o ...... : ... J8.8~3 ... .. . ' .. J1 .'1~! .~ ..... ... E~~! .? .... . . . . . . . . . . . . ....... ... .................................... .... ........................... 
1 O'l. rote must be oppl led TRUE : FALSE : FALSE FALSE . 

·1·~?·~~:~ ·~~~t ·~~:t.~~i}:~;~~::· .;zlu:; :: :: !:: :·;~\tE:·· . : ·: .. :F~~t:· ::: :. 
. . . . . . . . .......... ........ .......... .............. .... ............. ........... ........... ........... .......... ... ....... 
:rotol 1 O'l. : 3750 : 5000 : 5000 5000 ... . ....... ....... .. .... . .. . .. ........ . ... .. . ..... . .... . .. ... . ..... ....... ......... . ...................... . 

Firs t totol 15'l. : 0 : 3663 9715 0 .. ... ...... ...... ..... .. ........... ...... .. .... .. .... ... .... .. ........................... ... ...... ............... . 

No problems at this level: cell R17C3 will be TRUE if both cells above it are FALSE. 
TI1e same formula can be copied into the adjacent cells : R17C4, R17C5 and 

R17C6. 
Now, let's turn to the formulas, down the bottom o f the model, that actually 

calculate the royalties in each bracket. TI1e following illustration deals with the 10% 
bracket: 

r • File Edit Select Formot Options Colculote 
., 

Accumulated soles: : 750 1515 2295 309 1 .... .. .. .......... ... ...... .. .......... . ... ...... ... ...... .......... .. ..... ... ............... .. .............. 
. . .. . ................................................................................................... . . . . ..... 

P.-.c~~.rn.u l.a~.e ~ .~.~X~l ti.e~ : .: .... E?~O ...... : ... J6.~~3 . .. : ... . J 1 .~! !.? ..... ... go~ !.2 .... . 

. 1. ~.?-. :,~I~ . ~.u.s .t .. b~ . '?.i?P.! .~.~~ ...... T.R~E ...... : .... f. >\.L ~ E .... ..... f. P.-.L~E ..... ... . . ~ A..L~E . ... . 

. 1. S.'l.. :,~ I~ . ~.u.s t .. b ~. oppl ,l.~~ .... f. P.-.L~~ ..... : ...... T.R~~ .... .. .. ... . T.fl~~ ...... .. .. . F P.-.L~E . .. . . 
~9.'l.. _r. ~ t ~. ~.u.s t .. b~ . app 1 .1.~~ ..... F A..L~E .... . : .... f. A..L~E ... .. .. .. f. A..L~E ...... ... .. T.R~E .. ... . 

.. . .. .. .. .. :: ::::::! 9. i ~:~:: i :g:'l.::: :iMJOm::: :$:o~~ : :::: ::: >q~o: : : :: :: .. ... 5.qq9 ....... 
Firs t t oto l 15'l. : 0 : 3663 9715 ..... .. .. .. .. . .. .. .. ... .. .. .... .. .. . .. . .. .. ..... ... ....... .. .. ... .. . . .. . ... .. .. .. .. .. . .. .. .. 

0 0 0 
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The outcome of this rather complicated formula for cell R19C3 depends upon the 
10% logical flag just four rows up, in cell R15C3. If the flag is TRUE, then the 
function returns a value that is 10% of the product of the sales price in R5C2 and 
the accumulated sales, e ight rows up in the same column. But, if the flag is FALSE, 
then the function returns a ftxed amount that is 10% of the revenue obtained from 
the ftrst thousand sales. 

TI1e same formula applies to the other three cells in the row: R19C4, R19C5 
and R19C6. 

Let's cany on moving down the column: 

. . . ................. .. .. ....... .. ... ...... ....... .. .......... ... .. ................ ........... ...................... 
Accumulated sales:: 750 : 1515 . 2295 : 3091 .... ....... .. ... .... ...................... . ... .. .... .... ... .. .. .. ... .. . .... .... .... .... ... .. .. . .. .. ... ...... . ... . . . . . . . . . . . . . . . ............. .... ... .... ................ ...... ... ....... .. ...... .... ....... ........... .............. ...... ...... 

~.~c:u.~.~).~~.~~. ~.~.~~1 t.l.e~: .: .. . J~.~~9 ... ... ~ ... J~.6~3 ...... ~ .. J! .~ ~ ! .~ .. ... ~ ... EO~!.? ... . . . . . . . . . . . . . . . . ... . ..... .. .. .. ... .. ... ... .. .. .. ..... . .. ... ... .... ... ................ ... .... .. .. .... .. .. .. .. .. .. . .. .. . , ...... .. . . 
.1. O_'l.. tll!E'l. ~.u.st .. bEl. apP.l.i.e~ .. .... T.R~E ... ... ~ .. .. f. ~.L~E- ... _~ .... f. ~.L~E ..... ~ .. ... F f'.~~E ... . 
·'· 5.f •. .rll!E'l . (l:l.~.~~. b.E'l . ~.JlP.) .~.~~ .. .. f. ~.L~E .... ... .. .. .T.~~~ ..... _ ~ ... ... T.~~E ...... : .. ... ~f'.~~~ ... . 
~O.f •. . rll!E'l . (l:l.u.st. b,E) .a.JlP.l.Ie~ .... f. ~.L ~E ..... ; .... f. ~.L~E .. ... ; .. .. f. ~.L~E .. ... ; ... ... T~~E .. .. . . . . . . . . . . . . . . . . ... ... .. ..... .. .............. .. ..... . .. ... ........... .. ... ... .. ... ... ... ... .. ... .. ... . .. ... .. ..... ... ,, .... .. .. . 

:Total 10/. : : 5000 : 5000 : 5000 ......... .... .. ..................... .. .. .... ... .... ................... .. ... ... ............ . 
First total 15/. 3B63 : 97 15 : 0 .. .. .... .... ..... .. .. . ... .. .. ....... .. .. .. .. ....... ... ... .. .. .. ........ ... .. .. ............ . 

Second total 15/. : 0 : 0 : 0 : 15000 ..... .. .. .. .... ........ ... ............ .... ............................................... .. ..... ................ 
0 : 0 : 0 : 

Cell R20C3 will contain a non-zero value only if the 15% logical flag, four rows up 
in the same column, is set to TRUE. In that case, cell R20C3 will contain an amount 
that is 15% of the revenue obtained from all sales beyond the ftrst thousand. 

The same formu la can be copied into the neighboring cells: R20C4, R20C5 
and R20C6. 

Let's move on to the second-last cell in the column: 
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. . . . .. ..... ..... .... ... .. ..... .. .. ............................................................... 
Accumulated s al e:s: : 750 : 1515 : 2295 3091 ............................. ...... ... ... ................. ........ ......... ... ..... .. .. .... ... . . . . . . . . . . 

~:~~~:~:~!~~~~ :r:~x~j~:i~~~:: ::::#?~(:: ::: : : j~~~~:: :: :: :: :~i:~!!:$:: : .. : .. J?.q~ 1 .z. .... . . . . . . . . . . 
• • 0 • • .......... ................ ........... .. .. .... ........ .. .. ... .. ............ ....... ......... .. ..................... 

. 1. ~.:t.. r.~ !~ .~-~-~~--~~-~-~P.! .t.~~ ...... T.R~E ...... : .... f.~.~~~ ..... : .... f. ~.~ ~~ ..... : .... f.~.~~~ .... . 

. 1. 5.?-. !:~ !~ . ~.':'.~~- ~~ -~-~P.! .~.~~ .... -~ ~-~~~- ...... .... . !.~~E .. ........... !.R~~- ... .. : .... f. ~-~~E .... . 
~~.1. .. r~!~. ~.':'.s~. ~~ .~PP.! .1.':~ .... f. ~-L~~- .... : .... f. ~-L~~- .. .. : .... f.~-~~~- .... : ..... .T_R~E ..... . . . . . . . . . . . 
.. ... ............. : ................. . : .................. : ... .. ...... .. ..... : .................. : ................. . 

:rotol IO'l. : : 5000 : sooo 5000 ...... ... ....... ............. ...... ......... ... ..... ..................................... .... .................... 
First total 1 S'l. : : 3863 : 97 15 : 0 ............ ........................................... 

: 0 : ...................................................... 
; 0 : 

Cell R21C3 w ill contain a non-zero value only if the 20% logica l flag, four rows up 
in the same column, is set w muE. In that case, cell R21C3 wil l contain a fixed 
amount that is 15% of the revenue obtained from the sale of two thousand copies. 

TI1e same formula can be copied into cells R21C4, R21C5 and R21C6. 
We finally reach the last cell in the column, as shown in the following 

illustration: 

" II File Edit Select Formot Options Calculate 

...... ....... - ~~~.r:t.t. i_~Y. -~-~ !~: .: ..... _7_5~ ..... ... .... . 1.~? ... ... : ..... .7.~~ ... ... . : ..... .7.~~ ..... . . . . . . . . . . . . . ··············· ···························· ············ ......................................... .. ........... . 
Accumulated sales: : 750 15 t 5 . 2295 . 3091 .... ..... .. ..... .. . ...... . ..... . .... . ................................. ....... . .. .. ...................... . .... . . . . . . . . . . . . . ... ............. .... .. .............. .. ............. ... .............. .. .................. .. .... ........ .. ........ 

~-c~u.r:n_ul .~ t.':~ .r.o.~~ ] ~-~-~~:. : .... ~.3.7?0 . ... .. ... _$_8_8~~- .... . : . .. $. 1 .~? ! .~ ..... : ... FO~! .2 ... . . . . . . . . . . . . .... ...... ... .. ................. .. .... . ................. .. ....... .. ................ .. ............. ...... .. 

. 1. 0_? •.. \~!~ -~-~-~ ~- -~~. ~PP.l.i.~~ .. .. .. T.~~~- .. ...... .. F ~~~~- .. .. : . .. . f.~-~ ~E ... .. : .. .. F. ~~~E . .. . . 
1. 5.1.. !:~!~. ~-~-~ t. -~ ~. ~.~P. I .t.~~ .... F. ~.L ~E ........ ... !~~~- ... .. : .... ..T_R~~- .... . : .... -~ ~.L ~~- ... . 
. 0.?-. !:~!~. ~.':'.~ ~- -~~ .~n! .t.e~ ... f ~-L~E ......... . F ~~~E ..... : ..... F ~-~~~- .. .. : ... ... !~~E ..... . . . . . . . . . . . .. .... .... .... ......... ... ... ..... ...... ...... ... .. ... .. .... .... ... ....... ..... .. .. .. ..... .. .. ......... ...... ... 

:Total t O'l. : 3750 5000 : 5000 : sooo ............................ ... ................................. .. .................. .. .......... ............... 
First total 151. : 3863 : : 0 ...... ......... ...... ..... ...... .......... .. ... .. ... .. .. ...... .. . ..... ......... .. .............. .. ... .. ......... 

0 : : 
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The value o f cell R22C3 depends upon the 20% logical flag, five rows up in the 
same column. If the flag is true, then cell R22C3 receives an amounr thac represents 
20% of revenue obtained from all sales beyond the first three thousand. 

The same formula applies to cells R22C4, R22CS and R22C6. 
Let's move back up to the row that displays the accumulated royalties, as 

shown in the fo llowing illustration: 

., 

•......• . .•.•••• : ... ... . ... ... .. .. . : .•••••.•.......... : ... . ..........••.. : ....• . ... ...•.... . : .. .. . .. .. ........ ! Accumulated soles:: 7SO : ISIS : 229S : 3091 .! 

;~~u:0:uj~t~~ ·~~:Y~;t.l:~~i :·~~C.s.a~~; ::::.i: ::~· i .4 ~ i.~. : :: .: :::;z:o~!:? .. :: .. 1· 
. . . . . . . . . .... .............. ...... ................ .... ...... ............... .... ..... ........................ .... ........... 

I Oi'. rote must be applied TRUE : FALSE : FALSE : FALSE 
~~~:~~:: ·~~.:r:~: :~:~~:::-:~:: . .;i.g~.: . ::·:::: i~:~:E:·:::.·:::;~~~:: ·:· :: .· .. FtN::.::: 1· ~ 

. . . . . . . ········· ···· ·· ········ ···· ··· ····· ···· ····· ········· ······ ···· ············· ··· ····· ···· ····················· . . :Total I OZ : 37SO : SOOO : SOOO : SOOO .. · · ........ ;;1~; ·i ·;~·;;i · i ·s·'l. .... : ....... o ..... .... , .. .. '3'863 .... .. :· .. · ·9·7·1·5 .. · .. .. : · .. ... . 0 .... ..... .: , 
::::: ::: ~~~:~~d: :;~:;~:~: : i:s:'l.:: :::::::::: :o::::: :::: j: :::: :::a::::::::::::::::: :a:::::::: ::: :: : !:~:oqO,: :::: :i , :Total : 0 : 0 : 0 : 912 

The value of cell R13C3 is simply the sum of the four values at the bottom of the 
mode l. This same fo rmula is used for each of the remaining trimesters: cells 
R1 3C4, R13C5 and R13C6. 

That's all there is in this Multiplan model. If you want to actually see all these 
formulas simultaneously, then you can pull down the Options menu (see 
following illustration) and choose the Show Formulas command. 
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..... .. .. .... ... .. : ................. . : . .... .. v'Unprotect Document 
.l.~'l •. -~~ t~ .rn.u.s t. _b~ _appl _t_e~ ...... . ••· 
51. r'al e must be applied F 
... ;~~~ ·;.;;~·si· "b~ ·~·p·pi·i~d ·· · ;;· Remoue Cell Protection 

····· ·· ·· ···· ·····:··················;······· ./Restore Cell Protection 
.................................................................. .. .. .. .. ...... ... .. .. .. .... .. ................. 
...... .. .. .. .. ... }o.~~.u.o.t. .. .. : ... J7~o ... ... : .... . 5.o~o : 5ooo 5ooo 

.. .. .. ..... f. tr_st __ t o.~ a.l .. !.5.t. .. .. : ..... .. . o .. .. .. .. . , .. .. . J.~~j :::::T:: j:?:t:~ :::::: :: :: ::: :o::::::::: ·· ' 
Second tot al I 51. : : 0 . 0 ············ ···· ·· ·························································· ····· ·· ········ 

' To ta l : 0 

199 

., 

Even though this command automatically doubles the width of displayed columns, 
many of the formulas are still too long to fit into t11 e allotted space. So it's best that 
you pull down the Format menu and ask for the Column Width command, as 
shown in the followiRg illustration: 

I~~~=~~~~~ Percent 
.tNo Decimal 

Decimal 
Scientific 
Bar Graph 

Calculate 

Number Of Decimals ... ...... ········ ···· ··· ···· ··· ··· ·· ·· ··· ·· 
1··-·------------·------·--------1 ~ ~-~ ~ ~.Y!~.< -~ .l.~ ~I~' .R.J.~?! .c '· ~. 1 .. 

., 
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A dialog box asks you for a new setting for the column width (see following 
illustracion). Reply by 40, and click the OK button to cany on. 

Options Colcult~te 

New Column Width: ._1 4_~'-------' 

0 Set All Columns to Standard Width 

Cancel 

Here's the result for column 3: 

,. • Fil e Edi t Select Formot Options Colcult~te 

---==--~ ----------

. . .. ... . ....... ..... .. .. .. .... ... ... . ..... .. ... . .... .. ... ! .... .. ..... ... .. . .. ... .... . .. .. .... . . .. . . .. !1 

~~.!~.?.1.~ ................ ......................... ......... ......... : ~~.~.1.:.1. !.~~!::?.\~ .................... : :; 
I ........... ......... .... .. .. .................... ......................•....... ................................ ... 

~~.U.M. ~ .R (+~! ~ 1 .R.!.+_7) .~ ! . ~. ! :.~.J.~ ... ~! ~?.J. ~. ~ ................ : ~~.Y.~. ~ .~ !.~~ ! ~ 1 .~.!.~?! .~ ·'· R.! ... 
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TI1at brings us to the end of this rapid overview of Microsoft Multiplan. It's an 
elegant program that provides a superb example of what might be termed the 
"Macintosh style" of computing. Above all , it's a powerful productivity tool for 
people who are concerned by "What if ... ?" questions. 

And what if we took a look now at a sister product o f Microsoft Multiplan? 



chapter 9 

"Chart" - Business Graphics 

The Microsoft Chart tool enables you w produce a great variety of figures of the 
kind that are usually referred to as business graphics. that is, charts that reflect the 
relationship between a pair of variables, one of which is often time. 

111e most familiar representation of such a chart is simply a rectangular graph. 
In Microsoft Chart terminology, the variable represented by the horizontal x-axis 
designates the so-called categories of the graph, whereas the y-axis is said to 
provide the values. 

Chan offers you the choice berween over 40 different formats, including 
various histograms, line grapbs and pie cbarts . .. and nothing prevents you from 
changing rapidly from one format to another, with a view to selecting the most 
attractive presentation. 

The clirectOty of the "Chatt Master" disk is shown in the follmving i llustration: 

r • File Edit Uiew Special 
., 
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The icon named "Chart" is the program itsel f. "Modules", as usual, is a folder 
holding half a dozen elements of system software, and "Dossier" is an empty 
folder that might be used later on for storing some of the graphic documents that 
we are about to create. 

Demonstration 
Let us imagine an elemental)' example that consists of plotting two series of figures 
for a business: j01·ecast monthly sales for the year, and actual monthly sales. What 
we intend to do is to present these two series of figures as a single cha1t, so that 
they can be easily compared. 

Double-click the "Chart" icon to start the program. Two w indows appear on 
the screen, as shown in the following illustration: 

,. 4i File Edit Data Gallery Chart Form11t 
., 

In the background, the untitled chart window will not be used until later on, to 
display actual charts. 

For the moment, it's the w indow labeled "New Series" that concerns us. The 
term "series' ' merely designates a set of pairs of corresponding x-y coordinates. 
Notice that the window has a column for the categories on the left (x-axis), and a 
column for the values on the right (y-axis). But, before being able to insert any 
information concerning the new series we intend to create, we must tell the 
machine what sort of data we are going to propose. This is done by pulling down 
the Data menu and choosing the Text command, as shown in the following 
illustration: 
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"CHARr' - BUSINESS GRAPHICS 

., 

l11is info rms Chart thar we imend to refer to the categories on the x-axis, not by 
numbers (as might have been expected), but by textual labels: in fact, by the 
abbreviated names of the twelve months of the year. Notice that, besides Text, 
there are three o ther commands at the top of this menu: Sequence puts a simple 
arithmetic series of numbers in the left column, such as 1, 2, 3, etc. Date inserts an 
actual series of precise elates into the left column; and Numbers allows you to 
propose any numeric terms whatsoever for the x-axis. 

As far as the values along they-axis are concerned, only numbers are allowed. 
The Te;xt command offers us a dialog box (see fo llowing illustration) that 

allows us to name the future series itself as well as the two axes. 
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Chort Formot 

Series Nome: I Forecost 1984 

Cotegory Nome: I Month 
~====:==~ 

Uolue Nome: IThousonds of~ 

Cancel 
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We have named the series "Forecast 1984", because it will be composed of the 
projected sales figures, month by momh, for that year. l11e x-axis is to be called 
"Month", and the values alo ng the y-axis are to be represented as thousands o f 
dollars. 

Once the OK burton is clicked, Chart will present us with another window, 
named "Forecast 1984", as shown in the fo llowing illustration: 

r li file Edit Data Gallery Chart format 
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Notice that the window labeled "New Series" is tucked away just behind this latest 
window. The letters x and y have been replaced by the axis names that we just 
indicated, and there is a curious li ttle pointer that marks the spot where we are 
about to stan entering the names of the twelve months. 

The two columns might be filled in as shown in the following illustration: 

,. • File Edit Onto Gallery Chnrt Formnt 
., 

In creating this series, you use the mouse ro move the pointer from one column ro 
the other, or from one line to the next, and then you have to cl ick it. If you do nor 
place an explicit numeric value in the righthand column, Chan automatically 
inserts a zero. 

The next step in our demonstration consists o f creating a second series 
containing the actual sales figures for the year. 

There is a little trick that you must not forget in order to carry out this 
transition successfully ( that is, w ithout accidentally destroying the series you just 
created). It consists of clicking rhe title bar of the hidden "New Series" window, ro 
make it active. When this happens, it's the "Forecast 1984" window that gets tucked 
away behind the "New Series" w indow, as shown in the following illustration: 



DEMONSTRATION 

Number ... 

SorL. 
llnlliiJl.P ... 

List.. . :ICL 

207 

Now you can pull clown rhe Data menu once again and choose the Text command. 
Fill in the name "Actual sales 1984" for this new series (see fo llowing illustration), 
and click the OK bunon. 

Gallery Chnrt Formnt 

TeHt Series 

Series Nome: J Rctuol soles 1984 

Category Nome: J Month 
~====~ 

Uolue Nome: jThousonds of$ 

Cancel 

This second series might be completed as indicated in the following illustration: 
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., 

Mar 
Apr ; 1600 

May I :iOO 
Jun 1220 

Now you can put both series side-by-side, as shown in the following illustration: 

1500 
Mar 1500 Mar 
Apr 1550 Apr 

May 1800 May 
Jun 1100 Jon . 
Jul ! 1700 Jul · 

Aug 1!500 1\oQ ; 
S.p : 1700 s.p ! 
Oct ! 2300 Oct 1 

flov i 2400 
~ : 3000 

(ln case you're wondering what has happened to the windows named "New 
Series" and "Untitled", they have simply been reduced to small rectangles and 
tucked away out of sight behind the rwo windows we have just created ... so as to 
minimize the cluner on the desktop.) 

The next step is to tell the machine which series is to come first when the 
chart is drawn. This is done by clicking the little square boxes just to the left of the 
expression "Plot Series". TI1e logical solution would be to put the forecast values 
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before the actual values, so first activate the window labeled "Forecast 1984" and 
then click its "Plot Series" box. Next, activate the window labeled "Actual sales 
1984" and click its "Plot Series" box. 

Chart carries out its plotting oper-ations in the o rder you requested, and the 
"Order" boxes in bolh v.rindov.'S will reflect this sequence, as shown below: 

Jon 
F.t> 
Mar 
Apr 

Mov 
Jon 
Jul 
"ug 
Stp I 
Oot 
Nov 
Dec 

850 
1500 
1500 
1550 
1800 
1100 
1700 
1500 
1700 
2300 
2400 
3000 

Formot 

Moin [ h!Ht TtjPP. .. . 

01JP.fi1Uj [ IHH t ·ry[>P. . •. 
llm)s .. . 
lllltl I. Hg<HHI 
lltltlllrrnw 

S<!I<H t [ hnr t 
S<!I<H t l'lo t HrP.n 

Redrow Now 
./Rutomotlc Redrow 

., 

Now pull down the Chart menu and choose the Show Chart Window command 
in order to see the results, which are shown in the fo llowing illustration: 

3500 

3000 

2:100 

2000 
Thousands or$ 

1500 

1000 

500 

0 
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This is a chart of the so-called Column variety, but mher models can be chosen by 
means of the Gallery menu, as shown in the following illustrarion: 

4000 

3500 

3000 

2500 

Thousor.ds of$ 2000 

1500 

1000 

500 

Feb Mor Ap- Mo~ J\11 Jul Aug Sep Oct Nov Dtc 
Month 

If you ask for the Combination variety, for example, the fo llowing set of four 
models is displayed in a window on the screen: 
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You click the model you wam, then you click the OK button to obtain the rapid 
transformation of your chart imo the request eel style. 

One of the most attractive models, in the case of our example, is shown in the 
following illustration: 

~ j file Edit Data Gallery Chart Format 
., 

4000 

3500 

3000 
0 forl'eOst 1984 

2500 • Actual salts 1984 

Thousands of $ 2000 

1500 

1000 

500 

0 
Jon feb Mar Apr May .An Jut Aug S•p Oct Nov ~c 

Month 

Charts can be copied omo the Clipboard (see following illustration), enabling you 
to use them as graphic input ro MacWrire or MacDraw. 

Jon Feb Mar Apr Mo1J .An Jill 
Month 

., 
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Since there's a slight difference in the way they look on the screen and the way 
they're primed out on the Imagewriter, Chart asks you which solution you prefer, 
as shown in the fo llowing illustration: 

" li File Dolo Gollery Chart Format 

Copy Chart to Clipboord 

® As Shown on Screen 
0 Rs Shown when Printed 

Thousonds of $ 

Cancel 

2500 

2000 

1500 

1000 

!500 

0+-~--~~-+--+-~~~~-+--+-~--~0 
Jon feb Mar Apr May Jun Jut Aug Sep Oct Nov Dec 

Month 

., 

l11ere are many orher interesting possibilities opened up by the existence of 
Microsoft Chart. Fo r example, in the Data menu there is a Sort command that 
enables you to change the order of borh categories and values. And there are 
half-a-dozen arithmetic and statistical calculations that can be called upon for any 
series. 

Finally, it should be pointed out that there are links between Multiplan and 
Chart that enable you to actually visualize worksheet results, most effectively, by 
means of charts. 
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"MacProject" - Project Planning 

Uke Multiplan, the MacProject tool - created by Apple Computer - takes us into 
the domain o f computer modeling and simulation. MacProject is a close cousin of 
PERT (Program Evaluation and Review Technique), which is a system of 
scheduling interdependent events in such a way that they combine together as 
efficiently as possible in order to complete a global project. 

TI1e events that might be incorporated into a MacProject model can be quite 
heterogeneous, and of any nature whatsoever. l'vlaybe the only thing they have in 
common is that each event necessitates a certain amount of time. Apart from that, 
we are faced with a situation in which certain events can only start to take place 
once other specific events are completely terminated. l 11is planning tool is 
designed to handle ideally the sort o f project in which a certain number o f team 
members - working concurrently, almost in paralle l, on quite different tasks -
must harmonize their efforts so that no particular individual is systematically 
slowing down all the other members of the team through inadequate planning. In 
other words, MacProject might be thought of as a tool for operations research. 

Instead of theorizing any further about this excellent product, let us look at a 
simple case study using lvlacProject. 

Demonstration 

Our example, this time, concerns an author who - on )anuaty 26, 1984 - staned 
to write the manuscript o f a book about an interesting personal computer that had 
recently come into existence. He figured that the actual job of producing the 
manuscript would take no longer than six weeks, because he intended to use a 
word processing product to facilitate the task TI1e author had several friends with a 
remarkably thorough knowledge of the new computing machine (because they 
worked, in fact, for the company that manufactured it), and these friends had 
promised him to take no longer than a week, once the manuscript was given to 
them, to review it and to pull out all the bugs they could find. At the same time, 
the author planned to send his edito r a copy of the draft manuscript, so as to 
receive further suggestions for improvements. This latter operation was almost 
certainly going to take two weeks, because the author and his editor actually lived 
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in two di fferent countries, and the mail service was far from perfect. TI1e author 
reckoned that he could handle all corrections to the manuscript in the course of a 
week. And since the publisher and his printer intended to use avant-garde 
computerized techniques for the actual production of the book, they expected to 
have it in the book stores no more than three \veeks later. 

So, tel's see how this project \\>tlS planned with the help of MacProject. 
TI1e directory of the "Project" disk is shown in the following illustration: 

,. • File Edi t Uiew Speciol 
.., 

DO 
Modul•s Dossi•r 

The starting point, with MacPro ject, is to draw a set of connected b locks that 
constitute the flow diagram of the project in question. 

(As in the case ofMacDraw, our example w ill be limited to a flow d iagram that 
could be printed out on a single sheet of paper, but there is a Drawing Size 
command that makes it possible for a single MacProject document to extend over a 
few dozen sheets of paper.) 

Now, it 's easy to use this tool to draw connected rectangles. You position the 
pointer (a cross), then hold down the mouse button and drag the po inter in a 
" rubber banding" manner. The line that connects rectangles (see following 
illustration) is obtained automatically and rapidly by dragging the poi mer from one 
rectangle to another. Text is entered by clicking the pointer inside a rectangle and 
then using the keyboard. 
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r s file Edit Fonts Style T11sk Project Ch11rt 
., 

. e=;: -- -- - ' ~: -- -- -:_ Untitled 

FIRST BlOCK 

+ 

S£ca«> BlOCK 

·n1e basic structure of the MacProject flow diagram for our case study is shown in 
the following illustration: 

r • file Edit fonts Style Tosk Project Chort 

TI1e two blocks labeled BEGIN and END can be thought of as simple delimiters . .. 
which means that there are really only five major blocks in the structure. 
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MANUSCRIPT, as the name suggests, designates the six-week task of creating the 
initial manuscript, carried our by the amhor. FRIENDS is the name of one of the 
following operations, p lanned co last a week, during which the author's friends 
review the draft manuscript. EDITOR, at the botcom, is the name of the two-week 
phase during which the author's publisher carries out an analogous reading of the 
draft manuscript. ·n1 e author intends to wait for both copies of the draft manuscript 
- so that he can compare the critiques - be fore getting involved in the task 
labeled CORRECTIONS, planned to last for a week. And then the final task, labeled 
PUBLICATION, will involve the publishing house and the printer for three weeks. 

1l1e BEGIN and END deli miters are referred to , in MacProject jargon, as 
"mi lestones". Each b lock can be selected by bringing the pointer to rest on the 
upper edge of the rectangle (see foll owing illustration). 1l1e selection process 
results in the appearance of handles, just li ke in MacDraw. 

r a File Edit Fonts Style 

Se t Early Start... 
Se t Late Finish ... 

1l1e Task menu is then pulled down, and a Milestone command makes it possible 
to give the two delimiters a distinctive round-cornered appearance, so that they 
won't be confused with authentic blocks. 

Time is a fundamental notion in the MacProject context, and so the first thing 
we must do is to indicate to the machine what sort of time scale we're dealing with 
in the present example. Is it a matter of minutes, or rather months, or something in 
between? 

To give this information to MacProject, we pull down the Project menu and 
choose the Duration Scale command, as shown in the fo llowing illustration: 
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,. li File Edit 

We select one of the five alternatives, by clicking its radio button (see following 
illustration), and then we cl ick the OK button to get rid of the dialog box. 

,. li File Edit Fonts Chart 
, 

Pro_ject Durat ion Scole: 

0 Minutes 0 Hours 0 Days ® Weel:s 0 Months 

[ Cancel I 

We're not yet finished w ith the problems of time. (We've already pointed out that 
practically evetything in MacProject is time-based.) There's a Calendar command in 
the Project menu, and the following illustration shows the result of choosing it: 
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r • File Edit Fonts Style Tosk 
, 

18:00 

12 :00 

OK 

I f we click around on this dialog box for long enough, we end up informing the 
machine- as indicated in the preceding illustration - that the author intends to 
start work on Januaty 26, and that he intends to spend nine hours a day in front of 
the keyboard of his word processor. (Think of that black-and-white shape on the 
left as a 24·hour clock. ) Instead of clicking the OK bu!!on, we need to click the 
word 'janua1y", at the top of the calendar, in order to move on to the next month, 
as shown in the fo llowing illustration: 

r • File Edit fonts S 
, 

0 :00 

18:00 

12 .00 

OK 
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llere the author has indicated his intention ro work for 21 days during the month 
of February. (Notice that Macintosh is smart enough to know that there are 29 clays 
in February 1984.) 

Click the upwarcls-poinring little arrow to reach the next month, and so on. 
(Unless you have particular reasons for supposing that things never tum out as 
planned, don't bother going any further than the end of April. Simply click the OK 
to escape from the calendar.) 

We at last reach the point at which we can tell the machine something about 
Ihc five phases of our project. Let's use precise MacProject terminology. The thing 
that we've been calling a "block diagram" is referred to more precisely as the 
Scbedule Cbart, and our five major "blocks" are called tasks. 

We can start out by selecting the first task in the Schedule Chan , named 
/VIANUSCRJPT (see following illustration), and then pulling down the Task menu 
and choosing the Show Task Data command. 

Milestone 3C 
set Early Start... 
Set late Finish ... 

., 

In fact, MacProject docs not really intend ro sbow us data concerning the 
111/ANUSCR!PT task ... because nobody has told the machine anything yet about 
any one of the five tasks. All that MacProject can "show" us is a long line of narrow 
rectangles, towards the top of the screen (see following illustration), which are 
completely empty when they are first displayed. On the comraty, it 's we who have 
to "show" MacProject what specific values we wish to find in these rectangles. 
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,. j File Edit Fonts Style Task Project Chart 
., 

_ Tosk Doto 

Wwks : . Cost : 

l11e first clement of data to be entered is the number of weeks that the 
MANUSCRiPT task is planned to lasr. We type the number 6 and then hit < Tab> to 
move to the next rectangle. In this patticular example, we don't imend to analyse 
the actual costs of the various tasks (which would be quite feasible in a bigger and 
more realistic case study), so we'll simply jump over this rectangle by means of 
another < Tab>. Finally we reach the rectangles for listing the resources required 
for this task. To simplify things, let's imagine that there's a single manpower 
resource, named \'(lil/iam, devoted to this initial task. 

\Xfe now move on to the task called FRiENDS (see following illustration). First 
it must be selected, as before, and then the empty rectangles must be retrieved 
using a Show Task Data command. 

l11e time, in this case, is one week, and the names of four manpower 
resources - Neil, Bruno, Cbristopbe and Alain - are memionecl. 
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r • File Edit Fonts Style Task Project Chart 

=o Task Data 

Weeks: Cost : ResourcE's: 

I I I ' NEIL I BRUNO I CHRISTOPHE I ALAIN 

Next, we move clown ro the task called EDTTOR, for which we indicate a rime of 
two weeks and a single manpower resource, named Giles, as shown in the 
following illustration: 

r li File Edit Fonts Style T11sk Project Chart 

: 0 Task Dota 
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It is important to realize thar the two tasks - FRiENDS and EDrTOR- are thought 
of as starting simultaneously, whereas EDITOR is planned to continue for one 
week longer than FRJEIVDS 

A5 we have already po inted o ut, it is p lanned that the task named 
CORRECTIONS (see fo llowing illustration) sho uld nor stan before both the 
preceding tasks are terminated . This means thar the task called FRiENDS represents 
a special case in this Schedule Chatt, because it alone could be executed up ro a 
week late, and that sti ll wouldn 't provoke any overall delay in the p lanned global 
schedule. In other words, the path that leads through the task FRIENDS is nor as 
critical (to use the jargon of this branch of computer modeling) as the path 
leading through the task EDrTOR. 

r • File Edit Fonts Style Task Project Char t 

1l0 Task Dot e 

Weeks : Cost : Resources : 

I WILLIAM I APPLE II• 

CORRECT IONS t;-• ----1 

Finally we reach the PUBUCATION task (see following illustrat ion). It is p lanned to 
last three weeks, and to call upon a large publishi ng ho use and a printer as its 
principal resources. 
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Notice that we have pulled clown the Task menu and chosen a Show Schedule 
command. 

TI1e MacProject enrity kno~n as a scbedule is simply a d ialog box, as shown in 
the follmving illustration: 

,.. • File Edit Fonts Style 
., 

Display Aboue Task: 

O None @ Early Start 0 Early Finish 

Di sp lay Below Tas": 

@ None 0 l at e Start 0 l ate Finish 
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l11e three upper phone buttons concern the presence (or absence) of an 
indication to the top of the rectangles representing the tasks, and the three lower 
buttons concern things you might l ike to display underneath the task rectangles. 

f our notions are involved, and you can gnlsp them intuitively by imagining, 
say, your arrival at the office in the morning, and your departure in the afternoon, 
as follows: 

ES (Early Start): l11e earliest t ime you could arrive in the morning and hope to 
be let in the door to stan work. 
EF (Early Finish): 111e earliest time you could hope to leave in the afternoon 
afrer having completed your clay's \vork. 
/S(U!te Start): 1l1e latest time you could arrive in the morning and still be able 
to envisage the possibility of completing a full clay's work. 
LF ( ll tte Finish): 1l1e latest time you could be obliged to stay in order to 
complete a full clay's work. 

We have chosen to ind icate the ESclate above the rectangles, but nothing else. l11e 
result is as follow·s: 

Churl 

In other words, if all the collaborators work as planned, the author should start 
to write his manuscript on January 26, and the book should be on sale by April 19. 

l11ere is a Chart menu (see following illustration) that introduces several 
interesting overall viewpoints on MacProject features. 



DEMONS1TIATION 225 

,.. • File Edit Fonts S 

l11e Resource Chart, for example, provides us with a bar-chart indicating the exact 
periods when the various resources of the model are being exploited. Since this 
bar-chart is too big to fit on the Macintosh screen all at one time, you have the 
opportunity of scrolling through it A little piece of this chart, concerning the first 
two months of the project, is shown in the following illustration: 

,.. • file Edit fonts Style Toslc Project Chart 
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For MacProject users who are interested in costing out the various tasks, the 
options of the Chart menu called Resource Costs and cash Flow could be of great 
service. 

Conclusions on MacProject 

Two distinguished American cnttcs who reviewed Lisa several months ago 
described UsaProject - the ancestor of MacProject - as "perhaps the most 
fascinating of the software packages included with 1he Lisa" (Roger Wagner & j oe 
Holt, Sojtalk, September 1983). It's tempting to follow their example - were it not 
for marvelous MacPaint! - and to declare that MacProject is in many ways one of 
the most sophisticated kinds of software that has ever found its way into the 
personal computing world up until now. It might be said that the illustrious 
cousins named MacWrite and Multiplan "merely" manipulate, respectively, such 
entities as words and numbers, whereas MacProject and its likely descendants 
seem all geared to tackle the manipulation (?) of real-life affairs such as the 
construction of cities and cathedrals and computers .... 

Let's refrain from hyperbole, and conclude on a realistic note. MacProject can 
already perform in a useful manner at the following three levels: 

For a simple project involving mere a posteriori bookkeeping (concerning 
events that have already taken place), MacProject could be a handy 
documentation tool. 

2 MacProject can handle many "What if ... ?" situations and questions just as well 
as Multiplan. One might simulate and study, for example, the possible 
consequences of an exceptional time delay at some strategic poim in a 
fot1hcoming project. 

3 In the case of a complex real-life project, this tool cou ld be used in its original 
role as an instrument for critical patb cmalysis. Th is term, "critical path", can be 
applied to any phase of a project in which the slightest delay would 
automatically affect the outcome, time\vise, of the global project. 

For these three reasons, MacProject must be considered as an interesting product 
in the present Macintosh catalog, and as a likely 1aste of things to come .... 
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We have examined six application tools, four of which - MacWrite, MacPaint, 
MacDraw and MacProject - are proposed by Apple Computer, whereas the orher 
two ~ Microsoft Multiplan and Chatt - have been created by a software company. 
These six products make up a pretty solid basis on which to stan out using 
Macintosh as a productivity tool. But the story doesn't end there, because a great 
many software developers throughout the world are actively engaged in the 
creation of Macintosh products in many domains. 

As far as Apple Computer itself is concerned, there is another majo r software 
tool for Macintosh: MacTerminal, which enables Macintosh to emulate IBM, DEC 
and TTY terminals. 

Besides Multiplan and Chan, the 1vlicrosoft Corporation is offering Macintosh 
versions of their record-keeping product called File and their word processing 
~ystem called ~'(lord 

The Software Publishing Corporation is implementing the entire range of their 
well -known Pfs too ls on Macintosh: Pjs: File for file management, Pjs: Repor t for 
printing repons, Pfs: Write fo r word processing, and Pfs: Graph for graphics. 

l11e Lotus Development Corporation is creating a Macimosh version of their 
best-selling 1·2·3 program. 

And many other sofhvare companies and independent developers are working 
on Macimosh products that are destined to reach the market in the course of 
"Macintosh Year": 1984. 

Apple Computer, in any case, has been investing heavily in its re lationships 
with third-party software developers, and encouraging them by every means to 
create products for the new machine. l11is is understandable in the sense that - as 
the chairman of the board, Steve jobs, puts it - "Apple's future is all Macintosh". 
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Software Development Using Lisa 

Programs for most microcomputers, up until now, have been written using the 
same machine on which they are intended to be run. But this familiar method of 
software development - which appears to be almost "natural" - can create 
problems at times. After all , it's a bit like attempting to build a kitchen table in the 
kitchen itself, while using the half-built table as a workbench; it's theoretically 
possible, but things would be ever so much easier if the builder had a workshop 
and a proper set of tools for the job, including a good solid workbench. 

Most professional software designers are accustomed to the method that 
consists of using a "big" computer to develop programs for a "little" machine. 
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Microsoft, for example, used a DEC PDP-1 ·1 to develop software fo r the Apple I L ~ 
The advantages of the method are obvious: the relatively powerfu l faci lities of the ~ 
development machine serve as a sort of metalanguage enabling the software 
designer to freely manipulate the language of the target machine. 

In the case of the target machine called Macintosh, the perfect development 
machine is Lisa 2 

Development context 
Usa 2 - announced by Apple Computer on exactly the same day as Macintosh - is 
an improved version of Usa, the revolutionary machine that had been on the 
market for about a year. 111e most striking change is that Lisa's two (5',1.;") disk 
drives have been replaced, on ljsa 2, by a single drive that accepts the Sony (312") 

disks used by Macintosh. 
The basic model of Lisa 2 has a main memmy of 512K, and its only d isk 

device is the above-mentioned Sony drive. But a more powerful model, called Lisa 
2/5, is required for the development of Macintosh software. Usa 2/ 5 differs from 
the basic model in that it has an external Profile disk drive with a capacity of SM. 
To develop Macintosh programs on this Lisa 2/ 5, you also have to purchase a kit 
that eA'lends its main memory to 1M, and it's not a bad idea to have a second 
Profile. This means that we are speaking of a development machine that costs over 
three or four times as much as the target machine. 

To write programs fo r Macintosh, using Usa 2/ 5, you can usc either Pascal or 
assembly language, or both. Not only can assembly language routines be nested 
inside Pascal modules; inversely, too, Pascal routines can be called by assembly 
language modules. 

Usa Pascal is quite close to - but more powerful than - the language 
defined by Kathleen Jensen and Niklaus Wirth in the Pascal User Manual and 
Report (2nd edition), Springer-Verlag. l11e precise specifications of the Usa version 
of Pascal are provided in an Apple document entit led Pascal Reference Manual f or 
the Lisa. Assembly language programmers can obtain information on the machine 
instructions of the MC68000 processor in the book by I.ance A Leventhal entitled 
68000 Assembly Language Programming, Osborne/ McGraw-Hill, o r in the smaller 
68000 Microprocessor Handbook by Gerry Kane, at the same publishing house. 

In order to simplify the presentation of this subject, the only development 
language that will be mentioned in the rest of this appendix is Pascal. But it must 
be remembered that there is an assembly-language version of every aspect of 
Macintosh softwa re development on Usa 2/ 5. 

The actual program development activities - such as editing, compiling, 
assembling, linking and debugging - are carried out on the Lisa 2/ 5 in an 
environment called the Workshop, which is a set of tools booted from the ProFile. 
A complete description of the functions of this development environment is 
provided in an Apple document entitled Workshop User's Guide f or the Lisa. 

The Macintosh program that is being developed can be tmnsferred 
periodically from lisa 2/ 5 to the target machine, by means of a cable, in order to 
be run and tested. 
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Pascal particularities 

An experienced Pascal programmer should be able to use Usa Pascal, to create 
Macintosh software, with no particular difficulties. 

It's necessaty to introduce a few technical remarks here concerning the 
machine itself. The memory of Macintosh is made up of t\vo parts: a 128K random
access m emory (RANI), which will almost certainly be upgraded to 512K as soon as 
suitable chips become commercially available in large quantities and at a 
reasonable cost; and a 64K read-only memory (ROM). The tightly-coded 
information written into this huge chunk of ROM, during the manufaclllring 
process, constitutes one of the major assets of Macintosh. One third of it 
constitutes part o f the Macintosh operating system; another third, called 
QuickDraw, is a set of graphic routines which provide the basis of all the screen 
display activity of Macintosh; and the final third, referred to as the Toolbox, is a 
library of management routines used by software developers to take care of all the 
sophisticated features that you find in top-quality applications such as Mac\flrite 
and MacPaint. 

As far as the programmer is concerned, these ROM routines - which are 
divided into fifteen units ( in the Pascal sense of the term) - constitute a stock of 
466 procedures and functions whose identifiers can be used in Usa Pascal 
programs. 

TI1e voluminous documentation for developers, entitled Inside Macintosh, 
provides a complete semantic and syntactic description of each of these 
procedures and functions, together with the definitions of various predefined 
Pascal types and constants that can be used by the programmer. 

There is, however, one particular subject - dynamic storage allocation -
that may appear a little strange to some programmers, since Usa Pascal introduces 
several concepts that are not present in the conventional language. 

Dynamic variables and pointers exist already in standard Pascal, where they 
are used above all for building up sets o f linked cells for list processing. But Usa 
Pascal goes one step further, and introduces the notion of so·called handles, which 
are in fact po inters that point to ... other pointers! 

Why are such complicated entities necessary? l11e answer can be found in the 
section of the documentation that deals with an impmtant part of the Macintosh 
operating system, housed in the ROM, known as the Memory Manager. 

In Lisa Pascal termino logy, storage is allocated to dynamic variables in a 
region of main memory referred to as the heap, which is a collection of contiguous 
variable-length blocks, each of which - at any particular instant during the 
execution of a program - is e ither allocated or free. Whenever a block is freed, a 
"hole" appears in the heap. Now, since many of d1e blocks are relocatable ( i.e., the 
information they contain remains meaningful, no matter where mey are located in 
the heap), the Memory Manager can use housekeeping procedures to shift them 
around in the heap, in order to "gather together the ho les" and to utilize d1is freed 
space as efficiently as possible. 
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In view of this consranr reshuffling of the relocatable variables in th e heap, 
Usa Pascal had to offer the programmer a conven ient device for pinning down the 
exact address of such-and-such a dynamic variable at any particular instant. TI1e 
solution works as follows, using a method that is referred to in the documentation 
as double indirection Whenever the Memo!)' Manager allocates relocatable heap 
storage to a dynamic variable, it creates a masterpoinlerthat represents the current 
address of the variable in the heap. Evety time that the variable changes its location 
in the heap, because o f housekeeping aCi ivities, the Memo!)' Manager corrects the 
master pointer. Now, all rhat the programmer has to do is to keep in touch with 
this master pointer, and this is done by using a pointer - the so-called "handle" 
- that points at the master pointer. 

Once you've gotten the hang of this method of indirect addressing -which is 
not nearly as complicated as it appears to be, at first sight -you no longer need to 
wony about memo!)' management, and the rest of the job of Macintosh software 
development is just plain Pascal programming. · 

QuickDraw 

TI1e Macintosh designers did not waste any time looking around for a novel 
approach to graphics; they simply "borrowed" - lock, stock and barrel - the 
splendid QuickDraw package rhat a member of the team, Bill Atkinson, had 
created earl ier on for Usa. Complete details of QuickDraw are contained in an 
appendix attached to the above-mentioned Usa Pascal reference manual. 

Insofar as ·everything that appears on the Macintosh screen, including text, 
must be thought of, in the final analysis, as grapbic material, it is easy to 
understand why QuickDraw plays such a fundamental role in the Usa/ Macintosh 
context. In fact, it's hardly an exaggeration to describe the MacPainl and MacDraw 
tools as mere " implementations" of QuickDraw. 

By means of QuickDraw, the Macintosh screen can be organized into a 
number of individual areas, and various graphic objects can be drawn inside each 
area, as shown in the fo llowing illustrat ion: 
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QuickDraw operates within the framework ofa two-dimensional grid that provides 
the background for three mathematical constructs: points, 1'ectangles and t·egions. 
For each construct, QuickDraw proposes a Pascal type. 111e Point type is defined in 
terms of integer coordinates, and the Rect type in te rms of points, while the Region 
type is defined as one or several arbitrarily-shaped areas lying within the bounds of 
a recwngle. 

Next, QuickDraw introduces the notion of a bit image, which is simply a 
contiguous set of words in main storage, conceptualized as a matrix in a row-wise 
sense (with the lowest byte in storage being associated with the upper left corner 
of the matrix). A bit map is a triad - giving rise to another Pascal type -
composed of a pointer to a particular bit image, an integer that provides the row 
length of that bit image, and a bounda~y recwngle that fixes its height. The next 
QuickDraw graphic entity is the pattem, an 8-by-8-bit recwngle which is used to 
defin e a repeating design. Finally, QuickDraw describes a graphic entity referred to 
as the cursor . . . which is simply our familiar Macintosh pointer, viewed as a 
16-by-16-bit rectangle and defined in precise terms as a Pascal type. 

At this stage, QuickDraw introduces a fundamental record type called 
GrajPort, incorporating no less than 25 fi e lds, which specifies a complete drawing 
environment. The best way of approaching GrafPorts is to imagine that there is one 
such entity for evety window that might be opened onto the desktop. Two 
impottant subsets of the GrafPOJt fields specify, respectively, the pen characteristics 
for drawing, and the text characteristics for clara of keyboard o rigin. 

l11e basic concepts of QuickDraw are completed by the Picture type, used for 
handling "elastic" images that may be stretched or shrunk in order to fit into 
various rectangular "picture fram es", and the Polygon type, representing a set of 
connected po ints inside a recwngular boundruy. 

All three primitive shape constructs in QuickDraw - regions, p ictures and 
polygons - give rise to dynamically-allocated storage, and must be accessed 
through handles. 

On these foundations, the QuickDraw package then "explodes" into an 
amazing assortment of 145 Pascal procedures and functions, which belong to the 
following nineteen categories: 

GrafPott routines ( 15) 
Cursor-handling routines (5) 
Pen and line-drawing routines (13) 
Text-drawing routines (12) 
Drawing in "color" (3) 
Calculations with recwngles ( 10) 
Graphic operations on rectangles (5) 
Graphic operations on ovals (5) 
Graphic operations on rounded-corner rectangles (5) 
Graphic operations on arcs and wedges (5) 
Calculations with regions ( 18) 
Graphic operations on regions (5) 
Bit transfer operations (2) 
Pictures (5) 
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Calculations with polygons ( 4) 
Graphic operations on polygons (5) 
Calculations with points (6) 
Miscellaneous utilities (8) 
Customizing QuickDraw operations (14). 

Toolbox 
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Of the 466 routines in the Macintosh ROM that can be invoked by Pascal or 
assembly language programs, 216 belong to what is called the Toolbox, which can 
be broken down into the following eleven modules (presented in alphabetical 
order): 

1 Control Manager (26) In Macintosh terminology, controls are special objects 
on the screen that you can manipulate using the mouse. One typical example 
is the scroll bar that is used to change the contents o f an active window. 
Another example is provided by the various buttons and check boxes that you 
encounter inside dialog boxes. Evety control is associated with a specific 
window. Since storage space for relocatable control records is allocated from 
the heap, they are refetTed to by means of a control handle. 

2 Desk Manager ( 4) These routines enable your software to support the desk 
accessories: Note Pad, Scrapbook, Calculator, Clock, Puzzle. l11ey can be 
described as "mini-applications" that can be run concun·ently with any Nlacintosh 
application. 

3 Dialog Manager (22) In Macintosh terminology, a dialog box is a rectangle that 
appears on the desktop whenever the machine needs ro communicate with the 
user in order to obtain essential information. To minimize the effort required 
on the part of the user, Macintosh usually expects you to simply click some of 
the buttons and/ or check boxes in the dialog box. Quite often there's an OK 
button to let Macintosh know that your reply is ready. 

4 Event Manager (11) Whenever you perform the slightest act - such as 
touching the mouse, typing something on the keyboard, or inserting a disk into 
the drive - Macintosh thinks of it as an evem. So, these routines actually 
manage the man/ machine relationship, constantly, at the most primordial level. 

5 Font Manager (5) Software developers can use these routines to gain access to 
the same variety of typographical fonts that you encounter in Mac\Xfrite. 

6 Menu Manager (32). One of the nicest things about Nlacintosh, compared with 
most other personal computers, is the fact that you can browse through all the 
menus simply by dragging the mouse along the menu bar at the rop of the 
screen, with no obligation to select anything at all. TI1e entire menu setup is 
simple and elegant, with its dimmed and check-marked items, its highlighting, 
etc. TI1is quite large collection of routines allows the software developer to 
make use of all these user-friendly features. 

7 l?esol/rce Manager (26) In Macintosh terminology, a resource might be 
defined, rather negatively, as something that is nor imimately related to the 
application being run, even though its presence is necessaty. TI1e message in a 
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dialog box, for example, might be in English, or French, or Spanish .... All 
these elements o f secondary information can be placed in modifiable resource 
files. n wre are over twenty standard resource types (menus, icons, fonts, 
pointers, etc.), \Vithout counting those that might be invented by you yourself, 
within the context of a specific application. 

8 Scrap Manager (6) TI1e cur & paste concept, which is fundamental in the 
Macimosh context, makes constant use of a device - associated with the 
desktop, and common to eve!)' application - called the Clipboard. Software 
developers can of course build private cut & paste techniques into their 
applicat ions, but the routines in this manager allow them to also use the 
Clipboard. 

9 TextEdit (21) TI1is is a set of clara types and routines for text formatting and 
edit ing. TI1ey can be insetted in Macimosh application programs whenever it's 
a matter of entering information from the keyboard. 

10 Window Manager ( 42) Windows, in the Macintosh context, are the basic outlet 
by means of which the machine transmits information to the user. TI1ey can be 
moved across the desktop, overlapped, reduced in size, expanded, hidden; 
activated, deactivated, ere. TI1is big set of routines makes it easy for software 
developers to manipulate Macintosh windows. 

11 Toolbox Utilities (21) To use the Toolbox routines, many manipulations on 
numbers and strings must be carried out. TI1ese routines make it possible to 
perform such tasks in an optimal manner. 

Besides having to understand the semantics and syntax of all these procedures and 
functions, the software developer is expeCled to respect various conventions, so 
that all Macintosh application programs " look alike" ( to a cettain extent, at least) 
to the end user. There is no obligation to do so, of course, but i t is to evetybody's 
advantage if things turn out this way. Take the case o f the I-beam pointer, for 
example. Because of MacWirite, we have all become accustomed to the use of this 
pointer whenever text is being entered from the keyboard. Now, nothing prevents 
a software developer from using a different style of pointer in such a situation, or 
from using the 1-beam po inter for a quite cli fferem purpose, but this would be 
regrettable. 

One of the fundamental tenets of the Macintosh philosophy - as it was 
pointed out already at the beginning of this book - is that the user should get w 
know how to manipulate the machine through, say, /viae Write and MacPaint, and 
that all other applications should then appear ro the user as "second nature". 

Macintosh operating system 

Besides QuickDraw and the Toolbox, the 64K Macintosh ROM contains pan of the 
operating system. And this, roo, can be accessed to a certain extent by software 
developers. 

l11ere are 105 operating system procedures and functions which are accessible 
by Pascal or assembly language programs. TI1ey can be broken clown into the 
following four modules: 
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1 Memory Manager (36) These routines control the dynamic allocation of 
mem01y space in the heap. Insofar as the norions of pointers and handles are 
widely used in the context of Macintosh software development, this module 
will be frequently invoked. 

2 Segment Loader ( 4) Using these routines, you can divide the code of an 
application into several parts, called segments. The Finder statts an application 
by asking this module to load the main segment into memory. Further 
segments are loaded automatically when needed, and storage containing an 
unwanted segmenr can be freed by the programmer. 

3 File Manager (53) This big set of procedures and functions deals with the 
imponant question of disk fil es. There are three ways of handling file I/ O on 
Macintosh: (a) higher-level Pascal calls provide you w ith simplified facilities 
that are sufficient in many cases; (b) lower-level Pascal calls enable you to use 
the File Manager to its fLiilest capacity, but they are more difficult in handle; 
and (c) assembly language calls resemble lower-level Pascal calls. 

4 Print Manager ( 1 2) These routines enable the programmer to specify the exact 
manner in which information is to be sent to the printer attached to Macintosh. 

The concept of software components 
Back in 1969, a computer specialist named M. D. Mcilroy made the following 
precurso1y statement: ''I \vouldlike to see components become a dignified branch 
of software engineering. I "·ouldlike to see standard catalogs of routines ... ·· 

TI1e basic idea behind this remark - which was taken up, much later on, by 
the creators o f the Ada programming language - is that we have long been 
accustomed to hardu·are components (such as those that you · find today on the 
circu it boards of a microcomputer); so, why shouldn't we be able to adopt the 
same building-block strategy in the sojtlt'are domain? 

This is exactly what has happened as far as Macintosh is concerned. Those 466 
procedures and functions housed in the Macintosh ROM provide a real and perfect 
example of software building-blocks with which the developer can construct all 
sons of new and unusual applicat ions. 

Imagine, for a moment, a Macintosh without any of these ROM-based routines. 
And imagine that you intend to use this emasculated machine, programmable in 
68000 assembly language, in order to develop, say, a graphic design package like 
MacPaint. What a gigantic job! And what a global waste of time and energy i f every 
present and future software developer were obliged to cany on " reinventing the 
wheel" with respect to such everyday things as menus, windows, scrolling, text 
editing, graphics, etc. 

Thankfully, in the case of Macintosh, the long-awaited concept of software 
components has finally been brought to fruition. All this tightly-coded ROM-based 
"MacWare" puts the software developer face-to- face w ith the o ldtime depanment 
store slogan: "You name it. We've got it." 
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Software Development Using 
Macintosh 

l11ere are quite a few language systems - either existent or imminent - that 
enable you to develop software on the Macintosh itself: Macintosh Pascal, 
Macintosh Basic, logo, Pro log, Usp, F01th or even 68000 assembly language . ... 

The one that we have decided to present in this ftnal append ix is a 
surprisingly powerful interpreted language called lVlicrosoft Basic. Admitted ly, it 
can't produce q uite the same effects as if you had a Usa 2/ 5, and you worked in 
Usa Pascal a long the lines described in the preceding appendix. But almost. ... 

Demonstration 
Let us srarr o ut with the excellent demonstration program on the Microsoft Basic 
startup disk, "MS Basic", whose d irectory is shown in the following illustration: 

r • File Edit Uiew Special 
., 
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The icons with a hand are directly related to Microsoft Basic: "Basic" is the 
interpreter itself, whereas "Sphere" is the demonsu·ation program that we are about 
to examine. "Modules", of course, is the fami liar fo lder holding six elements of 
system software. 

Double·click the "Basic" icon to get started. l11e result is an uninteresting pair 
of blank windows labeled "Untitl ed" and "Command". Pull down the Fi le menu 
and choose the Open command. l11ings start to liven up: a dialog box asks us for a 
filename. We answer "Sphere" and click the OK button. Now we're greeted with an 
uninteresting pair of blank w indows labeled "Sphere" and "Command". This time 
we pull down the Control menu (see foll owing illustration) and choose the Run 
command, which means that we want to start th e execution of the "Sphere" 
program. 

,. • File Edit 
., 

Stop 3eC Sphere 
[ ontitHIP 
suspend 3eS 
List 

Troce On ~ 

·rrnce on 

-~- . - -- - LOffimuuu 

II 
I ICJJ 

The result - a skeletal wh ite sphere on a black sq uare background - is shown in 
the following illustration: 
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,. • File Edit Control 
., 

If we move the pointer to some other place on the "Sphere" window (see 
following illustration) and cl ick the mouse burron, the picture instantly reappears 
there. Alternatively, we can drag the picture around on the window. 

Notice that the image is displayed only within the bounds of the output 
window entitled "Sphere". I f you drag the image across the boundaries of this 
window, the pan outside the window is no longer visible. 

,. • File Edit Control 
., 

- -.;:::;...._--::---:"==:-:-_~ """;; -~=-=-=·-=---~....:--=-- ------· - -- - -- ----
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Since the "Sphere" window has a size box, we can enlarge the area of the window 
to cover the enrire screen, as shown in the following illustration: 

,. • file Edit Control 
., 

Sphere 

This demonstration program proves at least rwo things concerning Microsoft Basic. 
First, it is obvious that high·quality graphics can be obtained through this language. 
And second, it appears that the language can handle mouse input. 

But let us interrupt the demonstration by pulling clown the Control menu and 
choosing the Stop command, as shown in the following illustration: 

,. • file Edit 

suspend :~~:s 

l. l~t 

Run 
Troce on 
Trnee Off 
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TI1e program stops, as expected , and a message in the output window informs us 
(see following illustration) that a break has been introduced in the program at 
instruction no. 150. 

,. • File Edit Control 
, 

Sphere 
Break in 150 

~ 

Commond 

Nmice that the empty window labeled "Command" has reappeared at the bottom 
of the screen, and that it is in fact the active window on the desktop. 

It's time to take a look at the Basic program behind all that. Pull down the 
Control menu and choose d1e list command, as shovm below: 

, 
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The following illustration shows the first eleven lines of the program, which appear 
in a window entitled "Ust": 

,. • File Edit Control 

Break in 150 
LIST 

Sphere 

100 DliFINT A-Z 
110 DIM A(1025) 
120 GOSUB 220 
130 GIIT(0,0)-(127, 127),A 
140 x-o: Y· O 
150 IF MOUS!i(O)·O THEN 150 
160 IF ABS(X-MOUSE( I)) > 2 GOTO 180 
170 IF ABS(Y -MOUSE(2)) < 3 THEN !50 
180 PUT(X,Y),A 
190 XzMOUSE( 1): YzMOUSE(2) 

PUT(X,Y),A 

Command 

Notice that the command "LIST' has been displayed in the output w indow. 

., 

Click the descending atTO\V in the venical scroll bar ro move towards the end of 
the program. The final ten lines of this shott program are shown below: 

,. • File Edit Control 

Break in 150 
LIST 

Sphere 

0 GOTO 150 
0 REM Draw Picture 

CLS 
LINE(O,O)-( 120, 12 0),,BF 
ASPECT• • . I 
WHILE ASPECT•<20 

CIRCLE(60,60),50,30 .. ,ASPECT• 
80 ASPECT• • ASPECT•* 1.4 
90 WEND 

RETURN 

., 
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No doubt the most surprising aspect of this demonstration is the fact that a Basic 
program of 21 lines can do so much! 

Let us now take a look at the procedure for modifying the program. In fact we 
shall change two statements in the program: lines 240 and 270. 

Place the po inter anywhere on top of the statement in line 240 (see following 
illustration) and click the mouse burton. 

r a File Edit Control 

Break in 150 
LIST 

240 LINE(O,O)- ( 120, 120).,8 

Sphere 

10 GOTO 150 
20 REM Draw Picture 
30 CLS 
40 LINE(O,O)-( 120,~20),.BF 
50 ASPECT•" . 1 
60 WHILE ASPECT•<20 
70 CIRCLE(60,60).50.30 .. .ASPECT• 
00 ASPECT• .. ASPECT• * 1.4 
90 WEND 

RETURN 

Comm11nd 
----~ --- --

~---=-------=..:..::.--=--=-:-:---=--:-~ 

., 

l11e selected line reappe-ars instant ly in the active Command window, with a 
blinking venical bar just after the last character to indicate the insertion point. 

The mcx:lificat ion that we wam ro carry our on this line is very simple. Instead 
of the BF option o f the Une statement (Box rill , \vhich places the image on a b lack 
background), we want to have 8 (Box, which gi,·es rise to a white background ). 
So, we hit < Backspace> once, and then < Return> to tell the machine that our 
editing operation is completed. 1111'ee things then happen simultaneously (see 
following illustration): the modifi ed line is sent back ro irs context in the List 
window, it is also displayed in the output \Vinclow, and the Command window is 
blanked. 
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r 4i File Edit Control 

Break in 150 
LIST 
240 LINE(0,0)-(120,120),,8 

Sphere 

10 GOTO 150 
20 REM Draw Picture 
30 CLS 
40 LINE(O,O)-( 120, 120),,BIIo.. 
50 ASPECT• = . I "t 

60 WHILE ASPECT•<20 
70 CIRCLE(60,60),50,30 ... ASPECT• 
80 ASPECT• = ASPECT•* 1.4 
90 WEND 

0 RETURN 

Commond 
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Next we want to modify line 270. First, you have to move the pointer onto the Ust 
window and click the mouse button, to make the w indow active. Then you can 
select the pan of the program to be modified by placing the pointer somewhere 
on top of line 270 and clicking the mouse burton. Une 270 is immediately 
displayed in the active Command window, as shown in the following illustration: 

0 GOTO 150 
0 REM Draw Picture 

30 CLS 
40 LINE(0,0)-(120, 120),,B 
50 ASPECT• = .1 

WHILE ASPECT•<20 
70 CIRCLE(60,60),50,30..,ASPECT• 
80 ASPECT• = ASPECT•* 1.4 
90 WEND 

RETURN 
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\Vhat we v.l(lnt to do this rime is ro replace the numbers 50,30 in the statement by 
40,33. (l11e first number indicates the radius of the ellipse to be drawn. The 
second number represents the color of the drawn circles: 30 for white, 33 for 
black.) 

First, you drag the pointer across rhe numbers 50,30 in the Command 
window, to select them. They are immediately highlighted in black. l11en you pull 
down the Edit menu and choose the Cur command. Finally you type the numbers 
40,33 and hit < Return> to let the machine know that the entire modification has 
been completed. 

The desktop then appears as shown in the following illustration: 

r • File Edit Control 

Break in ISO 
LIST 
240 LINE(0,0)-{120, 120),,8 
270 CIRCLE(60,60),40, 

Sphere 

10 GOTO 150 
20 REM Draw Picture 
30CLS 
40 LINE(0,0)-( 120, 12 0)..B 
50 ASPECT• • . I 
60 WHILE ASPECT•<20 
70 CIRCLE(60,60),40,33 .. .ASPECT";._ 
80 ASPECT• • ASPECT•* 1.4 ~ 

90 WEND 
0 RETURN 

i. 

Command 

, 

If you now pull clown the Control menu and choose the Run command, the 
following result is obtained: 



DEMONSTRATION 

r • File Edit Control 

1=---- -: ___ - ---=- ~ :______::-__::._- - - -~--= Sphere 
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:;. _____ -: ____ -·-------=--------· ---.=:~-----------

• 
This demonstration is sufficient to po int out the way in which /v!icrosoft Basic 
works, and the interplay between the three windows. Let us now take a brief look 
at the language itself. 
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line-by-line description of the demonstration 

program 

A11PENDIX 0 

100 Eve1y variable whose name starts with a letter from A to Z is considered to 
be of integer type. 

110 TI1e A variable is a one-dimensional array w ith a ma.ximum of 1026 
elements. (TI1e low value of the subscript is zero.) 

120 Execute the subroutine thar starts at line 220. 

130 Screen GET statement: a special feature of the Macintosh version of 
Microsoft Basic. The A array receives the set of bits defining the square 
image whose upper left corner is located at the position (0 ,0) of the 
window, and whose lower right corner is located at ('127,127). To stock 
all the bits between the positions (Xl ,Yl) and (X2 ,Y2) . the number of 
b~tes required is given by the following formula: 

4 + (Y2- Y1 + 1) * 2 • T\T((X2 - Xl + 16) / 16) 

'vhere the INT function returns the largest integer that is equal to or less 
than the argument of the function. In the present case, the formula gives a 
result of 2052. Since each element of an integer array can stock two b~es, 
the A array must therefore be composed of 1026 clements. 

140 Initialize the X andY integers. 

150 Repeat this line nonstop until the user presses the mouse button. 

160 If the mouse has caused the pointer to be moved at least three points in a 
horizontal direction, then jump to line 180. 

170 If the mouse has caused the pointer to be moved at least three points in a 
venical direction, then proceed to line 180; orhe!Wise, return to line 150. 

180 Screen PUT statement: a special feature of the Macintosh version of 
Microsoft Basic. Erase the image at its current location. 

190 Update the values of the X and Y coordinates. 

200 Screen PuT statement: a special feature of the Macintosh version of 
Microsoft Basic. The A array gives rise to an image whose upper left 
corner is located at the spot on the screen specified by the X and Y 
coordinates. 

210 Return to line 150. 

220 Remark (REM): Draw Picture. First line of the subroutine. 

230 Clear the complete window. 
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240 LINE stat ement: a special feature of the Macintosh version of Microsoft 
Basic. Display a square between the points (0 ,0) and ( 120,120). The BF 
option means that the square will be filled with black. 

250 Because of the final # character. ASPECT# is recognized as the name of a 
double-precision numeric variable. ll1is variable is set to 0.1. 

260 Stan of a loop. As long as the variable ASPECT# remains less than 20, 
repeat lines 270 and 280. 

270 CIRCLE statement: a special feature of the Macintosh version of Microsoft 
Basic. Draw a white ell ipse (parameter 30), with a radius of 50, whose 
center is located at the position (60,60) . ll1e ASPECT# parameter 
indicates the relationship - referred to as the a:.pect ratio - between 
the height and the width of the ellip e. As long as this ratio remains less 
than 1, it's the horizontal radius that is indicated in the statement ; if the 
ratio is greater than 1, then it 's the venical radius that is indicated. 

280 Increase the aspect ratio. 

290 End of the \VI-II IE loop that starred ar l ine 260. 

300 End of the subroutine that started at line 220. 

Note: Readers of this description of the demonstrat ion program will have 
understood that the image that we have been calling a "sphere" is in fact a set of 
16 ellipses, 7 of which are horizontal ( like an egg on a table), whi le the 9 others 
arc vertical (l ike an egg in an eggcup). 
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Super Basic 
If \·Ve compare this latest version o f the language with early generations, it's almost 
true ro say that the principal thing in common seems to be the name "Basic"! 

Microsoft Basic is a collection of about 140 statements, functions and 
commands. 1l1e Macintosh version is a "standard" language in the sense that the 
interpreter wilt run programs wri tten in Microsoft Basic on other computers, but it 
naturally includes certain features that do not exist Oll[Side rvtacintosh. 

There are two novel aspects of the language, above all, which deserve to be 
explained by way of an example: first, the Mouse function, and second, rhe 
possibility of explicitly cal ling 41 of rhe 145 QuickDrau• routines in the Macintosh 
ROM. 

1l1e function Mouse(n) has seven distinct mean ings, depending on the value 
of n. For example, Mouse(O) returns a value that indicates the status of the mouse 
button, whereas Mouse( l ) and Mouse(2) return respectively the current X andY 
coordinates of the poinrer. 1l1e other possibilities - Mouse(3) through to 
Mouse(6) - return the start ing and ending coordinates of drag operations. 

Look at the follov.ring example: 

,.. a File Edit Control 

Elec:tronlc wrltln 
LIST 

100 CLS 
110 IF MOUSE(O) <O THEN CALL LINETO(MOUSE( l).MOUSE(2)): GOTO 11 0 
120 CALL MOVETO(MOUSE(l).MOUSE(2)): GOTO 110 
130 END 

Commond 

., 

1l1e statement in line 100 (Clear Screen) erases the contenrs of the Oll[put window 
and sets the pen position to the upper left corner of this window. 

In the next line, the fact that Mouse(O) is negative indicates that the button is 
still being held clown. In that case, the QuickDraw procedure UneTo is invoked, in 
order to carry on drawing. 
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As soon as the mouse button is no longer being held down, the program 
jumps to line 120, where the Quick.Draw procedure MoveTo is invoked, to keep 
track of the position of the mouse. 

The outcome (see fo llowing illustration) may not be fin e att, in the truest 
sense of the term ... but it certainly proves that Microsoft Basic provides a simple 
solution for getting your Macintosh ro behave in a most interesting manner. 

,.. • File Edit Control 
... 

Electronic wrttln 

ll 

The conclusion seems to be that d1e development of marketable Macintosh 
software will no doubt be carri ed out exclusively by means o f the Usa 2/ 5 
approach described in the preced ing appendix, whereas personal tasks that 
concern only the individual Macintosh owner can probably be handled in a quire 
satisfactory manner by means of a powerful and easy·to·use language such as 
Microsoft Basic. 
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A 
accessories, desk see desk accessories 
activating a w indow 26, 34 
active w indow 25 

changing 26, 34 
highlighted 33 

alarm clock 32 
alert box 117 
alignment boxes, MacWrite 85, 94 
Apple menu 31 

Calculator 32 
Clock 32 
Note Pad 41,43 
Puzzle 4, 32 
Scrapbook 51 

application development 2, 228-249 
appl ications, specific 

Basic, Macintosh 2 
Basic, Microsoft 2, 236-249 
Chan, Microsoft 2, 202-212 
MacDraw 2, 153·173 
Mac Paint 1, 119·152 
MacProject 2, 213-226 
MacTerminal 227 
MacWrite 1, 82-118 

area fill tool, MacPaint 132 
Arrange menu, Mac Draw 160 
arrow, scro ll 30 

8 
Backspace key 79, 104 
Basic, l'v1icrosoft 2, 236-249 
beep 44 
b linking venical bar 42, 44, 84 

251 

brush, MacPaint 122 
Brush Mirrors command, MacPaim 147 
Brush Shape command, MacPaim 122 
business graphics 202 
butron, dialog box 88, 115, 1 17 

Cancel 88 
Change All , MacWrite 117 
Eject 88, 170 
Find Next, MacWrite 115 
Go Ahead, MacWrite 118 
OK 90, 142 
Save 88 

button , mouse 9 
By Icon command 22 
By Name command 22 

c 
calculations, Multiplan 178 
Calculator 32 
Calendar command, MacProject 217 
Cancel button 88 
cancel icon, Multiplan 177 
canceling 

a command 88 
a MacPaint operation 149 

Caps Lock key 151 
Cash Flo\v command, MacProject 226 
cell, Multip lan 174 

absolute address 192 
current 176 
register 176 
relative address 180 

Change All button, :VlacWrite 117 
Change command. MacWrite 116 
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changing 
active w indow 26, 34 
document name 79 
icon name 21, 68 
size of w indow 55, 62 

Chatt menu, MacProject 224 
Chatt, Microsoft 2, 202-212 
choosing a menu command 14 
Clear command 

MacDraw 165 
MacPaint 140 

cl icking 9 
Clipboard 36 
clock 4, 6, 25 
Close All command 26 
close box 20 
Close command 16 
Column Width command, Multiplan 

199 
command See also specific com mands 

canceling 88 
choosing 14 
dimmed14 
highlighted 14 

Command key 
for Edit menu commands 37 
for File menu commands 15 
for MacPainr operat ions 140 
for screen clumps and snapshots 
151 

Command-period (_) to halt printing 90 
Command-Shift-3 151 
Command -Shift-4 151 
Control menu, Microsoft Basic 237 
Copy command 37 
copying (see also cut & paste operations) 

application 77 
disk 77 
document 77 
folder 73, 78 
image 134 
Scrapbook 58, 165-171 

creating 
document 62 
snapshot 1 51 

critical path analysis 222. 226 

current cell, Multiplan 176 
cursor see pointer 
cut & paste operations 36-60 
Cut command 37 

D 

to move text 53, 102 
to remove text 49, 99 

data disk 73 

INDEX 

deleting see removing, Backspace key, 
Clear command and Cut command 
1\'lacWrite 97-104 
text in Note P·ad 48 

cleselection 69 
desk accessories 31 

Calculator 32 
Clock 4, 32 
Note Pad 41,43 
Puzzle 4, 32 
Scrapbook 51 

desktop 12, 20 
dialog box 88 
dimmed command 14, 69 
clirecto1y w indow 21 
disk 5 

copying 77 
ejecting 6, 34 
non-stattup 74 
saving work on 87 
stattup 63 
swapping 76, 171 

disk drive 5 
additional 7 

document 
closing 91 
copying 73, 77 
creating 62 
moving 64 
naming 88 
opening existing 94, 187 
organizing see housekeeping 
priming 89, 146 
removing 10 
renaming 79 
saving 87 
untitled 84 
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Dossier folder 21, 63 
double clicking 9 

in MacPaint 122, 129, 142, 144, 146 
to open icon 27, 62, 65,83 

dragging 9 
icon 10 
scroll box 30 
size box 28 
through a menu 14 
title bar 27 
to select 48 
window 27 

Drawing Size command 
MacDraw 164 
MacProject 214 

drive, disk see disk drive 
Duplicate command 15, 77 
Duration Scale command, MacProject 
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dynamic storage allocation, Usa Pascal 230 

E 
Edit menu 37 

Clear command 140, 165 
Copy command 37, 40, 59, 134, 168 
Cur command 37, 49, 53, 99, 102 
Paste command 84, 97, 54, 103, 134 
Select All command 166 
Show Clipboard 37 
Undo command 149 

editing text 45 
Edit Pattern command, MacPaint 131 
Eject button 88, 170 
Ejecr command15, 34 
ejecting a disk, problems with 6 
e llipse 

MacDraw 158 
MacPaim 128 

Empty Folder 21 (see also Dossie r folder) 
duplicating 79 

Empty Trash command 19 
enlargement & reduction, MacDraw 164 
Enter key7 
eraser, MacPaint 122 
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erasing see removing, Backspace key, 
Clear and Cut commands 

F 
FatBits command. MacPaint 143 
File menu 13 

Close command 16 
Close All command 26 
Duplicate command 15, 77 
Eject command1 5, 34 
Get Info command14, 18, 23 
Open command 14 
Print command89, 146 

filing documents see folder 
filled shapes 127 
Fill menu. MacDraw 159 
Find command, MacWrite 114 
Finder 61, 63 
Find Next button, MacWrile 115 
Flip Horizontal command 

MacDraw 163 
MacPaim 136 

Flip Vertical command 
MacDraw 163 
MacPaint 137 

folder 21, 61 
closing 63 
containing other folders 79 
copying 78 
creating 79 
emptying 79 
filling 64 
opening 62 
removing 81 
renaming 68 

Font menu 
MacPaint 124 
MacWrite 86, 107 

FontSize menu, MacPaint 124 
footers, MacWrite 112 
Format menu 

MacWrite 108 
Multiplan 199 

format modifications, MacWrite 92 
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fonnula, Multiplan 174 
function 

G 

Usa Pascal 230 
Multiplan 181, 184, 192 

Get Info command 14, 18, 23 
Go Ahead button, J\1acWrite 118 
Goodies menu, MacPaint 120 
graphic object, MacDraw 154 
grid, MacDraw 157 

H 
handles 

MacDraw 159, 164 
Usa Pascal 230 

hardware 5·7 
headers, MacWrite 112 
Hide Rulers command 

MacDraw 158 
MacWrite 110 

highlighted (see also selecting) 
command 14 
icon 12 
title bar 33 

hollow 
icon 16, 21 
shape 127 

housekeeping 61-81 

I 
1-beam 44, 84, 97 
icon 3, 20 

clicking 9 
double-clicking 27, 62, 65, 83 
dragging 10 
highlighted 12 
hollow 16, 21 
moving 10, 13 
opening 14, 27 
renaming 21, 68 
selecting 12 

Imagewriter printer 1, 89 
indentation marker, J\1acWrite 93 
information window 19 

INDEX 

inserting (see also) Paste command 
messages in Note Pad 43 
pages in Scrapbook 54 
text in MacWrite 97-104 

insertion point 41,84 
Insert Ruler command, MacWrite 108 
Introduction command, J\1acPaim 120 
Invert command, MacPaint 139 

K 
keyboard 7 
keys, specific 

L 

Backspace key 79 
Caps Lock key 151 
Enter key 7 
Option key 135 
Return key 44, 177, 180 
Shift key 104, 127, 140, 151 
Tab key 220 

lasso, MacPaim 136 
layout menu, MacDraw 157 
line 

MacDraw 155 
MacPaint 125 
MacProject 214 

Usa 2, 5, 228-235 
list box 182 
Ust command, Microsoft Basic 240 
logical flag, Multiplan 189 
logo 2 
lotus tools 227 

M 
MacOraw 2, 153-173 
Macintosh Basic 2 
J\1acimosh Pascal 2 
J\1acPaint 1, 119·152 
MacProject 2, 213-226 
MacTenninal 227 
J\1acWrite 1, 82-118 
margin markers, MacWrite 85 
memory 

random-access 230 
read-only 11 230 
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menu 2, 11 , 20, (see also ~pecific menus) 
dimmed command 14 
pulling down 13 

menu bar 12, 20 
Microsoft tools 2, 227 

Basic 2, 236-249 
Cha11 202-212 
Multiplan 174-201 

Milestone command, MacPro ject 216 
Modules fo lder 21, 62, 168 
mouse 1, 6, 8-17 
moving (see also cut & paste operations) 

document ] 0 
folder 73 
icon 10, 13 
mouse l , 6, 8-17 
pointer 8, 20 
text, Mac\Xfrire 103 
window 27 

Multiplan, Microsoft 2, 174-201 

N 
naming 

document 88 
folder 21 

non-sranup disk see clara disk 
Nore Pad 41 43 

0 
OK bunon 90, 142 
Open command 14 
opening 

appl ication 83 
existing document 94 , 187 
icon 14,27 
\"Vindow 16 

operating system, Macintosh 234 
Option key 135 
Options menu, Multiplan 198 
organizing documents see housekeeping 

p 

painting tools 120 
Pascal 

Usa 230 
Macintosh 2 

Paste command 41 
to move images 134 
ro move text 54 , 103 
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Paste Function command, Multiplan 181 
patterns, MacPainr 120 
pencil , MacPaint 121 
Pfs roofs 227 
pointer l 

moving 9, 20 
raking different shapes 44, 178 

polygons, i'vlacPa inr 129 
pot o f paint see area fi ll roof, Mac Paint 
preset parameters, MacWrite 85 
pressing mouse button 9 
Prim Catalog command, MacPaint 147 
Print command 89, 146, 164 
printer see lmagewrirer primer 
printing 

MacPainr document 146 
MacWrite document 89, 149 
entire screen 151 
StOpping 90 

procedure, Usa Pascal 230 
processor, 1\-1C68000 5, 229 
programming the Macintosh 2, 228-249 
programs see applications, specific 
Project menu, MacProjecr 2"1 6 
Puzzle 4, 32 

Q 
QuickDraw routines 

in Macintosh ROM 231-233 
in Microsoft Basic 248 

Quit command 91 

R 
radio buttons 88 
random-access memory 230 
read-only memory 1 1, Z30 
rectangle 

MacDraw 159 
YlacProject 214 
ordinaty MacPaint 127 
round-cornered MacPaint 128 

removing see Backspace key, Cut and 
Clear commands, and trash can 
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renaming serial pons 7 
document 79 shapes 
folder 68 fi lled 127 
icon 21, 68 hollow 127 

replacing text, MacWrite 10 1 Shift key 67, 104, ·127, 140, 151 
Resource Chart command, MacProject 225 Shih-cl icking 67 
Resource Costs command, MacProject 226 sho1tcuts, MacPaint 147 
retrieval see opening existing document Show Clipboard command 37 

INDEX 

Return key 44, 97, 177, 180 Show Footer command, tvlacWrite 112 
ROM see read-on ly memo1y Show Formulas command, Multiplan 198 
Rotate command Shovv Header command, MacWrite 112 

MacDraw 163 Show Page command, MacPaint 142 
l'v1acPainr 138 Show Rulers command, MacWrite 111 

rubber banding 125 Show Schedule command, MacProject 223 
ruler, Mac\Xlri te 85, 92 Show Task Data command, !vlacProject 219 
Run command, Microsoft Basic 237 size box 28 

snapshor 151 
sohware see applications, speci fic 

S space boxes, MacWritc 85, 94 
Save As command 87 spray paint, MacPaint 124 
Save button RR Standard Rulers command, l\·1ac0rav.' "1 57 
saving 87 stanup disk 63 
schedule, MacProject 223 Stop command, Microsoft Basic 239 
Schedule Chart command, MacProject 219 stretching & shrinking, MacPaint 140, 164 
Scrapbook 51 Sty le menu 

fi le 166, 168 MacPaint L24 
screen 5 Mac\Xfrite 86, LOS 

dump 151 swapping disks 76 
system documents 62 
System 

scroll 
arrow 30 
bar 25 
box 30 

Search menu, MacWrite 114 
Select All command, MacDraw '166 
selecting 12 (see also clicking and 

dragging) 
by Shift-clicking 67 
icon 12 
MacDraw 159 . 
MacPaint 133 see also lasso 
MacWrite 102 
Multiplan current cell 176 
multiple icons 67 
Note Pad 48 
rool 23 

Send to Back command, MacDraw 160 

· file 63 
folder see Modules folder 

T 
Tab key 220 
tab wells, MacWrite 93 
task, MacProject 219 
Task menu, MacProject 216 
text (see also cut & paste operations) 

editing 45 
inserting 43, 54,97-104 
moving 53, 102 
removing 49, 99 
rep lacing 101 
selecting 48, 101 
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title bar 25 
Toolbox routines 233-234 
trash can 3, 10, 12-20 

{i 

Lindo command 149 
LIndo f-ind Next command, MacWrite I 15 
unit, Us.:1 Pascal 230 
untitled clocumenr 84 

v 
vertical scroll bar 30 
View menu 

By Icon 22 
By 1'\ame 22 

w 
window 16, 18-35 

activating 25, 34 
changing size of 28 
closing 16, 20 
directory 21 
dragging 27 
information 19 
moving 27 
opening 15 
overlapping 25, 33 

word wraparound, MacWrite 85 
worksheet window, Multiplan 176 
Workshop. Usa 229 
wristwatch icon 73 
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